PeopleTools 8.57: Fluid User Interface Developer’s Guide
# Contents

**Preface: Preface**..........................................................................................................................................vii  
Understanding the PeopleSoft Online Help and PeopleBooks..............................................................vii  
PeopleSoft Hosted Online Help.............................................................................................................vii  
Locally Installed Help..............................................................................................................................vii  
Downloadable PeopleBook PDF Files .....................................................................................................vii  
Common Help Documentation..................................................................................................................viii  
Field and Control Definitions...................................................................................................................viii  
Typographical Conventions.....................................................................................................................viii  
ISO Country and Currency Codes..........................................................................................................ix  
Region and Industry Identifiers..............................................................................................................ix  
Translations and Embedded Help...........................................................................................................x  
Using and Managing the PeopleSoft Online Help..................................................................................x  
PeopleTools Related Links....................................................................................................................x  
Contact Us..............................................................................................................................................xi  
Follow Us.............................................................................................................................................xi  

**Chapter 1: Getting Started with Fluid User Interface Development**......................................................13  
Fluid User Interface Overview....................................................................................................................13  
Implementing PeopleSoft Fluid User Interface........................................................................................13  

**Chapter 2: Understanding PeopleSoft Fluid User Interface**....................................................................15  
Understanding the Need for a Fluid User Interface................................................................................15  
Understanding the Characteristics of Fluid Applications..........................................................................16  
Understanding How to Build Fluid Applications..................................................................................19  
Considerations for PeopleSoft Fluid Application Implementation..........................................................20  

**Chapter 3: Creating Pages for Fluid Applications**..................................................................................23  
Creating Fluid Pages................................................................................................................................23  
Creating a New Main Fluid Page..............................................................................................................23  
Creating Other Fluid Page Types...........................................................................................................23  
Choosing a Fluid Layout Page.................................................................................................................24  
Converting Existing Classic Pages to Fluid.............................................................................................26  
Selecting Fluid Page Types.....................................................................................................................26  
Setting Properties for Fluid Pages.........................................................................................................29  
Setting Use Properties.............................................................................................................................29  
Setting Fluid Properties..........................................................................................................................30  
Defining the Layout of the Main Fluid Page.............................................................................................32  
Creating and Configuring Drop Zones...................................................................................................37  
Understanding Drop Zones on Fluid Pages............................................................................................38  
Creating Configurable Drop Zones for Dynamic Subpages....................................................................38  
Creating Subpages for Dynamic Injection into Drop Zones..................................................................41  
Configuring Drop Zones.........................................................................................................................42  

**Chapter 4: Defining Components for Fluid Applications**........................................................................45  
Adding Fluid Pages to a Fluid Component...............................................................................................45  
Setting Component Properties for Fluid Components...........................................................................45  
Setting Fluid Component Properties......................................................................................................45  
Setting Component Internet Properties for Fluid Components............................................................50  
Providing Left Navigation Using PT_SIDE_PAGETABS.....................................................................51  
Working with Search Pages.....................................................................................................................52
Contents

Understanding Component Search Options for Fluid Applications........................................ 52
Setting up Real-Time Search for Fluid Components................................................................. 53
Setting up Keyword Search for Fluid Components................................................................. 54
Setting Component Properties for Search Options................................................................. 55
Working with Search Pages....................................................................................................... 56
Comparing the Availability of Fluid Search Features to Classic Search Features...................... 57
Working with Master/Detail Components................................................................................ 58
  Understanding Master/Detail Components........................................................................... 58
  Guidelines and Limitations for Master/Detail Components.................................................. 59
  Understanding the Elements of Master/Detail Components................................................ 60
  Implementing Master/Detail Components............................................................................ 63
Working with Two-Panel Implementations.............................................................................. 69
  AJAX Transfers..................................................................................................................... 69
  Left Panel Collision Handling with Slide-out Left Panels.................................................... 71
  Creating a Translator Component to Handle Search Initialization.................................... 75
Testing Form Factors.............................................................................................................. 76

Chapter 5: Adding Page Controls............................................................................................ 81
  Managing Settings for Fluid Page Controls......................................................................... 81
    Understanding the Makeup of a Control on a Fluid Page............................................... 81
  Setting Properties on the Fluid Tab..................................................................................... 82
Working with Group Boxes....................................................................................................... 84
  Using Group Boxes for Fluid Pages.................................................................................... 84
  Setting Group Box Properties............................................................................................ 85
  Working with Container Group Boxes............................................................................... 89
  Working with Accordion Group Boxes............................................................................... 89
  Working with Layout Group Boxes..................................................................................... 91
  Creating Custom Header Group Boxes.............................................................................. 91
  Working with Related Field Group Boxes......................................................................... 92
  Working with Embedded Related Content....................................................................... 92
  Testing Group Box Layout.................................................................................................. 94
Working with Other Page Controls......................................................................................... 95
  Working with Grids............................................................................................................. 95
  Enabling Lazy Scrolling for Scrollable Grids..................................................................... 97
  Working with Scroll Areas.................................................................................................. 98
  Working with Edit Boxes and Long Edit Boxes................................................................. 98
  Working with Subpages........................................................................................................ 100
  Working with HTML Areas.................................................................................................. 100
  Working with Check Boxes................................................................................................. 101
  Working with Push Buttons and Hyperlinks....................................................................... 101
  Working with Static Images and Static Text...................................................................... 102
  Working with Horizontal Rules............................................................................................ 102
  Working with Charts........................................................................................................... 102
  Creating Fluid Pop-up Menus............................................................................................... 102
  Creating Sectional Tabs on a Page...................................................................................... 104
  Page Controls Not Supported in Fluid Applications........................................................... 105
Applying Styles....................................................................................................................... 105
  Understanding Fluid Styling............................................................................................... 105
  Identifying PeopleTools Style Sheets............................................................................... 106
  Overriding Delivered Style Classes.................................................................................... 106
  Setting Min/Max Width on Content.................................................................................... 109
  Hiding Columns in a Flex Grid Using Style....................................................................... 109
<table>
<thead>
<tr>
<th>Understanding Event Collections</th>
<th>160</th>
</tr>
</thead>
<tbody>
<tr>
<td>Defining an Event Collection</td>
<td>160</td>
</tr>
<tr>
<td>Subscribing to an Event Collection</td>
<td>161</td>
</tr>
<tr>
<td>Using Application Data Set Definitions for Events</td>
<td>161</td>
</tr>
<tr>
<td>Configuring Push Notification to Run within Oracle Mobile Application Framework</td>
<td>161</td>
</tr>
<tr>
<td>Understanding Push Notification and MAF</td>
<td>161</td>
</tr>
<tr>
<td>Gathering Push Notification Provider Information</td>
<td>163</td>
</tr>
<tr>
<td>Configuring a MAF Application in PeopleSoft</td>
<td>163</td>
</tr>
<tr>
<td>Creating an Adapter</td>
<td>165</td>
</tr>
<tr>
<td>Associating an Adapter to a Push Notification Event</td>
<td>166</td>
</tr>
<tr>
<td>Enabling Notifications</td>
<td>166</td>
</tr>
<tr>
<td>Registering Devices</td>
<td>167</td>
</tr>
</tbody>
</table>

**Chapter 9: Deploying Applications Using the Oracle Mobile Application Framework**

| Understanding Mobile Application Framework Support for PeopleSoft | 169 |
| Preparing to Use MAF for PeopleSoft Applications | 170 |
| Using an Integrated Development Environment (IDE) | 170 |
| Installing MAF | 170 |
| Installing Target Operating System Development Requirements | 172 |
| Importing the Delivered Mobile Application Archive | 172 |
| Configuring the Mobile Application Project for Your Site | 175 |
| Setting the Application Name | 175 |
| Selecting Application Icons | 177 |
| Selecting Feature Icons | 178 |
| Setting the Default Remote URL | 179 |
| Setting the Remote URL Whitelist | 180 |
| Enabling Push Notification for MAF | 181 |
| Enabling Push Notification for iOS MAF Applications | 181 |
| Enabling Push Notification for Android MAF Applications | 181 |
| Deploying Your Mobile Application | 182 |
| Deploying Applications for Android | 182 |
| Deploying Applications for iOS | 184 |
Preface

Understanding the PeopleSoft Online Help and PeopleBooks

The PeopleSoft Online Help is a website that enables you to view all help content for PeopleSoft Applications and PeopleTools. The help provides standard navigation and full-text searching, as well as context-sensitive online help for PeopleSoft users.

PeopleSoft Hosted Online Help

You access the PeopleSoft Online Help on Oracle’s PeopleSoft Hosted Online Help website, which enables you to access the full help website and context-sensitive help directly from an Oracle hosted server. The hosted online help is updated on a regular schedule, ensuring that you have access to the most current documentation. This reduces the need to view separate documentation posts for application maintenance on My Oracle Support, because that documentation is now incorporated into the hosted website content. The Hosted Online Help website is available in English only.

Note: Only the most current release of hosted online help is updated regularly. After a new release is posted, previous releases remain available but are no longer updated.

Locally Installed Help

If you are setting up an on-premises PeopleSoft environment, and your organization has firewall restrictions that prevent you from using the Hosted Online Help website, you can install the PeopleSoft Online Help locally. If you install the help locally, you have more control over which documents users can access and you can include links to your organization’s custom documentation on help pages.

In addition, if you locally install the PeopleSoft Online Help, you can use any search engine for full-text searching. Your installation documentation includes instructions about how to set up Elasticsearch for full-text searching. See PeopleSoft 9.2 Application Installation for your database platform, “Installing PeopleSoft Online Help.” If you do not use Elasticsearch, see the documentation for your chosen search engine.

Note: See Oracle Support Document 2205540.2 (PeopleTools Elasticsearch Home Page) for more information on using Elasticsearch with PeopleSoft.

Note: Before users can access the search engine on a locally installed help website, you must enable the Search field. For instructions, go to your locally installed PeopleSoft Online Help site and select About This Help >Managing Locally Installed PeopleSoft Online Help >Enabling the Search Button and Field in the Contents sidebar.

Downloadable PeopleBook PDF Files

You can access downloadable PDF versions of the help content in the traditional PeopleBook format. The content in the PeopleBook PDFs is the same as the content in the PeopleSoft Online Help, but it has...
a different structure and it does not include the interactive navigation features that are available in the online help.

**Common Help Documentation**

Common help documentation contains information that applies to multiple applications. The two main types of common help are:

- **Application Fundamentals**
- **Using PeopleSoft Applications**

Most product families provide a set of application fundamentals help topics that discuss essential information about the setup and design of your system. This information applies to many or all applications in the PeopleSoft product family. Whether you are implementing a single application, some combination of applications within the product family, or the entire product family, you should be familiar with the contents of the appropriate application fundamentals help. They provide the starting points for fundamental implementation tasks.

In addition, the *PeopleTools: Applications User's Guide* introduces you to the various elements of the PeopleSoft Pure Internet Architecture. It also explains how to use the navigational hierarchy, components, and pages to perform basic functions as you navigate through the system. While your application or implementation may differ, the topics in this user’s guide provide general information about using PeopleSoft Applications.

**Field and Control Definitions**

PeopleSoft documentation includes definitions for most fields and controls that appear on application pages. These definitions describe how to use a field or control, where populated values come from, the effects of selecting certain values, and so on. If a field or control is not defined, then it either requires no additional explanation or is documented in a common elements section earlier in the documentation. For example, the Date field rarely requires additional explanation and may not be defined in the documentation for some pages.

**Typographical Conventions**

The following table describes the typographical conventions that are used in the online help.

<table>
<thead>
<tr>
<th><strong>Typographical Convention</strong></th>
<th><strong>Description</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Key+Key</td>
<td>Indicates a key combination action. For example, a plus sign (+) between keys means that you must hold down the first key while you press the second key. For Alt+W, hold down the Alt key while you press the W key.</td>
</tr>
<tr>
<td>. . . (ellipses)</td>
<td>Indicate that the preceding item or series can be repeated any number of times in PeopleCode syntax.</td>
</tr>
<tr>
<td>{ } (curly braces)</td>
<td>Indicate a choice between two options in PeopleCode syntax. Options are separated by a pipe (</td>
</tr>
<tr>
<td>[ ] (square brackets)</td>
<td>Indicate optional items in PeopleCode syntax.</td>
</tr>
</tbody>
</table>
**Typographical Convention** | **Description**
---|---
& (ampersand) | When placed before a parameter in PeopleCode syntax, an ampersand indicates that the parameter is an already instantiated object.
Ampersands also precede all PeopleCode variables.
⇒ | This continuation character has been inserted at the end of a line of code that has been wrapped at the page margin. The code should be viewed or entered as a single, continuous line of code without the continuation character.

### ISO Country and Currency Codes

PeopleSoft Online Help topics use International Organization for Standardization (ISO) country and currency codes to identify country-specific information and monetary amounts.

ISO country codes may appear as country identifiers, and ISO currency codes may appear as currency identifiers in your PeopleSoft documentation. Reference to an ISO country code in your documentation does not imply that your application includes every ISO country code. The following example is a country-specific heading: "(FRA) Hiring an Employee."

The PeopleSoft Currency Code table (CURRENCY_CD_TBL) contains sample currency code data. The Currency Code table is based on ISO Standard 4217, "Codes for the representation of currencies," and also relies on ISO country codes in the Country table (COUNTRY_TBL). The navigation to the pages where you maintain currency code and country information depends on which PeopleSoft applications you are using. To access the pages for maintaining the Currency Code and Country tables, consult the online help for your applications for more information.

### Region and Industry Identifiers

Information that applies only to a specific region or industry is preceded by a standard identifier in parentheses. This identifier typically appears at the beginning of a section heading, but it may also appear at the beginning of a note or other text.

Example of a region-specific heading: "(Latin America) Setting Up Depreciation"

#### Region Identifiers

Regions are identified by the region name. The following region identifiers may appear in the PeopleSoft Online Help:

- Asia Pacific
- Europe
- Latin America
- North America
Industry Identifiers

Industries are identified by the industry name or by an abbreviation for that industry. The following industry identifiers may appear in the PeopleSoft Online Help:

- USF (U.S. Federal)
- E&G (Education and Government)

Translations and Embedded Help

PeopleSoft 9.2 software applications include translated embedded help. With the 9.2 release, PeopleSoft aligns with the other Oracle applications by focusing our translation efforts on embedded help. We are not planning to translate our traditional online help and PeopleBooks documentation. Instead we offer very direct translated help at crucial spots within our application through our embedded help widgets. Additionally, we have a one-to-one mapping of application and help translations, meaning that the software and embedded help translation footprint is identical—something we were never able to accomplish in the past.

Using and Managing the PeopleSoft Online Help

Click the Help link in the universal navigation header of any page in the PeopleSoft Online Help to see information on the following topics:

- What’s new in the PeopleSoft Online Help.
- PeopleSoft Online Help accessibility.
- Accessing, navigating, and searching the PeopleSoft Online Help.
- Managing a locally installed PeopleSoft Online Help website.

PeopleTools Related Links

Hosted Online Help Home

PeopleSoft Information Portal

My Oracle Support

Oracle University

Oracle's PeopleSoft PeopleTools 8.57 Home Page (Doc ID 2433119.2)

Elasticsearch Home Page (Doc ID 2205540.2)

"PeopleTools Product/Feature PeopleBook Index" (PeopleTools 8.57: Getting Started with PeopleTools)
Contact Us

Send your suggestions to PSOFT-INFODEV_US@ORACLE.COM. Please include release numbers for the PeopleTools and applications that you are using.

Follow Us

Facebook

YouTube

Twitter@PeopleSoft_Info

PeopleSoft Blogs

LinkedIn
Chapter 1

Getting Started with Fluid User Interface Development

Fluid User Interface Overview

The PeopleSoft Fluid User Interface is designed to be a significant enhancement to the PeopleSoft’s “classic” user interface, which has been the interface display on browsers for PeopleSoft end users for well over a decade. The PeopleSoft Fluid User Interface moves away from pixel-perfect page layout and provides greater flexibility with the enhanced use of cascading style sheets (CSS3), HTML5, and JavaScript (if needed).

PeopleSoft application fluid pages scale gracefully from large screen devices such as laptops and desktops down to the reduced viewing space of tablets and smartphones. Many commercial websites use a similar design model where the presentation and layout of information is adjusted dynamically to conform to the dimensions of the user’s device. The Fluid User Interface design approach gives developers just this type of control over the user experience. When a larger screen size is detected (a screen with more “real estate”) the application content will adjust and conform accordingly to fill the space. Similarly, if a smaller screen size is detected, non-essential information can be removed and the presentation of content will adjust to “flow” in a very usable fashion.

This documentation focuses on the tools, the approaches, and the techniques that application implementation teams will use to create, configure, and customize fluid application pages.

Note: The PeopleSoft Fluid User Interface is an evolving technology. As information becomes available or is requested, PeopleTools will post updates as needed on the following My Oracle Support page: PeopleSoft Fluid User Interface Supplemental Documentation (Doc ID 1909955.1).

Implementing PeopleSoft Fluid User Interface

Developing or customizing PeopleSoft Fluid User Interface applications involves many of the same tools and techniques used for developing or customizing classic PeopleSoft applications. A working knowledge and some expertise in the most current, industry-standard internet development tools and techniques is also required. The following list contains the main tools and technologies Oracle recommends developers are familiar with prior to beginning a fluid application implementation.

- Application Designer.
- PeopleCode.
- PeopleTools portal technology including the PeopleSoft Pure Internet Architecture.
- HTML 5.0.
• Cascading Style Sheets 3.0.
• JavaScript.
Chapter 2

Understanding PeopleSoft Fluid User Interface

Understanding the Need for a Fluid User Interface

A traditional, or classic, PeopleSoft application displayed in a browser assumes the screen size of the device running the application is of a standard, relatively predictable size, such as a browser running on a desktop or laptop computer. The classic PeopleSoft application will run on a mobile device, such as a tablet or cell phone, but it is not tailored or optimized for the mobile device.

With the traditional PeopleSoft application, the interface display is defined in Application Designer using a fixed layout, based on and bound to a pixel system. In the fixed layout, a developer can meticulously align fields, labels, group boxes, and so on, and be reasonably assured the page will appear in the browser running on a desktop or laptop just as it appears in the design-time layout. The traditional PeopleSoft application development design-time layout provides a WYSIWYG (what you see is what you get) scenario.

However, the fixed layout does not adapt -- expand or contract-- based on the device or the size of the screen on which it renders. A classic PeopleSoft application does not display dynamically. While an end user can access and use a traditional PeopleSoft application with a cellular phone, for example, most likely the user will need to shrink or expand the display in order to interact with the fields, with maybe only a small percentage of the page being visible at a time, losing the context of the information on the page.

With the emergence and popularity of mobile devices, namely tablets and smart cellular phones, PeopleSoft applications need to display and run on a wide range of mobile devices. For example, a small, light-weight self-service application must be equally usable on a browser running on a desktop, laptop, iPhone, Android, iPad, and so on.

To address this business demand, PeopleTools enables you to develop and customize components and pages for a fluid display when running on supported mobile devices. PeopleSoft applications that have been developed and enabled for fluid display will appear dynamically, depending on the device and screen size used for access, all based on a single page layout definition. That is, you create a single page definition, using the flexible fluid design approach, and it will display as needed on all the different supported devices, be it an Andriod phone or iPhone or tablet.

Terms used to describe similar design approaches in the industry include, fluid design, responsive design, relative layout, and elastic layout, to name a few. For PeopleTools, we refer to this approach as fluid, as in fluid design, fluid applications, fluid mode and so on. Regardless of the term used, the goal remains the same, which is to enable organizations to deploy applications to all the devices being used to conduct business such that the content of the PeopleSoft page resizes and adapts to the size of the browser window of the device.
Understanding the Characteristics of Fluid Applications

A PeopleSoft application enabled for fluid mode recognizes the device used to access it, and displays so that the application appears naturally, as expected by the user of a certain device type. For example, the following shows a PeopleSoft application page enabled for fluid display appearing on a browser on a laptop or a tablet device.

Image: Fluid page

This example shows a fluid page displayed on a tablet in landscape mode.

If you access that same page using a cell phone and view it in landscape mode, it would appear similar to the following example.
The following example shows how a fluid page may appear on a smart phone in landscape mode.

Notice that the page shrinks to fit the screen size of the device. The elements in the header are the same, only closer together, and the grid displays only the most critical columns. The user can use typical gestures, such as swiping (on homepages only), to scroll through the fluid page.

If you access the same page using a mobile phone and view it in portrait mode, you will notice additional changes as the page further adapts and responds to the adjusted screen display. The PeopleSoft Fluid User Interface is adaptive in that the system detects the device and generates the UI appropriate to that device, and it is responsive in that the CSS defined for the application responds to user actions on the client device, such as changing from portrait to landscape mode.

Note: The PeopleSoft Fluid User Interface adaptive qualities require a server trip, while the responsive qualities do not.
The following example shows a fluid page displayed on a smart phone in portrait mode.

Notice that the system further shrinks the page, while maintaining the fundamental structure.

**Related Links**

"Working with Fluid Homepages and Dashboards" (PeopleTools 8.57: Applications User's Guide)
"Working with Fluid Pages and Controls" (PeopleTools 8.57: Applications User's Guide)
Understanding How to Build Fluid Applications

PeopleSoft fluid applications are built in large part the same as you build a traditional or classic PeopleSoft application, using the same general application development steps in Application Designer. You create fields, records, and build SQL tables just as you would a traditional PeopleSoft application. But when it comes to designing pages and configuring components, you depart somewhat from the steps and techniques used for building PeopleSoft classic applications.

The following table contains the traditional PeopleSoft application development steps as they pertain to developing fluid applications.

<table>
<thead>
<tr>
<th>Development Step</th>
<th>Fluid Consideration</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Design application.</td>
<td>Review your in-house development cycle and documentation.</td>
</tr>
<tr>
<td>2. Create fields.</td>
<td>Create fields just as you would for a traditional PeopleSoft application. In most cases, the same fields that already exist would be used for any fluid development projects.</td>
</tr>
<tr>
<td>3. Create record definitions.</td>
<td>Create records just as you would for a traditional PeopleSoft application. In most cases, the same records that already exist would be used for any fluid development projects.</td>
</tr>
<tr>
<td>4. Build SQL tables.</td>
<td>Build SQL tables using the same techniques as for traditional PeopleSoft applications.</td>
</tr>
<tr>
<td>5. Create pages.</td>
<td>While you still use Application Designer to create fluid page definitions, the approach and layout used are completely different than what are used for traditional PeopleSoft page development. In addition, CSS is used heavily for appearance and layout. JavaScript can be used, if required.</td>
</tr>
<tr>
<td>6. Create components.</td>
<td>Components used for fluid pages must be configured specifically for that purpose. The fluid component options must be selected and set for fluid pages within that component to display as a fluid application.</td>
</tr>
<tr>
<td>7. Register components.</td>
<td>Classic and fluid applications both need to have the components registered using the registration wizard.</td>
</tr>
<tr>
<td>8. Test the application.</td>
<td>Use actual mobile phones, tablets, laptops, and desktop computers to test your application.</td>
</tr>
</tbody>
</table>

**Note:** While you can use device emulators for some preliminary testing, these emulators do not fully replicate the actual device and its native operating system. In particular, iOS testing requires an actual iOS device.

Application Designer is the main development tool used for building both classic and fluid PeopleSoft applications, and PeopleCode is the main programming language used to interact with component processing events and implement business logic. However, with fluid applications, the application implementation teams that will develop or customize PeopleSoft fluid applications will need expertise in these additional areas (listed in order of importance and recommended experience):

- CSS3
- HTML5

Note: The majority of this documentation focuses on creating pages and creating components for fluid display.
• JavaScript

**Important!** With the flexibility provided through creating and customizing HTML, CSS, and JavaScript, it is up to the developer to determine the amount of development work performed outside of the realm of PeopleTools. For example, PeopleTools cannot implement restrictions on what a developer adds to a freeform style sheet or to a JavaScript program. Developers customizing such elements need to be aware of performance and security implications.

**Note:** After reading this document, your application documentation, and any related information related to PeopleSoft Fluid User Interface, one very effective way to learn about fluid applications is to use the fluid applications delivered with your PeopleSoft application as examples. Consider and explore the intended audience, the capabilities of the pages, the page design, the page controls used, the component contents and settings, and so on. Especially, pay close attention to how CSS style classes are applied.

---

**Considerations for PeopleSoft Fluid Application Implementation**

Not all PeopleSoft application pages will be delivered for the PeopleSoft Fluid User Interface. The majority of PeopleSoft applications, components, and pages will, for the foreseeable future, continue to be delivered and accessed in classic mode, which is the way PeopleSoft applications have been accessed using desktops and laptops for over a decade. PeopleSoft application teams will be offering selected applications for fluid deployment that your organization can choose to enable and deploy.

In most cases, there is no quick and simple method for converting an existing custom classic application to a fluid application. Plenty of time should be spent analyzing requirements and discussing design options and considerations. In some cases, adjusting a classic page following the fluid approach to page design may be all that's required, while in other cases, you may consider building a new application from the ground up, perhaps reducing the number of fields and records required, and streamlining the entire data model.

Converting an application to fluid and bringing with it *all* the classic application techniques and elements may result in poor performance and usability on a mobile device. While some of the structural elements of the application must be analyzed and adjusted for fluid application deployment, such as page layout, some elements, such as PeopleCode business logic, can be used in either classic or fluid mode with little, if any, modification.

Before you consider deploying any PeopleSoft applications in fluid mode, it is important to consider the following items, which may help you to determine if fluid applications are appropriate for your user base at this time.

<table>
<thead>
<tr>
<th><strong>Consideration</strong></th>
<th><strong>Discussion</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Not all applications (currently) are candidates for fluid deployment.</td>
<td>Currently, the applications that are most suited for fluid deployment are those that are already considered streamlined, self-service type applications. For example, accessing a page to check a new hire’s job status would be a more appropriate fluid application as opposed to accessing a component with a cell phone to complete a new hire’s “add employee” business process.</td>
</tr>
<tr>
<td>Consideration</td>
<td>Discussion</td>
</tr>
<tr>
<td>------------------------------------------------------------------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Are mobile devices such as cell phones and tablets used widely to access PeopleSoft applications at your site?</td>
<td>If your user base already accesses or has expressed a demand for accessing your PeopleSoft applications using mobile devices, fluid deployment would be a good option for you. However, if mobile devices are not part of your user base or application delivery strategy, while you cannot disable fluid deployment at the system level, you can direct all users to the classic homepage at signon. See Setting Device Homepage Defaults for more information.</td>
</tr>
<tr>
<td>Application usage and workload?</td>
<td>Pages where there is heavy data entry required would not be suitable for phones or even tablets. The functional use of the page must be paramount. Plus, some pages are administrative in nature. Would these pages benefit from a simpler reworking to make them classic plus, but consequently foregoing the responsive and adaptive nature of fluid applications? See Converting Existing Classic Pages to Fluid for more information.</td>
</tr>
<tr>
<td>Does an application require functionality that does not exist in the fluid user interface?</td>
<td>For example, some features, like spell check, trees, and others are not available in fluid. See Page Controls Not Supported in Fluid Applications for more information.</td>
</tr>
</tbody>
</table>
Creating Pages for Fluid Applications

Creating Fluid Pages

Creating a New Main Fluid Page

The main fluid page is the main content area, or target page. The main page is used directly within the component.

To create a new main fluid page based on an existing layout template:

1. In Application Designer, select File, New.
2. Select Page (Fluid) in the New Definition dialog box, and click OK.
3. Select an initial layout page (template) from the Choose Layout Page and click Choose.

   **Note:** Most main fluid pages are based on the PSL_APPS_CONTENT layout page.

   See Choosing a Fluid Layout Page.

4. Enter the page name in the Save As dialog box.
5. Indicate whether you’d like to save the PeopleCode associated with the layout page for your new page (Yes/No).

   **Note:** Typically, click Yes to include any PeopleCode from the layout page.

6. Define layout and add page controls according to the fluid techniques and guidelines described in this documentation.

Creating Other Fluid Page Types

To create other fluid page types:

1. In Application Designer, select File, New.
2. Select Page (Fluid) in the New Definition dialog box, and click OK.
3. Select an initial layout page (template) from the Choose Layout Page that corresponds to the page type that you want to create—for example, select `PSL_SIMPLE_SBP` to create a fluid subpage.

   See Choosing a Fluid Layout Page.

4. Click Choose and enter the page name in the Save As dialog box.
5. Indicate whether you’d like to save the PeopleCode associated with the layout page for your new page (Yes/No).

**Note:** Typically, click Yes to include any PeopleCode from the layout page.

6. Open the Page Properties dialog box.

7. On the Use tab, select the page type—for example, select *Subpage* to create a fluid subpage.

8. Define layout and add page controls according to the fluid techniques and guidelines described in this documentation.

### Choosing a Fluid Layout Page

This section describes the layout pages you can use as the basis for any new fluid pages. Layout pages can be compared to templates. They provide a basic structure to get you started with a fluid page.

**Important!** Do not include a layout page in any component definition. Layout pages are templates only for the generation of a new fluid page definition.

**Image: Choose Layout Page dialog box**

This example illustrates the layout page options provided by the Choose Layout Page dialog box.

In your new page definition, you may add or remove elements as needed for your purposes. However, make sure to examine the template pages so that you understand how any existing PeopleCode or CSS styles affect the interface.
Important! Not all of the delivered layout pages are intended for external usage.

Recommended Layout Pages

This table describes the layout pages suitable for fluid application development.

<table>
<thead>
<tr>
<th>Layout Page</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PSL_APPS_CONTENT</td>
<td>Use PSL_APPS_CONTENT as the basis for most main fluid pages of type Standard or Secondary. This layout page contains the outermost group box to act as the overall container for the fluid page content. This group box has the ps_apps_content style applied, which provides the outer flexbox necessary for all fluid applications.</td>
</tr>
<tr>
<td>PSL_2COLUMN_FLOAT</td>
<td>This layout page contains nested layout group boxes inside of the outermost group box that has the ps_apps_content style applied. If you’re using this layout page, you need to supply the styling for the child containers based on your needs.</td>
</tr>
<tr>
<td>PSL_CONTENT_TITLE</td>
<td>This layout page includes a special Page Title group box to display a page title on the page. Use this layout page for pages that are displayed inside two-panel wrappers such as activity guides or master/detail components.</td>
</tr>
<tr>
<td>PSL_PANEL_CONTENT</td>
<td>This layout page includes a single container having the default styling for the side panel (left or right panel) usage. If you’re using this template, you also need to specify your own record/field and make sure the appropriate role (ARIA) is applied to the outer container for accessibility.</td>
</tr>
<tr>
<td>PSL_PANEL_NAV</td>
<td>Left (typically) panel usage to contain navigational elements, which control the target page content. Role (ARIA) automatically applied to indicate that the contents will be navigational in nature.</td>
</tr>
<tr>
<td>PSL_SIMPLE_SBP</td>
<td>Use PSL_SIMPLE_SBP as the basis for fluid subpages. Note: After creating a subpage from this layout template, you must change the page type from Standard to Subpage. See Creating Other Fluid Page Types.</td>
</tr>
<tr>
<td>PSL_TWOPANEL</td>
<td>Used in PeopleTools 8.54 to provide a two-panel layout, typically with navigation on the left side and the transaction page on the right.</td>
</tr>
<tr>
<td>PSL_USER_PREF</td>
<td>Use this layout page for creating user preferences to be included as part of My Preferences.</td>
</tr>
<tr>
<td>PSL_USER_PREF_FT</td>
<td>Use this layout page for creating a footer page for user preferences.</td>
</tr>
</tbody>
</table>

Layout Pages Reserved for Internal Usage

These layout page types are reserved for internal usage by Oracle development teams: PSL_FILTER_RESULTS.
When you’re evaluating whether to convert your existing custom classic applications to fluid, you should consider these questions:

- Will the application be used on smart phones and tablets as well as laptops and desktop computers, thereby taking advantage of the responsive and adaptive nature of fluid applications across all form factors?
- Will the application benefit from easy access via a tile on a homepage or dashboard?
- Or, if the application is administrative in nature, would it benefit from a simpler reworking to make it classic plus, but consequently foregoing the responsive and adaptive nature of fluid applications?

Then, consider these implementation approaches:

- For applications that do not require all of the benefits of the responsive and adaptive nature of fluid applications, rework the classic pages to classic plus.
- For simple classic applications with a simple page structure and few page controls, create a new fluid component and page, and then copy all of the existing classic page controls into the new fluid page.
- For more complex classic applications with complex page structure, consider starting anew by redesigning the pages as a fluid application, taking full advantage of all fluid page design features.

When developing fluid applications, you can create multiple page types for simultaneous display, each page serving a different role in accordance with HTML 5 specifications. The main page is a standard page that has been designated a Fluid Page on the Use tab of the Page Properties. The main fluid page definition contains the bulk of the transaction fields and controls, which are contained within an outermost layout group box that has the `ps_apps_content` style applied. For more information on setting page properties for fluid pages, see Setting Properties for Fluid Pages.

When creating a new fluid page or opening an existing fluid page, you can select Page (Fluid) from the definition list in Application Designer.
The following example shows the Page and Page (Fluid) definition types in the definition list in Application Designer.

You select the remaining page types for fluid mode, from the Page Type drop-down list on the Use tab of the Page Properties dialog.

This example shows the fluid page types listed in the Page Type drop-down list on the Page Properties, Use tab.

The following table provides a brief description of each fluid page type and the layout page to be used when creating a new page definition.

<table>
<thead>
<tr>
<th>Page Type</th>
<th>Layout Page</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Standard Page</td>
<td>PSL_APPS_CONTENT</td>
<td>The main fluid page is the main content area, or target page; the main page is used directly within the component. The main fluid page contains the outermost group box, which acts as the overall flexbox container for the fluid page content. This group box has the <code>ps_apps_content</code> style applied.</td>
</tr>
<tr>
<td>Page Type</td>
<td>Layout Page</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>--------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Subpage</td>
<td>PSL_SIMPLE_SBP</td>
<td>Fluid subpages can be used to reduce clutter, group related fields, and segregate business logic.</td>
</tr>
<tr>
<td>Secondary Page</td>
<td>PSL_APPS_CONTENT</td>
<td>Fluid secondary pages are typically displayed in a modal window. See <a href="#">Implementing Transfers and Modal Windows with PeopleCode</a>.</td>
</tr>
<tr>
<td>Header Page</td>
<td>NA</td>
<td>Page displayed in <code>&lt;header&gt;</code> section of the HTML acting as the banner area fixed at the top of every page. It does not scroll with the page. The header page appears at the top of the browser interface over the main page, containing elements used for basic navigation and orientation, like a back button, page title, home button, search button, and so on. PeopleTools supplies a default header page, PT_HEADERPAGE, but this can be overridden for a custom header page to be used by selecting No System Header Page in the Component Properties dialog box.</td>
</tr>
<tr>
<td>Side Page 1</td>
<td>PSL_PANEL_CONTENT</td>
<td>Page displayed on the left side off the screen, often containing left-side navigational constructs. Users can slide it open and shut.</td>
</tr>
<tr>
<td></td>
<td>PSL_PANEL_NAV</td>
<td></td>
</tr>
<tr>
<td>Footer Page</td>
<td>NA</td>
<td>Page displayed in the <code>&lt;footer&gt;</code> section of the HTML at the bottom of the main page, containing elements related to the end of a transaction, such as a Save button. The footer page is fixed at the bottom of the content page and does not scroll.</td>
</tr>
<tr>
<td>Search Page</td>
<td>NA</td>
<td>Page generated in <code>&lt;aside&gt;</code> section containing search pages, which include Find an Existing Value and Keyword Search.</td>
</tr>
<tr>
<td>Note: An Add a New Value page is not provided by the search page definitions provided by PeopleTools.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Layout Page</td>
<td>NA</td>
<td>You can designate a page definition as a layout page for use as a template for development reuse or for testing purposes, such as finalizing CSS work.</td>
</tr>
<tr>
<td>Note: This is a base layout page, which can be used when selecting a new Page (Fluid). At that time you can select a layout page where the structure will be copied into your new page. You cannot apply a layout page after you have created a page or if you create a new a new page (regular).</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Master&amp;Detail Target page</td>
<td>NA</td>
<td>Displays the transactional fluid page for use within the master/detail component, in which the master provides the navigation and the detail displays the target content. For more information on the master/detail approach, see <a href="#">Working with Master/Detail Components</a>.</td>
</tr>
<tr>
<td>Side Page 2</td>
<td>PSL_PANEL_CONTENT</td>
<td>A side page that appears from the right side of the screen. Users can slide it open and shut. Typically used to contain related content.</td>
</tr>
</tbody>
</table>

* Typically, PSL_APPS_CONTENT is used to create pages of this type.
Image: Fluid Screen Layout

The following diagram illustrates the general layout of the various fluid page types.

![Fluid Screen Layout Diagram](image)

**Note:** Not all page types are required to be used. The application content area displays the content presented by the main fluid page.

**Related Links**
Choosing a Fluid Layout Page

## Setting Properties for Fluid Pages

You create fluid pages using Application Designer and use the same Page Properties dialog box to set the properties for a fluid page. This topic describes the settings that are specific to fluid pages. For general page development information refer to the product documentation for Application Designer, the Application Designer Developer's Guide.

**Related Links**
"Understanding Page Design and Development" (PeopleTools 8.57: Application Designer Developer's Guide)  

## Setting Use Properties

On the Use tab in the Page Properties dialog box, some properties need to be described separately in the context of fluid applications (versus classic applications).
Image: Page Properties > Use tab

This example shows the Use tab in the Page Properties dialog box in Application Designer. The following descriptions cover the properties that are specific to fluid pages.

**Page Type**
Select the type of page for use in the fluid application, such as header, footer, search, and so on.

For more information on page types used for fluid development, see Selecting Fluid Page Types.

**Fluid Page**
For a page to be displayed and rendered in fluid mode, the Fluid Page check box *must* be selected. This is required.

### Setting Fluid Properties

The Fluid tab contains a collection of properties that apply only to fluid pages.
Image: Page Properties > Fluid tab

This example shows the Fluid tab in the Page Properties dialog box in Application Designer. The following descriptions cover the properties that are specific to fluid pages.

**Style Classes**
Enter the application-specific style classes to apply in addition to the default system-specific styles (PeopleTools styles applied by default). Separate multiple style classes with a space.

**Form Factor Style Class Override**
Use to override the style based on the form factor (device size) of the device accessing the page. Form factors are represented in these ranges:

- Small: Applies to most smartphones.
- Medium: Applies to 7-inch tablets.
- Large: Applies to 10-inch tablets and laptops.
- Extra Large: Applies to large monitors.

**Suppress System-Specific Style Classes**
Select to bypass the system default style applied by PeopleTools.
If not selected, the application-specific style specified for Style Classes will be appended to the default system style, such that both styles are used.

---

**Defining the Layout of the Main Fluid Page**

Designing and defining the layout of a fluid page is one of the major differences between developing fluid applications and developing classic applications. In a classic application, you perform layout of a page in a WYSIWYG format, where page elements and controls are placed exactly where you want them within a pixilated invisible table.
This example illustrates a classic PeopleSoft page definition in Application Designer, where each page element is meticulously placed on the Layout tab.

And, despite the obviously more polished presentation in the generated HTML page that displays in the browser for the user, the layout, spacing, order, color, and so on is for the most part identical between the design time definition and the runtime presentation.
Image: Classic page at run time

This example illustrates the same page as depicted in the previous example at run time. The design time and runtime appearance is practically identical in terms of layout, positioning, sizing, color, font, and so on.

General Profile Information

QE User

Password

Change password
Change or set up forgotten password help

Personalizations

My preferred language for PIA web pages is: English
My preferred language for reports and email is

Currency Code
Default Mobile Page

Alternate User

If you will be temporarily unavailable, you can select an alternate user to receive your routings.

Alternate User ID
From Date (example: 12/31/2000)
To Date (example: 12/31/2000)

Workflow Attributes

Email User Worklist User

Miscellaneous User Links

Email

Primary Email Account Email Type Email Address

When performing layout for a fluid page, you will notice that design representation in no way resembles the design representation for the classic page.
Image: Fluid page at design time

This example shows a fluid page layout at design time in Application Designer, with various elements contained in nested group boxes and little if any indication regarding how the page might appear at run time to the user.

The layout of the fluid application is not what you would call a WYSIWYG approach. If an end user were to access a page in this state, it would be impossible to complete a transaction. Notice the boxes that are used to indicate levels of containment and to provide visual cues, making each element from high-level to low-level a self contained and discrete. Group boxes are used to achieve this effect. The rectangular boxes within some of the group boxes represent subpages.
Image: Fluid page at run time

This example illustrates the fluid rendering of this very same page definition (above) in a browser.

At a high-level, you can map the rendering in the browser to the layout as:

- The area showing the employee photo is represented in the layout as the group box labeled App Header.
- The area showing the navigation on the left is represented in the layout as the group box labeled psc_panel-action.
- The area on the right currently titled Addresses is represented in the layout as the group box labeled Your Content Sub-Page here. When Addresses is selected from the left hand navigation, it appears in the content container. When Contact Details is selected, the contact information is displayed in the content container, and so on.

Note: The blue bar running across the top displays the fluid banner, which is the default PeopleTools, or system, header page definition (PT_HEADERPAGE). Because it is a separate page definition entirely, it is not depicted in the layout view of the main page (the content below it) in Application Designer.

While there are many factors contributing to the appearance of a fluid page, which will be discussed in this document, the main elements of fluid page layout are:
Chapter 3 Creating Pages for Fluid Applications

PeopleSoft Design Elements | Description
---|---
Group boxes | Group boxes are the primary control, providing not only visual cues, but, more importantly, it acts as the container for all controls and page elements. For example, subpages must be enclosed in a group box, grids and scroll areas need to be enclosed in a group box, and so on. Each control is comprised of two parts: the label and the control – wrapped in the container of a group box. In fact, the entire page itself must be contained in one super group box: a requirement for fluid rendering.

Style sheets | While group boxes take on the role of discretely containing each and every element on a page, the physical placement of the group boxes within the Layout tab in Application Designer is largely irrelevant. How and where a page element or control renders on the end user device is determined by style sheets. PeopleTools delivers the system-wide PSSTYLEDEF_FMODE style sheet. You can make custom, free form style sheets to extend or override the system-wide style sheet.

Both group boxes and free form style sheets are discussed in detail in other sections of this document.

**Note:** Tab order index is determined only by the order in which the fields and controls appear on the page from top-to-bottom and left-to-right.

During the page design process, you might want to periodically preview how your page looks in the browser. How your page appears in Application Designer at design time may look different when viewed online. This is particularly true for fluid pages, which do not follow the pixel perfect WYSIWYG paradigm of classic pages. With fluid pages, CSS determines how the page and how the page elements are displayed to the user. The physical placement of the page elements often has no bearing on how the fluid page will appear at run time. Therefore, you must either preview fluid pages from Application Designer or view them in a runtime browser session. You can use the View in Browser menu item in Application Designer to preview the look of your fluid pages. See "Previewing Fluid Pages" (PeopleTools 8.57: Application Designer Developer's Guide) for more information.

Creating and Configuring Drop Zones

This topic provides an overview of drop zones on fluid pages and discusses how to:

- Create configurable drop zones for subpages.

  **Note:** Typically, as an Oracle customer, you can skip this step. PeopleSoft application teams have already added one or more configurable drop zones on selected fluid pages.

- Create subpages for dynamic injection into drop zones.

- Configure drop zones.
Understanding Drop Zones on Fluid Pages

Configurable drop zones allow you to extend the fields that are displayed and processed on delivered fluid pages without customizing the component or fluid page definition. At design time, a placeholder subpage stub (PT_ERCSUBPAGE_STUB) is inserted into a related content group box on the fluid page definition. Typically, PeopleSoft application teams (PeopleSoft HCM, PeopleSoft FSCM, and so on), have identified which delivered fluid pages can be extended by customers and have already added one or more configurable drop zones on these fluid pages. Then, you create subpage definitions and associate your subpages to one or more drop zones. Finally, at runtime during the component build process, the configured subpage dynamically replaces the subpage stub. The records and fields defined on your subpage are loaded into the component buffer along with the records and fields from the main page definition.

The complete procedure for creating and configuring drop zones includes three tasks described within this topic:

1. (Optional) Creating configurable drop zones.
   
   If you merely want to take advantage of the drop zones delivered with your PeopleSoft application, you can skip this step. Otherwise, if you want to create additional drop zones, see Creating Configurable Drop Zones for Dynamic Subpages.

2. Creating subpages for these drop zones.
   
   See Creating Subpages for Dynamic Injection into Drop Zones.

3. Configuring a selected drop zone by associating a subpage to it.
   
   See Configuring Drop Zones.

Note that adding a related content group box on a fluid page creates a “drop zone.” These drop zones can be configured for two purposes:

- Embedded related content only.
  
  Embedded related content was introduced in PeopleTools 8.55. While the procedure for creating and configuring embedded related content has not changed, the group box itself is now also referred to as a drop zone. See Working with Embedded Related Content.

- Dynamically injected subpages or embedded related content.
  
  A related content group box created for dynamically injected subpages could be configured for embedded related content instead. However, both uses cannot coexist simultaneously. If a drop zone already configured with embedded related content is reconfigured with a subpage, then the embedded related content configuration is overridden. If a drop zone is already configured with a subpage, it will not be available for configuration with embedded related content.

Creating Configurable Drop Zones for Dynamic Subpages

Typically, PeopleSoft application teams have already added one or more configurable drop zones on selected fluid pages. However, in some cases, you may want to add drop zones to other fluid pages. To do so, you would follow the same steps used by PeopleSoft application development teams.

Note: Adding a drop zone to a page definition delivered by Oracle is considered a customization.
Guidelines for Creating Configurable Drop Zones for Dynamic Subpages

Adhere to the following guidelines when creating configurable drop zones for dynamic subpages:

- Insert the PT_ERCSUBPAGE_STUB subpage stub (which is defined on the PeopleTools Options page).
- Do not insert any other page controls within the related content group box.
- If you add drop zones on subpages rather than on the main fluid page, then you must ensure that each drop zone that will be displayed on the main fluid page at runtime can be uniquely identified. The PeopleSoft system uses the combination of `occurs_lvl.RECORD_NAME.FIELD_NAME.Field_ID` to identify each group box as a page record field. By associating each group box to a unique RECORD.FIELD, you will ensure that each can be uniquely identified.

Image: Unique page field identifier

The information that uniquely identifies page field can be found on the page definitions Order tab. In the following example, Drop Zone 1 is uniquely identified as `0.DERIVED_PSWD.NEWPASSWORD.14`.

Adding a Related Content Group Box for Dynamic Subpages

To add a related content group box for dynamic subpages:

1. Insert a group box on your fluid page in the general position you would like to display the content from the dynamic subpage.
2. Double-click the group box to open the Group Box Properties dialog box. Then, on the Fluid tab, set the Group Box Type to Related Content.
3. (Optional) Apply styling, if needed, to this group box that will only be rendered if a subpage is configured for this drop zone.
4. Select the Label tab and enter a descriptive label to identify this related content group box as a drop zone. This label is not rendered at runtime, but it will help at design time by:
   - Differentiating this drop zone from any others on the page.
• Providing a label on the drop zone during fluid page preview.

• Providing a label for the drop zone during the drop zone configuration task.

5. Associate a record field to this drop zone to ensure that it has a unique page field identifier.

6. Insert the PeopleTools-defined PT_ERCSUBPAGE_STUB subpage stub into the related content group box so that:

• The upper left corner of the subpage is located within the group box.

**Image: PT_ERCSUBPAGE_STUB subpage**

In this example, the upper left corner of the PT_ERCSUBPAGE_STUB subpage is located within the related content group box.

• The subpage is listed immediately after the group box on the Order tab for the page definition.

**Image: Page definition: Order tab**

In this example, the PT_ERCSUBPAGE_STUB subpage (field 15) immediately follows the group box (field 14) on the Order tab.

**Important!** If you insert multiple drop zones on the same page, always inspect and fix the order of group boxes and subpages on the Order tab.

7. Save your changes.
Related Links
Configuring PeopleTools Options for Fluid Applications
"Previewing Fluid Pages" (PeopleTools 8.57: Application Designer Developer's Guide)
Working with Embedded Related Content

Creating Subpages for Dynamic Injection into Drop Zones

Considerations for Creating Dynamically Injected Subpages
Consider the following when creating subpages for dynamic injection into drop zones:

• The records and fields defined on your subpage will be loaded into the component buffer along with the records and fields defined on the main page.
• Multiple updatable tables are allowed at level 0.
• Because your subpage is not physically added as a page control on the main page definition, you cannot perform a record name substitution (that is, identify a from record on the subpage and a to record from the main page).
• Record field PeopleCode defined on your subpage will execute as part of the events in the component processor flow. If your implementation requires other scenarios or PeopleCode events, (for example, page Activate, PreBuild, PostBuild, component record, or component record field events), then you should use PeopleCode event mapping to avoid customizing delivered components and pages. See "Mapping Application Class PeopleCode to Component Events " (PeopleTools 8.57: Portal Technology) for more information.
• The fields from your subpage that are dynamically added to the component buffer at runtime are not available in the component’s search record.

Creating a Subpage Definition
To create a dynamic subpage definition:

1. In Application Designer, select File, New.
2. Select Page (Fluid) in the New Definition dialog box, and click OK.
3. Select PSL_SIMPLE_SBP to create a fluid subpage.
4. Click Choose and enter the page name in the Save As dialog box.
5. Indicate whether you’d like to save the PeopleCode associated with the layout page for your new page (Yes/No).

   **Note:** Typically, click Yes to include any PeopleCode from the layout page.

6. Open the Page Properties dialog box.
7. On the Use tab, select Subpage to specify this as a fluid subpage.
8. Add page controls on your subpage definition.
Related Links
"Understanding Page Design and Development" (PeopleTools 8.57: Application Designer Developer's Guide)
"Using Subpages" (PeopleTools 8.57: Application Designer Developer's Guide)

Configuring Drop Zones

Use the Configure Drop Zones component to search for, select, and configure components containing configurable drop zones.

Navigation
PeopleTools >Portal >Configure Drop Zones

Image: Configure Drop Zones search page

This example illustrates the fields and controls on the Configure Drop Zones search page. You can find definitions for the fields and controls later on this page.

Enter one or more search criteria or omit all criteria to return all components containing configurable drop zones.

Component Enter the definition name for the component as search criteria.
Market Enter the three-character market code as search criteria.
Description Enter the description as defined on the General tab of the Component Properties dialog box as search criteria.
Configured Subpage Enter the definition name for an already configured subpage as search criteria.
Object Owner ID Enter the object owner ID of the component as search criteria.

In the search results, click a row to configure the available drop zones for that component.
### Image: Configure Drop Zones configuration page

This example illustrates the fields and controls on the Configure Drop Zones configuration page. You can find definitions for the fields and controls later on this page.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Page Name</td>
<td>Displays the name of the main fluid page that contains a configurable drop zone or a subpage with a drop zone.</td>
<td></td>
</tr>
<tr>
<td>Tab Order</td>
<td>Displays the tab order number for the drop zone from the Order tab of the page definition (page or subpage) where the related content group box is physically defined.</td>
<td></td>
</tr>
<tr>
<td>Drop Zone</td>
<td>Displays the label for the drop zone, which is derived from these values in descending order of precedence:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• The label for the related content group box.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• The default label for the RECORD.FIELD associated with the group box.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• A string that is the concatenation of the page definition (page or subpage) where the related content group box is physically defined plus the field ID for the group box as found on the Order tab. For example: PAGE_NAME_ID.Field_ID</td>
<td></td>
</tr>
<tr>
<td>Used By Related Content</td>
<td>Indicates that this drop zone has been configured for embedded related content. Reconfiguring it with a subpage overrides the embedded related content configuration.</td>
<td></td>
</tr>
<tr>
<td>Subpage Name</td>
<td>Select a fluid subpage to associate with the drop zone.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>To remove a subpage configuration, clear the Subpage Name field and save your changes.</td>
<td></td>
</tr>
</tbody>
</table>

**Note:** The configurable drop zone may actually reside on a subpage that has been included in the main fluid page.

**Important!** If Dummy Name is displayed as the name of the drop zone, then the PT_ERCSUBPAGE_STUB subpage is positioned incorrectly on the page definition. In particular, check the Order tab.
Reconfigured  Indicates that an existing subpage configuration has been changed.

Related Links
Working with Embedded Related Content
Defining Components for Fluid Applications

Adding Fluid Pages to a Fluid Component

Like classic applications, the fluid application uses components to contain sets of pages. With all the different page types that are included within a single fluid transaction (header pages, footer pages, primary pages, and so on) they must all be included within the same component so they run in the same panel buffer. Having these pages all in the same panel buffer means you can write PeopleCode to work on all page types at the same time.

Note: When using the default system pages, as in the default header page provided by PeopleTools, the system automatically loads those pages into the component. If you intend to use those pages, they do not need to be added manually to the component. However, if you have built custom header pages, search pages, and so on, those pages need to be inserted manually into the component to associate them with that component so the system loads them at runtime.

Setting Component Properties for Fluid Components

This section describes component properties from a fluid perspective.

Setting Fluid Component Properties

Use the Component Properties, Fluid tab to set fluid component properties.
Image: Component Properties dialog box: Fluid tab

This example illustrates the options on the Fluid tab. You can find descriptions for the options after the example.

Component Attributes

Fluid Mode
Indicates that the pages in this component are to be accessed in fluid mode. This is required for fluid rendering.

Layout Only
Select when testing the layout of the pages within the component. When selected the borders of all the group boxes on the page appear in different colors to illustrate the scope of each group box container.

Page Navigation in History
Enables the system to store the visited pages in the Back button history. This setting applies to the pages within the current component.
This can be enabled also using the SetTransferAttributes PeopleCode built-in function.

For more information, see "SetTransferAttributes" (PeopleTools 8.57: PeopleCode Language Reference).

**Return to Last Page in History**

Select to return the user to the last viewed page within a component after being transferred to a different component. This setting applies in the event of a transfer between components.

The default behavior when using the Back button to return from a transfer between components is to display the initial page of the component, regardless if it was the last viewed page.

For example, with Return to Last Page in History selected, if the user was on the third page within the component prior to the transfer to another component, the system displays the third page in the original component after using the Back button to return from the transfer.

This can be enabled also using the SetTransferAttributes PeopleCode built-in function.

For more information, see "SetTransferAttributes" (PeopleTools 8.57: PeopleCode Language Reference).

**Display on Small Form Factor Homepage**

Select to enable the tile for this component to be displayed on fluid homepages and fluid dashboards on small form factor devices such as smart phones.

If Display on Small Form Factor Homepage is not selected, the tile for that component will not appear on fluid homepages and fluid dashboards when accessed by a small form factor device.

If a fluid homepage does not contain any tiles for components with Display on Small Form Factor selected, that fluid homepage displays an error message on the small form factor device, reading This Homepage is Empty: None of the tiles configured for this homepage are supported on smart phones.

**Note:** If a tile for a fluid component is not displayed on the fluid homepage, users can still access the component using other navigation features, such as the NavBar and the Navigator menu.

When a user personalizes a fluid homepage, a visual cue in the form of a smartphone icon appears next to a tile on the Add Tile dialog box indicating which tiles can be displayed on the homepage for a small form factor device. The smartphone icon appears for tiles associated with components with Display on Small Form Factor selected.
When personalizing a homepage using a smartphone, tiles associated with components that do not have Display on Small Form Factor Homepage selected display a note reading *Tile is not supported on this device.*


### No System Header Page
Select if you have a custom header page that you want to display instead of the default, system header.

### No System Side Page
Select if you have a custom side page that you want to display instead of the default, system side page.

### Component Type
Select the type of component you are building:

- **Standard.** Similar to standard, classic components, this type is used for most fluid components that will include fluid application pages.

- **Activity Guide.** This component type applies to custom fluid activity guides—that is, those not created using the Manage Templates menu item under the Activity Guide menu folder. Activity guides aggregate a step-wise procedure or activity that spans multiple components.

  See "Understanding Activity Guides" (PeopleTools 8.57: Portal Technology) for more information on how to create activity guide templates instead of creating activity guide components.

- **Master/Detail.** Used for a special type of fluid component, similar to an activity guide, master/detail components provide access to multiple components, aggregating the navigation to these components in a master list, which remains displayed in the left panel. A master/detail component enables you to create a means of navigating easily amongst a collection of components sharing a common theme, such as those most likely to be accessed regularly by a particular role. See Working with Master/Detail Components for more information.

### Search Type
Select the type of search the user will interact with when accessing the component:

- **None.** Disables search pages for the component.

- **Standard.** Displays a “standard” search page, which provides users with search results that they click, and drill into component pages and data replacing the entire browser window.

- **Master/Detail.** Displays a two-panel search results page similar to fluid master/detail components, which also provides users with search results that they click, and drill
into component pages and data. However, the search results 
remain active and visible in the left side panel, while the 
application page displays in the detail area.

For Standard and Master/Detail search types, either a Search 
Framework search definition or a pivot grid model needs to be 
associated with the component. For more detailed information 
on these options and how they are configured, see Working with 
Search Pages.

**Note:** When you enable either a Standard or Master/Detail 
search type, the system displays Next and Previous buttons in 
the fluid banner by default.

### Header Toolbar Actions

Select the options to be displayed in the fluid banner:

**Disable All Actions**

Select to deselect all header toolbar actions. At runtime, the 
system displays a fluid banner containing no buttons.

**Logout**

Select for the Sign Out item to appear in the Actions List. 

Used to logout, or sign off, of the application, returning the user 
to the system signon page.

**Home**

Select for the Home button to appear on the fluid banner. 

Returns the user to the default fluid homepage, as if they’ve just 
signed on.

**Back**

Select for the Back button to appear on the fluid banner. 

Returns the user to the previously visited item.

**Note:** If you switch languages during the middle of a PeopleSoft 
session (such as during development or testing), the Back button 
will continue to display the original language. The current 
language for a session can be switched using PeopleTools, 
Utilities, International, Preferences.

**Add To**

Select for Add To items to appear in the Actions List. 

Enables a user to add a tile for the component to a fluid 
homepage, the NavBar, or Favorites.

**Help**

Select for the Help item to appear in the Actions List for the 
fluid pages in this component.

**Important!** This option is reserved for PeopleSoft-delivered 
components only.
When a user clicks Help, the system displays the PeopleSoft Online Help in a new browser page regardless of the form factor. The Help URL value must be specified in the General tab of the web profile to enable any online help (same as for classic components and pages). For more information on configuring online help URL for your PeopleSoft system, see "Configuring General Portal Properties" (PeopleTools 8.57: Portal Technology).

**Note:** For fluid applications, you cannot launch online help from modal pages.

**Note:** For the Safari browser, running on iOS in full screen mode, PeopleSoft Online Help is displayed in a full modal page.

### Notifications

Select for the Notifications button to appear on the fluid banner. When a user clicks the Notification button, the Notification window shows the list of push notifications for that user, such as actions and alerts. See "Using the Notification Window" (PeopleTools 8.57: Applications User's Guide) for more information.

Deselect this option to disable notifications while within a specific component.

### NavBar

Select for the NavBar button to appear on the fluid header, providing users with additional navigation features, such as the Navigator menu, Favorites, and other NavBar tiles.

### Related Links

"Working with the Controls in the Fluid Banner" (PeopleTools 8.57: Applications User's Guide)

### Setting Component Internet Properties for Fluid Components

Use the Component Properties, Fluid tab to set some fluid component properties.

If a component is a fluid component, then most of the properties on the Internet tab of the Component Properties dialog box do not apply. For example, none of the Toolbar actions apply.

However, these properties on the Internet tab do apply to Fluid components:

- Primary Action (Search Pages).
- Display Folder Tabs.
- Process Mode options (except for Allow Expert Entry).

For more information on the Internet tab off the Component Properties dialog box, see "Setting Internet Properties" (PeopleTools 8.57: Application Designer Developer's Guide).
Providing Left Navigation Using PT_SIDE_PAGETABS

Some fluid pages are the only page within a fluid component. In which case, they are standalone, and once an end user arrives at them, there is obviously no need to provide additional navigation devices within the component. However, other fluid components may have multiple pages within a component. You then need to consider how you would like users to navigate through the component.

By default, similar to classic components, the page tabs appear across the top of the page, always visible to the end user.

**Image: Fluid Component: Page Tabs on Top**

This example illustrates the default appearance of page tabs in a fluid component. They appear across the top of the main transaction page, similar to the classic interface.
This example illustrates adding the delivered PT_SIDE_PAGETABS page definition to a fluid component. No other configuration, other than inserting this page definition into the component, is required to achieve left navigation.

This example illustrates the effect of inserting PT_SIDE_PAGETABS into the fluid component. The page tab navigation appears on the left side panel, which end users can slide in and out when needed.

This topic discusses setting up search pages for fluid components.

For a fluid component, you have these options for providing search when a user accesses the component:
Chapter 4 Defining Components for Fluid Applications

<table>
<thead>
<tr>
<th>Fluid Component Search Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Real-time</td>
<td>Based on a pivot grid that builds a query against the component search record. See Setting up Real-Time Search for Fluid Components.</td>
</tr>
<tr>
<td>Keyword</td>
<td>Based on a search index created using the Search Framework and mapped to the fluid component. See Setting up Keyword Search for Fluid Components.</td>
</tr>
</tbody>
</table>

For any custom fluid component that you create, Oracle recommends that as part of the normal page and component development, you also create:

- A component-based pivot grid (for real-time component search).
- A search definition in the Search Framework for indexing the underlying application data (for keyword search).

A custom fluid component must employ at least one of the search options. You can employ both options. If neither search option is configured, you will need to bypass search completely using some other mechanism (for example, using SearchInit PeopleCode). Otherwise, the system displays an error, preventing access to the component.

When comparing one search option over the other, consider that the real-time search runs a search on all the data that is currently stored in the database while the keyword search may contain less current data. How current the data provided by the keyword search depends on how frequently the search indexes are updated. If you intend to employ only one of these search options, to ensure the best user experience, Oracle recommends employing the real-time search so the system reflects real-time data for end users.

Setting up Real-Time Search for Fluid Components

For classic components, the system automatically builds the component search page displayed to a user, with no additional effort required by the application developer. The system uses built-in logic to create the component search page on the fly based on the search keys defined on the search record for the component.

In the fluid user interface, the real-time component search page is not populated automatically by the system. For any custom fluid component that requires real-time, component search capabilities, the application developer must create a pivot grid, using the component as the data source. The pivot grid generates the underlying query using the search keys defined on the records in the component and populates the search page. See the product documentation for PeopleTools: Pivot Grid for creating a component-based pivot grid for use with implementing real-time search for a fluid component.

Creating a Pivot Grid for Real-Time Search

When creating a pivot grid for real-time fluid component search, keep these items in mind while using the Pivot Grid Wizard:

- Make sure the pivot grid Data Source Type is set to Component and the Component Name under Data Source reflects your fluid component on Step 1 of the wizard.
- Make sure the Default View is set to Chart Only under View Options on Step 4 of the wizard.
• Under Fluid Mode, Viewer Options on Step 4 of the wizard, select either Grid and List or List for Result View if you intend to use the Master - Detail search page type or you intend for the search results to be displayed on a small form factor. Selecting Grid is a valid option for the Standard search page type and if the fluid component would not be accessed by small form factor devices.

Setting Search Defaults for Real-Time Search

In a fluid component when search is enabled and an end user accesses the component, the system displays search results on the search page using the default search criteria provided by the application developer. If you do not provide default search criteria, the system displays an empty page, which may detract from the user experience.

When creating a pivot grid for real-time component search, you can provide default search criteria using these options:

• In the Pivot Grid Wizard, enter the desired values under Select Query Prompt Values in Step 3.
• In Application Designer on the Record Field > Use tab, set a Default Value for a search key in the search record.
• Use SearchInit PeopleCode to set a search record value to a particular value (record_name.field_name=value;).

Note: If you are using multiple options for setting default search criteria, the system imposes this order of precedence: SearchInit PeopleCode takes precedence over Record Field Default Value settings, and Record Field Default Value settings take precedence over any Query Prompt Values set in the pivot grid definition.

Related Links
"Understanding Component Real Time Search Using Pivot Grid in the Fluid Mode" (PeopleTools 8.57: Pivot Grid)
"Creating a Component Pivot Grid Model Using the Pivot Grid Wizard" (PeopleTools 8.57: Pivot Grid)

Setting up Keyword Search for Fluid Components

The keyword search for a fluid component is similar to the keyword search for a classic component. The keyword search runs against a search index built using the PeopleSoft Search Framework and deployed to the search engine, such as Oracle SES. The keyword search is more free-form and more “Google-like.” You implement keyword search for a fluid component using the same steps as you would complete for a classic component.

<table>
<thead>
<tr>
<th>Task</th>
<th>Documentation Cross Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create a query for the search definition.</td>
<td>See &quot;Understanding Search Definition Queries&quot; (PeopleTools 8.57: Search Technology).</td>
</tr>
<tr>
<td>Create a search definition.</td>
<td>See &quot;Creating Search Definitions&quot; (PeopleTools 8.57: Search Technology).</td>
</tr>
<tr>
<td>Map the search definition to your fluid component.</td>
<td>See &quot;Mapping Components to Search Definitions&quot; (PeopleTools 8.57: Search Technology).</td>
</tr>
</tbody>
</table>
### Task Documentation Cross Reference

<table>
<thead>
<tr>
<th>Task</th>
<th>Documentation Cross Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create a search category.</td>
<td>See &quot;Understanding Search Categories&quot; (PeopleTools 8.57: Search Technology).</td>
</tr>
<tr>
<td>Deploy and build your search index.</td>
<td>See &quot;Administering Search Definitions and Search Categories&quot; (PeopleTools 8.57: Search Technology).</td>
</tr>
</tbody>
</table>

When accessing a component with keyword search enabled, the search category mapped to that component appears selected in the Global Search box. Running a search on that category returns results only from the indexes in that category and displays them in PTS_NUI_SEARCH. If the user selects All or another search category and runs a search, the system treats the search as a global search, and the global search page (PTS_NUI_GBLSRCH) is used to display results.

### Setting Component Properties for Search Options

This section discusses setting component properties as they relate to setting up search for a fluid component.

#### Setting Internet Properties

You can set the default search mode for the fluid component using the Primary Action property in the Search Page group box on the Component Properties > Internet tab:

- **New**: Add mode.
- **Search**: Real time component search.
- **Keyword Search**: Search Framework-based search on the search category associated with the component.

**Note:** If a fluid component is designed to provide both real-time component search and keyword search, then real-time component search should be used as the default search option. That is, the Primary Action setting on Component Properties > Internet tab: should set to *Search*.

#### Setting Fluid Properties

When setting properties on the Component Properties > Fluid tab, the properties in the following table relate to implementing search for a fluid component:
### Property

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
</table>
| Search Type        | • None: Disables a search page from appearing for a fluid component. If selected, you need to ensure you have bypassed the search requirement sufficiently, such as by using SearchInit PeopleCode.  
• Standard: Select to display the “standard” search page, derived from the search page definition: PTS_NUI_SEARCH. Using the page, the end users view the search results, and drill into the component.  
• Master/Detail: Select to display the “standard” search page, derived from the search page definition: PTS_NUI_SEARCH_S. Using the page, the end users view the search results, and drill into the component. With the Master/Detail option, the search results remain displayed in the left side panel while the component displays in the right panel.  

**Note:** Standard or Master/Detail search types may be used for both real-time or keyword search options. |
| Next/Previous in List | Select to display features for end users to use for navigating through the search results. The Next/Previous icons will appear in the fluid banner after drilling into a component search result. |

### Related Links

**Setting Component Properties for Fluid Components**  
"Setting Component Properties" (PeopleTools 8.57: Application Designer Developer's Guide)

### Working with Search Pages

The search pages the system displays for classic applications are not displayed for fluid applications. For each type of fluid search, component search or Search Framework-based keyword search, PeopleTools delivers a default search page. The delivered search page definitions must be the base for any custom or system search page as they contain the basic framework and structures to use as a reference. If you decide you need a custom search page for a specific fluid component, you can clone the delivered search page and add or remove elements as needed. The following table lists the delivered default search pages:

<table>
<thead>
<tr>
<th>Definition Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PTS_NUI_SEARCH</td>
<td>Standard search page.</td>
</tr>
<tr>
<td>PTS_NUI_SEARCH_S</td>
<td>Master - Detail search page.</td>
</tr>
</tbody>
</table>
The default system-wide search, PTS_NUI_SEARCH, is set on the PeopleTools Options page in the Fluid Mode Properties group box. It is not recommended to override the system-wide search page on PeopleTools options, as this would affect every fluid component. If you need a custom search page for your fluid application, set the Search Type to None on the Fluid tab of the Component Properties dialog box, and insert your custom search page within your fluid component so that it loads at runtime when the component is accessed.

For more information on the Fluid Mode Properties, see Configuring PeopleTools Options for Fluid Applications.

The page design of PTS_NUI_SEARCH uses the two-panel layout template, and contains numerous group box containers and subpages. If creating a custom search page based on this template, you can remove the subpage for the feature you don't want to include on your search page. For example, if you don't want to include charts or facets, remove the PTS_NUI_FACETS and PTS_NUI_CHARTAREA subpages.

### Comparing the Availability of Fluid Search Features to Classic Search Features

Due to the differences between classic applications and fluid applications, not every search feature that is available for classic applications is available for a fluid application, and vice versa. Likewise, within a fluid application, not every search feature is available on every device type. For example, a search option used on a tablet or laptop, may not be available for use on a smartphone.

The following table lists the feature differences between classic applications and the fluid applications.

<table>
<thead>
<tr>
<th>Feature</th>
<th>Classic Applications</th>
<th>Fluid Applications</th>
</tr>
</thead>
<tbody>
<tr>
<td>Persistent Search</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Images in results</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Related Actions in component search results</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Related Actions in keyword search results</td>
<td>Only in List View</td>
<td>Yes</td>
</tr>
<tr>
<td>Bulk Related Actions</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Conditional Global Search</td>
<td>Yes</td>
<td>Yes</td>
</tr>
</tbody>
</table>
Defining Components for Fluid Applications

<table>
<thead>
<tr>
<th>Feature</th>
<th>Classic Applications</th>
<th>Fluid Applications</th>
</tr>
</thead>
<tbody>
<tr>
<td>Facets in component search results</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>List view in component search results</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Chart view in component search results</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Add a New Value</td>
<td>Yes</td>
<td>Yes</td>
</tr>
</tbody>
</table>

The following table lists the feature differences between various devices when accessing the fluid user interface.

<table>
<thead>
<tr>
<th>Feature</th>
<th>Desktop/Laptop</th>
<th>Tablet</th>
<th>Phone</th>
</tr>
</thead>
<tbody>
<tr>
<td>Related Actions</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Bulk Related Actions</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Chart interaction in component search</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
</tr>
</tbody>
</table>

**Note:** The features by device table contains only those features where differences occur on one or more devices. For any feature not appearing, it can be assumed that feature is available on all supported devices.

**Working with Master/Detail Components**

This topic provides an overview and describes how to implement a fluid application using the master/detail model.

**Understanding Master/Detail Components**

Master/detail components provide an approach for providing access to pages spanning multiple components, aggregating the navigation to the various pages all within a single master/detail component. Similar to classic WorkCenters, the pages accessible from within master/detail components are intended for a particular role, providing quick access to the components and pages used most frequently. In this regard, master/detail components provide WorkCenter-like functionality for fluid applications. Typically, the components and pages accessed from within master/detail components are not necessarily presented sequentially, as in there is no implied procedure or sequence for accessing the pages. Without the use of the master/detail construct, users would typically navigate to these components and pages separately via the Navigator menu as needed.
Example of a Master/Detail Application

Image: Master/detail example: Accounts Payable WorkCenter

This example illustrates a master/detail application, the Accounts Payable WorkCenter. The left panel provides navigation while the target content is displayed on the right.

Guidelines and Limitations for Master/Detail Components

Note the following guidelines and limitations for target content and master/detail components:

- For a fluid component to be included as target content, it must be defined as a **Standard** fluid component.

  **Important!** A fluid wrapper component (that is, a fluid activity guide, another master/detail component, or fluid navigation collection) can never be included as target content inside a master/detail component.

- Typically, for each page defined within the fluid component, the outermost group box must include the `ps_apps_content` style or another styling appropriate to the page design.

- Unless AJAX transfers are enabled on the master/detail component, the fluid component should not perform a transfer to another component. This includes transfers via a hyperlink, a push button, or a PeopleCode program. Such transfers will result in the user exiting the master/detail component. See **AJAX Transfers** for more information.

- If the target content is a fluid component that employs an internal two-panel construct (that is, it either includes a Side Page 1 page, was built from the PeopleTools 8.54 PSL_TWOPANEL layout page, or was designed with an internal left panel similar to PSL_TWOPANEL), you must enable left panel collision handling with the slide-out left panel on the master/detail component. See **Left Panel Collision Handling with Slide-out Left Panels** for more information.

- User search interactions are not allowed for fluid components that are displayed in the master/detail target area. Use other mechanisms to set component keys for each fluid component. See **Creating a Translator Component to Handle Search Initialization** for examples.

- The fluid component definition must not include a Header Page page definition.
• Including a Footer Page page definition within a fluid component displayed as target content inside of a master/detail component may or may not follow usability standards and could create a confusing user experience.

• To use a multi-page fluid component in a master/detail component, you can do one of the following to maintain a clear and consistent user experience:

  • Reparent the page tabs to a group box of type Page Tab that is included on each page definition.

  • Include PT_SIDE_PAGETABS in the component definition to reparent the page tabs to the left panel. You must also enable left panel collision handling with the slide-out left panel on the activity guide. See Left Panel Collision Handling with Slide-out Left Panels for more information.

  • Hide the page tabs. You can do so in the component definition by deselecting the Display Folder Tabs (top) on the Internet tab. Alternatively, you can use delivered styles to hide the page tabs.

  • If you want the master/detail component to maintain the same title in the fluid banner regardless of which page is displayed as target content, then set the title in whichever definition generates the content for the master list using the PeopleTools-delivered SetSideTopTitle JavaScript function. For example:

    ```javascript
    AddOnLoadScript("SetSideTopTitle('" | EscapeHTML("My M/D Component's Title") | "\n");
    
    • If your master/detail component controls the title in the fluid banner (see the preceding bullet item), for each page defined within the target component, you should include a group box of type Page Title that is defined to be visible when the page is rendered within a master/detail component. This Page Title group box provides context that is lost when the page title is not displayed in the fluid banner. To hide this page title if the page is rendered outside of a master/detail component, use the psc_hideinmode-notmd style.

Understanding the Elements of Master/Detail Components

This section describes the essential elements of master/detail components.
Image: Master/detail elements

This graphic illustrates the main elements of master/detail components.

- The master/detail component definition - PT_MDSTARTPAGE_NUI in the example.
- A side page definition, which will display the navigation elements - PT_MDSIDEDEPAGE in the example.
- A target page definition, which will display the target content - PT_MDSTARTPAGE_NUI in the example.

Master/Detail Component

The master/detail component has its component type set to Master/Detail on the Component Properties: Fluid tab. This component contains two page definitions: a target page for the details and a side page for the master list.

PeopleTools provides a default master/detail component: PT_MDSTARTPAGE_NUI that you can clone and modify or use as is.
Image: PT_MDSTARTPAGE_NUI component

This example illustrates the PT_MDSTARTPAGE_NUI component definition.

Master/Detail Side Page

The master/detail side page provides the left navigation in the form of a side panel. The side page acts as the master, controlling the navigation, whereas the target page acts as the details, displaying when called by the master. The master/detail side page has page type set to Side Page 1 on the Page Properties: Use tab.

PeopleTools provides a default master/detail side page: PT_MDSIDEPAGE that you can clone and modify or use as is.

Image: Master/detail side page

This example illustrates the PT_MDSIDEPAGE definition.

The inner group box (selected in this example) will display the master list to the user. The group box type is Layout Only with this style applied: ps_masterlist-group.

Master/Detail Target Page

The target page displays the content accessed from the side page navigation. The target page has page type set to Master&Detail Target Page on the Page Properties: Use tab.
PeopleTools provides a default master/detail target page: PT_MDSTARTPAGE_NUI that you can clone and modify or use as is.

**Image: Master/detail target page**

This example illustrates the PT_MDSTARTPAGE_NUI definition.

The Target Content group box is placed on the target page and displays the target content at runtime. The group box type is Master/Detail Target with this style applied: *ps_ag-targetcontent*.

---

**Implementing Master/Detail Components**

While you can clone the delivered PT_MDSTARTPAGE_NUI component and the pages within that component, the following procedure demonstrates how you can reuse the delivered definitions to load the master list from a different component.

To load the master list from a different component:

1. Create a dynamic view record definition—for example, MY_NAVLIST_DVW. Add these fields to the dynamic view:
   - LINE_NBR — For the hyperlink to the target content.
   - COUNTER — If a dynamic counter needs to be displayed along with the link.

2. Create a standard page definition—for example, MY_NAVLIST. On the Use tab, select the Fluid Page check box.

3. Add a group box that covers the entire page. On the Fluid tab, define these properties of the group box:
   - In the Style Classes field, enter *psc_scroll*.
   - For the Group Box Type field, select *Layout Only*. 
4. Add a grid to the page. Define these properties of the grid:
   - On the General tab, select the Unlimited Occurs Count (rows) check box.
   - On the Label tab, click the Display Navigation Bar: Properties button; on the Row Cntr tab, select the Invisible check box.
   - On the Label tab, deselect the following three check boxes: Show Border, Show Row Headings (runtime), and Show Column Headings (runtime).
   - On the Use tab, select the following two check boxes: No Auto Select, and No Auto Update.
   - On the Use tab, for the Grid Layout field, select List Grid Layout (Unordered).
   - On the Fluid tab, in the Style Classes field, enter psc_list-linkmenu psc_wrap psc_list-has-icon psc_list-separator-dark psc_border-standard psc_border-bottomonly psc_list-icons-active.
   - On the Fluid tab, in the Custom Grid Header field, select 0 | None.

5. Add a group box as the first column to the grid associated with the PTLAYOUT.GROUPBOX1 field. On the Fluid tab, define these properties of the group box:
   - In the Style Classes field, enter ps_vtab.
   - For the Group Box Type field, select Layout Only.

6. Add a push button/hyperlink as the second column in the grid associated with the MY_NAVLIST_DVW.LINE_NBR field. Define these properties of the hyperlink:
   - On the Type tab, for the Type field, select Hyperlink.
   - On the Label tab, select the Both check box.
   - On the Fluid tab, for label rendering, select the After Control radio button.

7. If you wish to display a dynamic counter as part of the link to the target content, add an edit box as the third column in the grid associated with the MY_NAVLIST_DVW.COUNTER field. On the Fluid tab, define these properties of the edit box:
   - In the Style Classes field, enter psc_list-count.
   - For the Input Type field, select text.

8. Insert a group box around the grid. On the Fluid tab, for the Group Box Type field, select Layout Only.
9. Add a page Activate PeopleCode program to the page definition. Your PeopleCode program must:

- Get the initial row from the URL parameters and then set the active row in the master list.
- For each link in the master list, add a row to the rowset representing the grid on your page.
- For each link, generate the URL to the target content. For example, use the GenerateComponentContentURL built-in function.
- Specify this URL as the action URL of the PTLAYOUT,GROUPBOX1 group box field.
- For the MY_NAVLIST_DVW.LINE_NBR hyperlink field, specify the item number in the master list, the label to be displayed for this list item, and an optional image.
- For the optional the MY_NAVLIST_DVW.COUNTER dynamic counter, retrieve and set the dynamic value.

The following example page Activate program creates four items in the master list: a fluid component, a fluid component with additional URL parameters, a classic component, and a fluid dashboard. The same optional image is reused for each list item. In addition, the counter for each item is hard-coded and not dynamically retrieved.

```peoplecode
Local string &sNewURL, &sMenu, &sComp, &sPage;
Local number &nRow = 0;
Local Rowset &rs = GetLevel0()().GetRowset(Scroll.MY_NAVLIST_DVW);
```
If &rs <> Null Then
    /* Get the initial row number from the URL. */
    If (%Request.GetParameter("nRow") <> "") Then
        &nRow = Value(%Request.GetParameter("nRow"));
    End-If;
    /* Set the active row in the master list. */
    If (IsGroupletRequest()) Then
        AddOnLoadScript("DoRowAction(" | &nRow | ");");
    End-If;
    /* Use SetSideTopTitle to maintain the same title in the fluid banner regardless of what is displayed as target content. Use a Message Catalog entry. */
    /* AddOnLoadScript("SetSideTopTitle(" | EscapeHTML("My M/D Component's Title") | "");"); */
    /* Specify the first row in the master list. */
    Local integer &n = &rs.ActiveRowCount;
    &sMenu = "MenuName.MY_MENU";
    &sComp = "Component.MY_COMP1_FL";
    &sPage = "Page.MY_PAGE1";
    &sNewURL = EncodeURL(GenerateComponentContentURL(%Portal, %Node, @&sMenu, %Market, @&sComp, @&sPage, "U"));
    &rs(&n).PTLAYOUT.GROUPBOX1.SetGroupletActionUrl(&sNewURL);
    &rs(&n).PTLAYOUT.GROUPBOX1.SetGroupletDisplayIn(%GroupletActionMDTargetFluid);
    &rs(&n).PTLAYOUT.GROUPBOX1.IsGroupletLabelOnly = True;
    &rs(&n).PTLAYOUT.GROUPBOX1.Visible = False;
    &rs(&n).MY_NAVLIST_DVW.LINE_NBR.Value = &n;
    &rs(&n).MY_NAVLIST_DVW.LINE_NBR.Label = "Fluid Component 1";
    &rs(&n).MY_NAVLIST_DVW.LINE_NBR.LabelImage = @("Image.CHECKLIST_64");
    &rs(&n).MY_NAVLIST_DVW.COUNTER.Value = 5;
    /* Insert another row in the master list. */
    &rs.InsertRow(&n);
    &n = &rs.ActiveRowCount;
    &sMenu = "MenuName.MY_MENU";
    &sComp = "Component.MY_COMP1_FL";
    &sPage = "Page.MY_PAGE2";
    /* Includes additional URL parameters. */
    &sNewURL = EncodeURL(GenerateComponentContentURL(%Portal, %Node, @&sMenu, %Market, @&sComp, @&sPage, "U") | ";&CONNGATEWAYID=LOCAL");
    &rs(&n).PTLAYOUT.GROUPBOX1.SetGroupletActionUrl(&sNewURL);
    &rs(&n).PTLAYOUT.GROUPBOX1.SetGroupletDisplayIn(%GroupletActionMDTargetFluid);
    &rs(&n).PTLAYOUT.GROUPBOX1.IsGroupletLabelOnly = True;
    &rs(&n).PTLAYOUT.GROUPBOX1.Visible = False;
    &rs(&n).MY_NAVLIST_DVW.LINE_NBR.Value = &n;
    &rs(&n).MY_NAVLIST_DVW.LINE_NBR.Label = "Fluid Component 2";
    &rs(&n).MY_NAVLIST_DVW.LINE_NBR.LabelImage = @("Image.CHECKLIST_64");
    &rs(&n).MY_NAVLIST_DVW.COUNTER.Value = 12;
    /* Insert the third row in the master list. */
    &rs.InsertRow(&n);
    &n = &rs.ActiveRowCount;
    &sMenu = "MenuName.MY_OTHER_MENU";
    &sComp = "Component.MY_CLASSIC_COMP";
    &sPage = "Page.MY_PAGE3";
    /* Classic components require a different value. */
    &sNewURL = EncodeURL(GenerateComponentContentURL(%Portal, %Node, @&sMenu, %Market, @&sComp, @&sPage, "U"));
    &rs(&n).PTLAYOUT.GROUPBOX1.SetGroupletActionUrl(&sNewURL);
    &rs(&n).PTLAYOUT.GROUPBOX1.SetGroupletDisplayIn(%GroupletActionMDTargetClassic);
    &rs(&n).PTLAYOUT.GROUPBOX1.IsGroupletLabelOnly = True;
    &rs(&n).PTLAYOUT.GROUPBOX1.Visible = False;
    &rs(&n).MY_NAVLIST_DVW.LINE_NBR.Value = &n;
    &rs(&n).MY_NAVLIST_DVW.LINE_NBR.Label = "Classic Component 1";
&rs(&n).MY_NAVLIST_DVW.LINE_NBR.LabelImage = @("Image.CHECKLIST_64");
&rs(&n).MY_NAVLIST_DVW.COUNTER.Value = 1;

/* Insert the fourth row in the master list. */
&rs.InsertRow(&n);
&n = &rs.ActiveRowCount;
&sMenu = "MenuName.PT_FLDASHBOARD";
&sComp = "Component.PT_FLDASHBOARD";
&sPage = "Page.PT_LANDINGPAGE";

/* Specify which fluid dashboard as a URL parameter. */
&sNewURL = EncodeURL(GenerateComponentContentURL(%Portal, %Node, @&sMenu, %Market, @&sComp, @&sPage, "U") | 
&"&DB=QE_CHART_DB");
&rs(&n).PTLAYOUT.GROUPBOX1.SetGroupletActionUrl(&sNewURL);
&rs(&n).PTLAYOUT.GROUPBOX1.SetGroupletDisplayIn(%GroupletActionMDTargetFluid);
&rs(&n).PTLAYOUT.GROUPBOX1.IsGroupletLabelOnly = True;
&rs(&n).PTLAYOUT.GROUPBOX1.Visible = False;
&rs(&n).MY_NAVLIST_DVW.LINE_NBR.Value = &n;
&rs(&n).MY_NAVLIST_DVW.LINE_NBR.Label = "Chart Dashboard";
&rs(&n).MY_NAVLIST_DVW.LINE_NBR.LabelImage = @("Image.CHECKLIST_64");
&rs(&n).MY_NAVLIST_DVW.COUNTER.Value = 0;

End-If;

**Image: Example master list for MY_NAVLIST**

This example illustrates the rendering of the master list based on the preceding PeopleCode example. The initial list item (nRow=2) is selected by default when the master/detail application is opened.

10. If you want the master/detail component to maintain the same title in the fluid banner regardless of which page is displayed as target content, then uncomment and use the SetSideTopTitle JavaScript function to set the title.

11. Create a fluid component definition—for example, MY_NAVLIST:

   • On the Use tab, select *INSTALLATION* as the search record.
   • Insert the MY_NAVLIST page into the component.

12. Use the component Registration Wizard to add the component to a menu and permission list.
Important! Do not register the component in the portal registry.

13. Manually, create a content reference definition to launch your master/detail application:

   a. In the browser, select PeopleTools > Portal > Structure and Content.

   b. Create the content reference definition in the menu folder where you want the menu item to appear.

   **Note:** To make your master/detail application available as a tile only and not as a menu item in the menu structure, create the content reference definition in the tile repository. See "Understanding Tile Definitions and the Tile Repository" (PeopleTools 8.57: Portal Technology).

   c. In the content reference definition, specify the delivered PT_MDSTARTPAGE_NUI component in the URL information as follows:

      | Node Name | LOCAL_NODE |
      | URL Type | PeopleSoft Component |
      | Menu Name | NUI_FRAMEWORK |
      | Market | GBL |
      | Component | PT_MDSTARTPAGE_NUI |

   **Image: URL information for a master/detail application using PT_MDSTARTPAGE_NUI**

   This example illustrates the fields in the URL Information group box for a master/detail application based on the delivered PT_MDSTARTPAGE_NUI.

   d. Add four additional parameters to the URL definition to identify the component you created to define your master list:

      **nRow**
      Specify the list item to be displayed when the master/detail is initially opened. A value of 0 represents row 1 in the list.

      **GMenu**
      (Required) Specify the menu name you used to register your component.

      **GComp**
      (Required) Specify the name of the component containing the master list.
Chapter 4 Defining Components for Fluid Applications

GPage

Specify the name of the page containing the master list.

e. Specify any additional URL parameters required for correct rendering and operation of your master/detail application—for example, whether AJAX transfers are allowed or whether to use the slide-out left panel. See Working with Two-Panel Implementations for more information.

When to Clone the Delivered PT_MDSTARTPAGE_NUI Definitions

In some circumstances, to implement a master/detail application, you may want to clone the PT_MDSTARTPAGE_NUI component and the page definitions it includes. These situations include:

• You need to execute additional initialization PeopleCode for the master/detail component that is not in the PeopleTools-supplied component.
• You need to use more than one grouplet for the navigation list in the left panel.

Related Links
"GenerateComponentContentURL" (PeopleTools 8.57: PeopleCode Language Reference)

Working with Two-Panel Implementations

Several fluid application design patterns make use of the two-panel paradigm in which navigation links are displayed in the left panel and the content is displayed in a target content area on the right. These fluid application design patterns include:

• Master/detail components.
• Fluid activity guides.
• Fluid navigation collections.

AJAX Transfers

AJAX transfers, or asynchronous in-place transfers, use AJAX (asynchronous JavaScript and XML) technology to allow component-to-component transfers to occur without exiting from the fluid wrapper (fluid activity guide or master/detail component) that contains the source component from which the transfer was invoked. When AJAX transfers are enabled for the fluid wrapper, then the new content replaces the target content area within the fluid wrapper. When AJAX transfers have not been enabled (the default configuration), the new content replaces the entire browser window. AJAX transfers apply to four PeopleCode functions only: Transfer, TransferExact, ViewContentURLContent, and ViewContentURLFluid.
The following diagram illustrates the elements that are presented within a fluid wrapper component:

- **Fluid banner** — With fluid activity guides, the content of the fluid banner is maintained by the activity guide. With master/detail components, the content is maintained by the individual components displayed in the target content area.

- **Optional sub-banner** — With fluid activity guides, the content of the sub-banner is maintained by the activity guide.

- **Navigation panel** — The items in the navigation panel are presented by the fluid wrapper component.

- **Target content area** — The component selected in the navigation panel is displayed in the target content area.

Since AJAX transfers are disabled by default, you must explicitly enable AJAX transfers on each fluid wrapper where the behavior is desired:

- For fluid activity guides including fluid navigation collections, add the following query string parameter to the URL for the content reference definition that launches the activity guide: 
  ```
  &AJAXTransfer=y
  ```

- For master/detail components, add the following query string parameter to the URL for the content reference definition that launches the master/detail component: 
  ```
  &ICAJAXTrf=true
  ```

- If you are creating a custom fluid wrapper definition in Application Designer (that is, a custom master/detail component or a custom activity guide component), use the `SetMDAJAXTrf` function.
In addition, when you enable AJAX transfers, then you might also need enable a slide-out left panel to prevent inadvertent left panel collisions:

- For master/detail components, fluid activity guides, and fluid navigation collections, add the following query string parameter to the URL for the content reference definition that launches the fluid wrapper: &ICMDListSlideout=true

- If you are creating a custom fluid wrapper component definition, use the SetMDListSlideout function.

**Related Links**

"SetMDAJAXTrf" (PeopleTools 8.57: PeopleCode Language Reference)
"SetMDListSlideout" (PeopleTools 8.57: PeopleCode Language Reference)
"Transfer" (PeopleTools 8.57: PeopleCode Language Reference)
"TransferExact" (PeopleTools 8.57: PeopleCode Language Reference)
"ViewContentURLClassic" (PeopleTools 8.57: PeopleCode Language Reference)
"ViewContentURLFluid" (PeopleTools 8.57: PeopleCode Language Reference)

**Left Panel Collision Handling with Slide-out Left Panels**

The “slide-out” left panel is a feature that enables you to include a component that itself has a left panel within fluid wrappers (master/detail components, fluid activity guides, fluid navigation collections, or custom fluid wrapper components) that also use the left panel to present navigation links. If collision handling with the slide-out left panel is not enabled, contention will occur as both the outer and inner components attempt to manage the contents of the left panel. When this occurs, users lose the ability to navigate via the navigation links of the outer, wrapper component, via the navigation links of the inner component, or both.

Two types of contention (or collisions) can occur depending on the implementation of the inner component that causes the collisions:

- *Intra-page collisions* occur when the inner component has included its own left panel (that is, a page type of Side Page 1). Because the fluid wrapper also implements the left panel using Side Page 1, the collisions occur *within* this side page. Fluid components developed on PeopleTools 8.55 and later releases use Side Page 1 to implement the left panel.

- *Inter-page collisions* occur when the inner component has included the left panel as part of the page content—for example, in PeopleTools 8.54, the PSL_TWOPANEL layout page provided one mechanism for creating a left panel. In this case, the collisions occur *between* the Side Page 1 of the fluid wrapper and the content of the inner component.

**Important!** A fluid wrapper component (that is, a master/detail component, a fluid activity guide, or a fluid navigation collection) can never be displayed inside another fluid wrapper component. Enabling the slide-out left panel cannot be used to overcome this inflexible limitation.
When the slide-out left panel is enabled and an inner component *without* its own left panel is displayed, the left panel of the outer, fluid wrapper is displayed normally; there is no need for a slide-out left panel.
When the slide-out left panel is enabled and an inner component with its own left panel is displayed, the left panel of the outer, fluid wrapper is initially minimized as shown in the following example. The navigation links displayed are those from the inner component:
Clicking anywhere on the tab divider (labeled Detail, in this example) will slide open the left panel of the outer, fluid wrapper. The navigation links displayed are those from the outer, fluid wrapper:

The slide-out left panel is disabled by default. You must enable the slide-out left panel on each fluid wrapper definition which requires its use:

- For master/detail components, fluid activity guides, and fluid navigation collections, add the following query string parameter to the URL for the content reference definition that launches the fluid wrapper: &ICMDListSlideOut=true
- If you are creating a custom fluid wrapper, use the SetMDListSlideout function.

In addition, when you enable AJAX transfers, then you might also need to enable a slide-out left panel to prevent inadvertent left panel collisions.

**Related Links**

"SetMDListSlideout" (PeopleTools 8.57: PeopleCode Language Reference)
"IsSide1CollisionInterPage" (PeopleTools 8.57: PeopleCode API Reference)
"IsSide1CollisionIntraPage" (PeopleTools 8.57: PeopleCode API Reference)
"IsSide1HasCollision" (PeopleTools 8.57: PeopleCode API Reference)
AJAX Transfers
Creating a Translator Component to Handle Search Initialization

Within fluid activity guides, master/detail components, and fluid navigation collections, search interactions are not allowed for fluid components. Moreover, the search type must be set to none. In addition, SearchInit PeopleCode cannot be used to set search keys. Therefore, you must use some other mechanism to set component keys for each fluid component.

The following examples show how you could create a “translator component” to set the search keys and then redirect the user to the actual target component. In each example for simplicity in comparisons, it is assumed that two search keys are required and that both keys are of type string. In these examples, the key values are hard-coded within the program. However, you could use other techniques such as global variables or selecting the values from the database as would be appropriate for your application.

**Example 1: Classic Target Component**

In the case of a classic target component, SearchInit PeopleCode can be used directly and no translator component is required.

Add a PeopleCode program similar to the following in the target component’s SearchInit event:

```plaintext
Local string &key1 = "value_1";
Local string &key2 = "value_2";
If All(&key1) And
  All(&key2) Then
  SRCH_REC.KEY1.Value = &key1;
  SRCH_REC.KEY2.Value = &key2;
  SetSearchDialogBehavior(0);
End-If;
```

**Example 2: Populating the Search Record in the Translator**

In the case of a fluid target component, if *all* search keys can be populated in the search record, then you can use the Transfer function to transfer to the target component.

---

**Note:** When using the Transfer function, ensure that AJAX transfers are enabled for the fluid wrapper; then the new content replaces the target content area within the fluid wrapper.

Add a PeopleCode program similar to the following in the translator component’s PostBuild event:

```plaintext
Local string &key1 = "value_1";
Local string &key2 = "value_2";
Local Record &sRecord = CreateRecord(Record.SRCH_REC);
If All(&key1) And
  All(&key2) Then
  &sRecord.KEY1.Value = &key1;
  &sRecord.KEY2.Value = &key2;
  End-If;
Transfer( False, MenuName.MENU_NAME, BarName.BAR_NAME, ItemName.MENU_ITEM_NAME, Page.COMPONENT_ITEM_NAME, %Action_UpdateDisplay, &sRecord);
```

**Example 3: Generating a URL with Query String Parameters**

In the case of a fluid target component, if *all* search keys *cannot* be populated in the search record, then you must generate the URL with custom query string parameters before invoking a built-in function to transfer to the target component.
Add a PeopleCode program similar to the following in the translator component’s PostBuild event:

```plaintext
Local string &key1 = "value_1";
Local string &key2 = "value_2";
Local Array of string &qry_str = CreateArrayRept("", 0);

If All(&key1) And All (&key2) Then
    &qry_str.Push("KEYVALUE1=" | EncodeURLForQueryString(&key1));
    &qry_str.Push("KEYVALUE2=" | EncodeURLForQueryString(&key2));
End-If;

Local string &sURL = GenerateComponentContentURL(Portal.PORTAL_NAME, Node.NODE_NAME⇒, MenuName.MENU_NAME, "GBL", Component.COMPONENT_NAME, ",", %Action_UpdateDisplay);

If &qry_str.Len > 0 Then
    &sURL = &sURL | &qry_str.Join("&", ";", ",");
End-If;

ViewContentURLFluid(&sURL);
```

**Related Links**

AJAX Transfers

**Testing Form Factors**

PeopleTools provides a built-in option for testing your fluid components and pages by form factor. You access this option from the PeopleSoft sign in page, by clicking the Set Trace Flags link prior to signing in. You enable the Set Trace Flags link to appear on the sign in page by enabling the Show Trace Link at Signon web profile property on the Debugging tab. Clicking the Set Trace Flags link enables an entire set of tracing options, not just the Form Factor Trace option.

**Important!** By default, the form factor trace option is disabled (hidden). To enable the Form Factor dropdown list to display on the sign in page, you need to add a custom web property to the current web profile. Add ShowFormFactor and set it to true. For information on adding custom web profile properties, see "Configuring Custom Properties" (PeopleTools 8.57: Portal Technology).

**Note:** Using the PeopleTools form factor trace option is not a replacement for browser emulation, third party emulation or simulation, or testing on actual devices (smartphones, tablets, laptops, desktops, and so on). It is provided as a tool to give you quick feedback and testing capabilities while developing fluid pages.
This example illustrates the Set Trace Flag link displayed on the PeopleSoft Sign-in page.

Once you click the Set Trace Flags link, the Select a Language drop-down list becomes the Form Factor drop-down list from which you can select the desired form factor.
Image: Form Factor Drop-Down List Box

This example illustrates the Form Factor drop-down list box displaying the options for selecting a form factor: Small, Medium, Large, and Extra Large.

After you select a particular form factor, the system displays a second browser window rendered in the dimensions of the form factor you selected, displaying the sign-in page.
Image: Form Factor Trace Sign-In Page

This example illustrates the sign-in page assuming the dimensions of the form factor you selected.

After signing in, you can navigate to and view the layout of a fluid page for the form factor you selected.
Image: Form Factor Trace Display

This example illustrates a fluid page rendering in the form factor you selected from the Form Factor trace option.
Chapter 5

Adding Page Controls

Managing Settings for Fluid Page Controls

This topic provides an overview and discusses common page control properties for fluid pages.

Understanding the Makeup of a Control on a Fluid Page

A basic input page control consists of two items:

- The control.
- The label.

The system considers the control and the label pairing as a single unit and presents them within a single container in the HTML—ps_box-<control_type>.

For example, in the case of an edit box, the system generated this structure in the HTML.

Image: HTML for fluid page controls

This example illustrates the appearance of the HTML used to display a page control.

```html
<div id="win0divWM_WR_HDR_CONTACT_DETAIL" class="ps_box-edit">
  <div id="win0divWM_WR_HDR_CONTACT_DETAILlbl" class="ps_box-label">
    <label id="WM_WR_HDR_CONTACT_DETAIL_LVL" class="ps-label" for="WM_WR_HDR_CONTACT_DETAIL">
      Alternate E-mail address or Phone number for this request only
    </label>
  </div>
  <div id="win0divWM_WR_HDR_CONTACT_DETAILctrl" class="ps_box-control">
    <input id="WM_WR_HDR_CONTACT_DETAIL" class="ps-edit" type="text" title="Alternate E-mail address or Phone number for this request only" onclick="javascript:cancelBubble(event);" maxlength="70" value=""/>
  </div>
</div>
```

The system generates default styles, which are styled through the style sheets. Applications can override or extend style by adding additional styles or replacing the top-level system default style. In the case of the example above, the application change chose to override the PeopleTools-provided style and it would remove the ps_box-edit class only in favor of the specified class from the application definition.
Setting Properties on the Fluid Tab

For any control that you can add to a page, such as a group box, an image, a grid, and so on, there is a Fluid tab on the properties dialog box for that control. All of the controls share some properties, while others have additional properties that apply only to the function of that control.

**Note:** The options documented below apply to all fluid page controls. Depending on the control selected for the page, additional properties may appear. Properties specific to an individual control type are documented within a section devoted to that control type.

**Image: Common Fluid tab Options**

This example illustrates the common page control options available for on the Fluid tab of the Properties dialog box for the control. Descriptions of the options follow the example.

<table>
<thead>
<tr>
<th>Record</th>
<th>Label</th>
<th>Use</th>
<th>General</th>
<th>Fluid</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Application-Specific Styles**

**Style Classes**

Form Factor Style Class Override

Small

Medium

Large

Extra Large

Suppress System-Supplied Style Classes

Supress On Form Factor

- Small
- Medium
- Large
- Extra Large

Label Rendering

- Before Control
- After Control

Control Structure

- Basic
- Advanced

Include Labels in Grid Cells

**Style Classes**
Enter additional style class specifications used for adjusting the display or behavior of a specific control. This setting applies to
all form factors unless specifically overridden by subsequent form factor overrides. These styles are either appended to or are used instead of the system-supplied style classes (that is, styles automatically applied by PeopleTools by default). Separate each style class by a space.

<table>
<thead>
<tr>
<th><strong>Form Factor Style Class Override</strong></th>
<th>Overrides any styles defined in the Style Classes field by applying additional style classes for a specific form factor (device size). If no value is specified as a form factor override, the Style Classes value is applied.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Suppress System-Supplied Style Classes</strong></td>
<td>Indicates to suppress any default system style classes that are automatically applied for this control type (for example, ps_box-edit would not be applied for an edit box). If selected, it applies to all form factors, and the system applies no PeopleTools default classes for the control (nor does the system load state information).</td>
</tr>
<tr>
<td><strong>Suppress on Form Factor</strong></td>
<td>To prevent a page element from being displayed on a specific form factor, select the appropriate form factor. If selected, the page element is never rendered on the client device, similar to setting a field as invisible for a classic page. Suppression can improve throughput as the size of the HTML document is reduced.</td>
</tr>
<tr>
<td><strong>Label Rendering</strong></td>
<td>The system processes the display of a control as a combined unit of both the display and its label. You can control the position of the label.</td>
</tr>
<tr>
<td></td>
<td><em>Before Control:</em> Select for the label to appear to the right of the control.</td>
</tr>
<tr>
<td></td>
<td><em>After Control:</em> Select for the label to appear to the left of the control.</td>
</tr>
<tr>
<td><strong>Control Structure</strong></td>
<td><em>Basic:</em> Select to have the control appear on the fluid page just as it would appear on a classic page.</td>
</tr>
<tr>
<td></td>
<td><em>Advanced:</em> Select to have the control appear on the fluid page with the look and feel of a modern, touch-enabled application. For example, a check box would appear as a toggle switch, rather than as a square box.</td>
</tr>
<tr>
<td><strong>Include Labels in Grid Cells</strong></td>
<td>If using a Tab Separator in your grid, you are allowed to generate field labels within a grid.</td>
</tr>
<tr>
<td></td>
<td>Typically, these are suppressed but because you can put group boxes within grids, the labels are appropriate to display what the individual fields are (depending on context).</td>
</tr>
</tbody>
</table>

Depending on the type of control you are adding to the page, there can be additional options for that control. Use the following links to find more information for each control.
Related Links
Working with Group Boxes
Working with Other Page Controls

Working with Group Boxes

This topic discusses the many uses of group boxes while creating fluid applications.

Using Group Boxes for Fluid Pages

Group boxes are essential containers used for the layout of the fluid page as well as containers for encapsulating and managing control and widget behavior, positioning, and appearance.

Any fluid page must have at least one over-arching group box to contain all other elements of the page. Depending on the number of controls and complexity of the page, additional group boxes can be added. The group box can be used to indicate visual cues but it can also act as a logical grouping of related controls. Using the fluid properties for a group box, you can override or customize the style at each group box layer.

The following example illustrates the use of multiple group boxes in the layout of the fluid page, clearly separating the page elements into distinguishable parts, enabling individual control if needed. For example, the Page Title group box and the Your Content Sub-Page here group box can have individual styles applied if needed.

Every Fluid page should start with a group box. Typically, the outer group box for primary or secondary pages should have the style of `ps_apps_content` class, though there are exceptions as with 2 panel display. While the `ps_apps_content` style would not typically be used in subpages, subpages should reside within a containing group box as well.
**Image: Group Boxes define fluid page layout**

This example illustrates how group boxes are used in the layout of the fluid page, clearly separating the page elements into distinguishable parts.

In general, it is recommended to be generous in the use of group boxes to layout and organize your page elements. However, group boxes are not just used for layout purposes. For some controls and widgets, it is required that they be encapsulated within a group box in order to apply behavior characteristics.

In addition to using group boxes as a container with a header (the default type of group box), a group box can have additional functions and behaviors. The most common is the usage of a layout type of group box. Layout group boxes are used to enclose elements for specific layout purposes. Some layouts are defined by styles only.

Some group boxes have additional types, like the Accordion Vertical group box which allows for multiple embedded Accordion group boxes to provide the behavior of a mutually exclusive display of group box, with only one of the Accordion Group boxes expanded and visible at any one time. Group boxes can even be put inside of grids to create new virtual columns containing multiple stacked fields.

Group boxes are the most critical element with which you should become familiar for fluid page development.

**Setting Group Box Properties**

This section describes properties specific to group boxes on a fluid page that you can set on the Fluid tab of the Group Box Properties dialog box.

Application Specific Styles and Suppress On Form Factor are common properties to all fluid controls. See Setting Properties on the Fluid Tab.
**Group Box Type**

- **Default**: Same as Container. It includes both a header structure and a content structure.

- **Container**: Use as a standard container, just as in classic applications, to illustrate groupings of fields.

  See [Working with Container Group Boxes](#).

- **Accordion Vertical/Horizontal/Group Box**: Used to implement expandable sections.

  Accordions are a construct where you have a mutually exclusive set of group boxes, only one of which can be expanded at a time (all others collapsed). Accordion Vertical is a container of Accordion Group boxes. The Accordion Group boxes are individual, expandable group boxes within the Accordion Vertical.

  See [Working with Accordion Group Boxes](#).

- **Layout Only**: Use for a group box only to contain and position child elements.

  See [Working with Layout Group Boxes](#).

- **Panel Control**: Use for containing content when creating a side tab.

- **Custom Header Left/Right/Middle/Bottom**: Use to add application controls to header page sections.

  See [Creating Custom Header Group Boxes](#).

- **Page Title**: Used to generate an H1 heading element (<h1>…</h1>) that displays either the page title (as would be found in the fluid banner) or the content title (as replicated from the item selected in the left panel in a two-panel implementation). See [Working with Two-Panel Implementations](#).

---

**Important!** Do not place any content or page controls within this group box container.

---

If you plan to allow the component that includes your page to be displayed within a fluid wrapper (a fluid activity guide or master/detail component), it is recommended that a Page Title group box (associated with a record field) be placed at the top of your page; this group box will display the content title. You should hide this Page Title group box when the component runs standalone and display it only when your component is displayed within a fluid wrapper. For activity guides (and fluid navigation collections), the activity guide framework automatically updates this page title found in the
content area to match the selection made in the navigation panel.

- **Related Field Group:** Used to create a FIELDSET collection where the LEGEND (the group box header) is repeated to a screen reader when input type elements are read within the FIELDSET. Typical usage would be when you have a collection of radio buttons based on the same field.

  See Working with Related Field Group Boxes

- **Toggle Container:** Use to switch between two group boxes and changes the label of the button controlling the toggle.

  **Note:** Currently, do not use the Toggle Container option. This option is for internal use only until a future release.

- **Custom Grid Header:** Similar to the Custom Header sections, the Custom Grid Header group box type allows you to define a custom area to be available for association with a grid. This is used when defining a grid to look for the available Custom Grid Header defined group boxes to associate with a grid. A custom grid header can be associated only with one grid.

- **Custom Action Menu:** Enables the transaction to add to the Actions List displayed in the banner.

- **Popup:** A type of group box, where the group box label is rendered as a button (a collapsible image can be used to identify an image as well to be displayed with the text). The button is rendered initially and when selected, the content appears as a Popup area associated with the button.

- **Custom Header Search:** Use to create a custom header for component search.

- **Page Tab:** Use to take page tabs running horizontally across the top of the component pages, and insert them into the left sidepage, creating left navigation. For sample usage, refer to PT_SIDE_PAGETABS.

- **Master/Detail Target:** Use to surround the content to be displayed when the master item in the left navigation side page is selected. Add this group box to a master/detail target page. For more information on the master/detail approach, see Working with Master/Detail Components.

- **Search Action:** Use to synchronize component search actions to the actions displayed on the Action List, (other area in the header if preferred). This enables a PeopleCode Event from the selected action, such as Return To List.
**Note:** When selected, also select UL as the HTML Tag Type.

- **Related Content:** Use to create drop zones for embedded related content or for dynamic subpages.
  - To create drop zones for embedded related content, see *Working with Embedded Related Content*.
  - To create drop zones for dynamic subpages, see *Creating Configurable Drop Zones for Dynamic Subpages*.

- **Menu and Menu Item:** Use as a container for a pop-up menu and for each menu item, respectively.
  
  See *Creating Fluid Pop-up Menus*.

- **Tab Set and Tab Item:** Use as a container for a set of sectional tabs embedded on a page and for each tab, respectively.
  
  See *Creating Sectional Tabs on a Page*.

<table>
<thead>
<tr>
<th>HTML Tag Type</th>
<th>Selecting an HTML tag type enables you to create proper HTML structure as defined by HTML specifications.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Default</strong></td>
<td>Same as DIV.</td>
</tr>
<tr>
<td><strong>DIV</strong></td>
<td>Set as an HTML 5.0 &lt;div&gt; tag.</td>
</tr>
<tr>
<td><strong>Section</strong></td>
<td>Set as an HTML 5.0 &lt;section&gt; tag. If creating a section containing an article, you may consider using this group box type.</td>
</tr>
<tr>
<td><strong>UL</strong></td>
<td>Set as an HTML 5.0 &lt;ul&gt; (unordered list).</td>
</tr>
<tr>
<td><strong>OL</strong></td>
<td>Set as an HTML 5.0 &lt;ol&gt; (ordered list).</td>
</tr>
<tr>
<td><strong>LI</strong></td>
<td>Set as an HTML 5.0 &lt;li&gt; (list item). Required to be structurally correct. The &lt;li&gt; should always be within a &lt;ul&gt; or &lt;ol&gt; tag, and nothing else should be directly beneath a &lt;ul&gt; or &lt;ol&gt; except for &lt;li&gt;.</td>
</tr>
</tbody>
</table>

**Draggable**

Indicates that content can be dragged out of the group box area. Users initiate drag and drop by using touch on touch screen devices and by using the mouse for desktops and laptops.

**Droppable**

Indicates that content can be dragged into the group box area.

**Gestures**

Select for group boxes where the drag, drop, and swipe gestures need to be available. Use to limit the scope of the drag, drop and swipe features so that these events are set and invoked efficiently.
For example, assume you want to drag an element from group box A to group box B, and the parent of these two group boxes is group box C. If you select Gestures for group box C, you do not need to set it individually for group box A and B.

**Scroll Bars**

- **None:** Display group box with no scroll bar.
- **Vertical:** Display the group box with a scroll bar on the right side, running top-to-bottom.
- **Horizontal:** Display the group box with a scroll bar on the bottom, running left-to-right.
- **Both:** Display both vertical and horizontal scroll bars.
- **Carousel:** Display the scroll bar in carousel mode (slider mode), where records can be viewed in defined sets by spinning or swiping.

**Scroll Sizing by Style**

Indicates that the size of the scroll will be controlled by style.

By default, PeopleTools attempts to control the sizing of the group box to accommodate the size of the current page size. If you want to restrict the size of the group box stylistically (using classes and CSS), you can do this so that the system does not attempt to change the size of the group box as needed.

---

**Working with Container Group Boxes**

Container group boxes can be used as a standard container, similar to classic application usage. Use group boxes to associate relevant page field controls and to create a page that is intuitive to the user.

When using container group boxes, keep these items in mind:

- A default, system style provides a standard look and feel.
- A header will be generated if a label is defined.
- Custom styles can be used to override default styles.
- The default HTML tag used for group box is “div,” which you can override with the HTML Tag Type option.
- You can set the group box as Section and Article elements.
- Can be used as a collapsible data area.

**Working with Accordion Group Boxes**

The Accordion is a web control that allows you to provide multiple, collapsible panes and display them one at a time. With an accordion group box,

When working with the accordion feature:
Adding Page Controls Chapter 5

- Set the parent group box container as Accordion Vertical for vertical accordion behavior (up and down) or Accordion Horizontal for horizontal accordion behavior (left and right).

- Set the children group boxes (the group boxes that will be the recipient of the expanding and collapsing behavior) as Accordion Group Boxes.

**Note:** Horizontal Accordion group boxes should not be used in the current release. It is reserved for internal use.

**Image: Accordion Group Box Container Structure**

This example illustrates that when creating an accordion construct, the outer group box is assigned the Accordion Vertical group box type, and the content within resides in group boxes of type Accordion Group Box.

**Image: Accordion Group Box Vertical After Page Load**

This example illustrates how an accordion group box appears initially, after page load, with all sections collapsed, by default.
Image: Accordion Group Box Vertical After Selecting a Section

This example illustrates how one section can be expanded at a time, showing the page content within, while keeping the other sections collapsed, saving display space.

<table>
<thead>
<tr>
<th>Location information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Telephone</td>
</tr>
<tr>
<td>Street Address</td>
</tr>
<tr>
<td>Address Line 1: 500 Broadway</td>
</tr>
<tr>
<td>Address Line 2</td>
</tr>
<tr>
<td>City: Death Valley</td>
</tr>
<tr>
<td>State: CA</td>
</tr>
<tr>
<td>Country: USA</td>
</tr>
<tr>
<td>Postal Code: 94584</td>
</tr>
</tbody>
</table>

Working with Layout Group Boxes

The layout group box is used only for layout for positioning its child elements. When using layout group boxes, keep these items in mind:

- No default look and feel style is applied, such as no border.
- No header will be generated.
- The label set for the group box will be ignored at runtime, but can be used at design time for reference.

Creating Custom Header Group Boxes

Before creating any sort of custom header (also referred to as an “application header”), become familiar with the default system header page definition, PT_HEADERPAGE.

You can use the Custom Header Left/Middle/Right/Bottom group box types to reparent custom controls to the default header. You will notice that the default PT_HEADERPAGE header page definition contains a left box, middle box, right box and a bottom box. Each of these group boxes also contains a Custom group box; these correspond directly to the Custom Header group box types and are used to inject custom application controls into the header page sections. On your page definition, create Custom Header Left/Middle/Right/Bottom group box types as needed for your custom controls. At runtime, the content of the Custom Header group boxes will replace the content of the related Custom group box in the header page.

Note: During page rendering, the system identifies the first focusable field based on the organization of the page definition and places the cursor there unless overridden by SetCursorPos PeopleCode. When adding custom buttons to the header of a primary page or a secondary page (for example, when using any of the Custom Header group box types), place the group box with the custom buttons at the bottom of your page definition. This will prevent the custom button from being identified by the system as the first focusable field.
Alternatively, if you do not want to use the default system header page, you can create your own custom header page.

**Working with Related Field Group Boxes**

Use related field group boxes to group or associate a set of fields. The fields will be enclosed in `<fieldset>...`</fieldset>

The group header will be within `<legend>` instead `<h..>`.

The Collapsible Data Area option should not be used for related field group boxes.

**Working with Embedded Related Content**

You can display embedded related content on a fluid page using the Related Content group box type. Then, existing tile definitions can be configured as embedded related content on these fluid pages either as an anonymous service or as an explicitly defined related content service using the PeopleSoft Tile URL type.

**Image: Related Content group box type**

This example illustrates setting the Group Box Type value to Related Content, which then displays the Autosize check box.

The following procedure provides an example of adding embedded related content to your fluid page. You will complete the first task in Application Designer and then the final task using the Manage Related Content Service component in the browser.

**Adding a Related Content Group Box for Embedded Related Content**

To add a related content group box for embedded related content only:

1. Insert a group box on your fluid page in the general position you would like to display embedded related content.

2. Double-click the group box to open the Group Box Properties dialog box. Then, on the Fluid tab, set the Group Box Type to Related Content.

3. For interactive embedded related content, you can select the Autosize check box if you always want the content to be fully visible; for non-interactive embedded related content, leave this check box deselected.

4. (Optional) Apply styling, if needed, to this group box using styles. Recall that the system applies default styles, and you would only require additional styling to override or enhance the default styling. One of the options for styling is to override the default sizing. If no additional styling is specified, then the embedded related content consumes the default size, which depends on the container or page.
Enter styles in the fields in the Application-Specific Styles area. For example, to use less than the full width of the container or page, enter the percentage of the width. For example: psc_width-80pct.

5. Select the Label tab and enter a descriptive label to identify this related content group box as a drop zone. This label is not rendered at run time, but it will help at design time by:

- Differentiating this drop zone from any others on the page.
- Providing a label on the drop zone during fluid page preview.
- Providing a label for the drop zone during the related content configuration task.

**Image: Related Content group box with label**

This example illustrates a related content group box added to a fluid page with a customized label for identification as a drop zone.

6. Save your changes.

**Note:** When a related content group box is configured in this manner, it can be used for embedded related content only. To create a related content group box that can be used for either dynamic subpages or embedded related content, see Creating Configurable Drop Zones for Dynamic Subpages.

**Assigning Page-Level Embedded Related Content**

1. In the browser, select PeopleTools >Portal >Related Content Service >Manage Related Content Service.

2. Click the Assign Related Content to an Application Page link and select the content reference associated with the component for your fluid page.

3. On the Configure Related Content page, configure the embedded related content in the Page Level Related Content group box as described in "Assigning Related Content to Fluid Components and Pages" (PeopleTools 8.57: Portal Technology).

**Image: Assigning Page Level Related Content**

The following example illustrates configuration of embedded related content on a fluid page.
Testing Group Box Layout

Because group boxes are essential to the layout of the fluid page and all of its elements, being able to determine exactly the contents of a group box container is also essential. Select Layout Only on the Fluid tab of the Component Properties dialog box.

Image: Enabling Group Box Layout Testing

This example illustrates where you enable group box layout testing on the Component Properties dialog box, by selecting **Layout Only**.

![Component Attributes](image)

At run time, the system displays the fluid page in the browser using different colored boxes to depict the scope of each group box on the page, providing visual indication for you to verify the scope and contents of each group box container.
Image: Group Box Testing Display

This example illustrates the different colored boxes indicating the scope and coverage of each group box using the My Preferences page (PTGP_USER_PERS_FL).

---

**Working with Other Page Controls**

This section contains an overview and discusses aspects specific to fluid page development with regard to adding page controls.

In general, adding page controls to fluid pages is comparable to adding page controls to a classic page, except for using CSS styles to position the control and the obvious look and feel differences at runtime. The content in the this topic call out key differences with regard to fluid development. You should be well versed in development of classic PeopleSoft applications and all of the various page control options provided by Application Designer prior to beginning a fluid development or customization project.

---

**Working with Grids**

**Setting Grid Label Properties**

Fluid grids support these property settings:

- Row count ($n$ rows).
• Previous, Next, and View All.

Combined, these properties enable lazy scrolling on fluid grids; see Enabling Lazy Scrolling for Scrollable Grids for more information. However, unlike classic grids, no separate page controls are displayed for these features.

• Find.

• Download to Excel.

• Personalize.

This property enables the save sort feature in fluid via the Sort button on fluid grids allowing users to save sorts and remove saved sorts.

These features are not supported and are ignored (if enabled) on fluid grids:

• Top and Bottom (First and Last links).

• Row count ($x$–$y$ of $n$).

• Footer.

For more information on setting grid label properties, see "Setting Grid Label Properties" (PeopleTools 8.57: Application Designer Developer's Guide)

**Selecting Grid Layout**

Fluid grids support these layout options:

• Data Grid Layout.

• Div Grid Layout.

• Flex Grid Layout.

• List Grid Layout (Ordered).

• List Grid Layout (Unordered).

• Menu Grid Layout.

• Tab Set Grid Layout.

For more information on selecting a grid layout and setting other grid use properties, see "Setting Grid Use Properties" (PeopleTools 8.57: Application Designer Developer's Guide).

**Setting Fluid Properties for Grids**

When working with grids, the relevant, common fluid properties apply, but also you can set these properties:

**Scroll Sizing by Style**

Select to override the system default, automatic scroll container sizing. If you use this option, you must control the scroll container sizing through a custom style. If you select this option, be aware of these items:
• If the custom style does not control the scroll container size successfully, the scroll may not appear or work as desired.

• Your custom style must be able to handle window size and orientation change.

• If there is no overflow amount (data rows exceeding occurs limit) lazy scrolling may not be triggered.

**Custom Grid Header**
Select to specify a custom grid header.

**Include Labels in Grid Cells**
Select this option to generate field labels within grid cells when you’re using list grids, div grids, or flex grids with group boxes to group fields, or when you have a tab separator in your grid.

Typically, these are suppressed but because we have the ability to put group boxes within grids, the labels are appropriate to display what the individual fields are (depending on context).

---

**Note:** In some situations, such as when displaying a page on a smart phone, you may want grid scrolling disabled. Add the `psc_noscroll` style to Small in the Form Factor Style Class Override group box to disable scrolling for that grid on small form factor devices. Do not disable scrolling for lazy scroll grids.

---

**Other Unsupported Grid Features**
These grid features are not supported in addition to the grid label features that aren’t supported:

• Odd/even row styles.

• Persist in menu.

**Related Links**
"Working with Grids" (PeopleTools 8.57: Applications User's Guide)

---

**Enabling Lazy Scrolling for Scrollable Grids**
Lazy scrolling provides the ability for the PeopleSoft application to dynamically load grid content as the end user scrolls downward. Rather than loading all content up front, which would degrade performance, the fluid application loads the content as needed. The fluid application loads the next set of scrollable content automatically as the user reaches the end of the currently displayed content. The fluid application displays the total row count for the grid on the same line as the grid title.

To enable lazy scrolling:

1. On the Grid Properties > General tab, set the Occurs Count to the number rows to be sent to the browser when the grid appears initially.

   **Note:** Make sure Unlimited Occurs Count (rows) is not selected.

2. On the Label tab, in the Header Navigation Bar Properties for that grid, make sure the Invisible option is clear for these property tabs:
3. On the Use tab, in the Grid Style group box, select the Vertical check box.

**Working with Scroll Areas**

When working with scroll areas, the relevant, common fluid properties apply, but you can also set these properties:

- **Layout**
  - Default – Displays the rows of the scroll in the standard, default format.
  - List (Unordered) – Displays the rows of the scroll as a bulleted (unordered) list.
  - List (Ordered) – Displays the rows of the scroll as a numbered (ordered) list.
  - Menu – Use as a container for a pop-up menu.
  - Tab Set – Use to as a container for a set of sectional tabs embedded on a page.

See Creating Fluid Pop-up Menus.

- None: Disables the display of place holder text.
- Static: Select to enable the Static Text box, and enter the desired text.
- Message Catalog: Select to enable the Message Set/Number boxes. Enter the message set and message number of the message catalog entry that contains the place holder text.

**Working with Edit Boxes and Long Edit Boxes**

When working with edit boxes and long edit boxes, the relevant, common fluid properties apply, but also you can set these properties:

- **Place Holder Text**
  - Display default, place holder, text in the edit box. For example, add a default value or sample format of the field data to assist users.
  - None: Disables the display of place holder text.
  - Static: Select to enable the Static Text box, and enter the desired text.
  - Message Catalog: Select to enable the Message Set/Number boxes. Enter the message set and message number of the message catalog entry that contains the place holder text.

HTML example:
<input type="text" id="PS_APP_END_DATE"
class="ps-edit"
placeholder="Specify the date you expect to
finish the assignment."
value="" maxlength="10" ...>

### Input Properties

Select the expected data type for users to input. This sets the HTML input type parameter.

Setting input types for forms allow for better input control and validation for various data types, including:

- text
- date
- datetime
- email
- number
- range
- search
- time
- url

**Note:** The Input Properties setting does not apply to long edit boxes.

---

**Note:** In the current release, spell check is not optimized for fluid. It is not recommended to enable spell check at the component level or at the field level for fluid applications.

**Note:** While display-only rich text editor fields are supported in fluid applications, editable rich text editor fields are not. If you enable the rich text editor for long edit boxes on fluid pages, then you must also select two check boxes on the Use tab of the Long Edit Box Properties dialog box: Display Only and Expand Field When Display Only.

**Note:** The Show Label option is not supported for edit boxes on fluid pages.

**Note:** The character limit counter is not supported in fluid applications. If the Enable Long Edit Counter check box is selected for a long edit box on a fluid page, no information is displayed about characters remaining.

### Working with Number Fields

When you select *number* as the Input Type, the system uses an HTML 5 number input which renders in a fashion specific to the browser/device accessing the page. For example, on a touch device the system...
displays the numeric keyboard when the number field is in focus, and a browser may display a spinner (spin-button) for a number field.

**Note:** Browser rendering and HTML 5 rendering may change after the publication of this document.

When setting Input Type to number, consider that HTML 5 restricts the data that can be used as input or displayed for number fields to the following set of characters:

- 0 through 9.
- - for negative numbers.
- . for a decimal point.

Adding additional characters (such as a currency symbol, a thousand’s separator, and so on) or additional field formatting is not supported for a field with the Input Type set to `number`. For example, if you set Input Type to `number`, the numeric keyboard will be displayed by default for that field on touch devices, however you also introduce the HTML 5 number field character restrictions. In this case, any special characters or formatting applied in Edit Box Properties, field definition formatting, or PeopleCode (such as currency symbols, thousands separators, and so on) will not be displayed or accepted as input for that field.

On the other hand, if you want to allow additional formatting or characters for numerical values, then set the Input Type to `text`, keeping in mind that with the Input Type set to `text` you lose the device/browser-specific representation (such as the numeric keyboard for example).

A general recommendation would be that you should only set a field's Input Type to number if the underlying field definition Field Type is set to `Number` in Application Designer, or if the Field Type is set to `Character`, you have also set the Format Type to `Numbers Only`.

**Working with Subpages**

Using subpages can help to reduce clutter in the layout page, and it clearly separates related fields into separate entities. In addition, it enables you to logically separate business logic.

When using subpages, you will notice that the footprint is small in terms of the space it consumes in the layout. The width of the subpage displayed on the primary page is based on the width of the label when you insert into the page (fluid page).

Subpages must be enclosed in a group box of the type layout.

There can be multiple levels of subpages.

**Working with HTML Areas**

In general, HTML areas should be used sparingly, if at all, with fluid applications. If used, keep these guidelines in mind:

- Select the HTML Tags Only option on the HTML tab of the HTML Area Properties dialog box for performance reasons. This limits the processing and parsing tasks that the system needs to perform, especially in the case of large grids containing numerous input fields.

- Do not reference external JavaScript or external style sheets in the HTML area.
**Working with Check Boxes**

With check boxes on a fluid page, there are differences based on the Control Structure settings on the Check Box Properties > Fluid tab.

The default (Advanced) shows the actual translate values (On/Off, Active/Inactive, whatever they happen to be). With Basic selected, the system shows just a check box, similar to classic rendering.

Label positioning can be important with these options, as you typically want labels to appear after a standard check box but before the control with the Advanced option selected.

**Image: Advanced and Basic Check Box Rendering**

This example illustrates the differences in rendering and label placement of the Advanced and Basic Control Structure settings for check boxes. The Advanced selection shows the toggle switch, while the Basic selection displays a more standard check box.

---

**Working with Push Buttons and Hyperlinks**

In addition to the existing push buttons used in classic applications, these push buttons are available for use with fluid user interface pages.

- Home
- Sign Out
- NavBar
- Add To
- Search

You can create toolbars containing push buttons that appear in custom locations, such as sidebars for example, using your own actions, if needed. Push buttons are not required to appear only in the toolbar at the top of the page. Options that can be found on the Use tab that may also be of interest for fluid pages include:

- Execute PC on Row\Group click: Runs PeopleCode as soon as user clicks on row\group).
- Execute SearchSave Event: When a user runs a search, the system saves the page data prior to running the search so it is not lost. This option applies only to the search button, not every button on the page.

**Note:** For a button to display an image and text (a combination button), on the Label tab, select Both for the Label Type, then specify the Alt tag for image and Label Image.

**Note:** The Open in New Window and Replace Current Window options on the Push Button/Hyperlink Properties dialog box Use tab are not supported for fluid pages. To open a page in a new window for a fluid page, use PeopleCode, such as ViewURL or ViewContentURL.
Working with Static Images and Static Text

Static controls can be used for fluid pages. They have a different structure than what you see on classic pages, and you can apply style classes to these page elements (to the outer wrapper as with all other controls).

Image: Static Text

This example illustrates the static text control represented in the generated HTML for a fluid page.

```
<div class="ps_box-text" id="win0div$ICField3">
  <span class="ps-text">This is Static Text</span>
</div>
```

Image: Static Image

This example illustrates the static image control represented in the generated HTML for a fluid page.

Working with Horizontal Rules

The horizontal rule control can be used and you can apply a style on the Horizontal Rule Properties > Fluid tab to be applied to the horizontal rule. Styles are applied at the ps_box-hr level (as with all controls, styles applied in IDE are found in the outer wrapper of the control).

Working with Charts

When inserting charts onto a fluid page, note that there is no Fluid tab on the Chart Properties dialog box. The properties applied to a chart on a fluid page are applied using the Fluid tab of the chart container (the group box surrounding the chart.)

For more information, see "Fluid Mode Considerations for Charts and Gauges" (PeopleTools 8.57: PeopleCode API Reference).

Creating Fluid Pop-up Menus

You can create a pop-up menu on a fluid page with menu items performing any action or navigation. Fluid pop-up menus can contain only a single level of menu items. Using the page controls and techniques described in this section will create pop-up menus that are rendered, styled, and tagged to standards that work with assistive technology.
Image: Example of a fluid pop-up menu

The following example illustrates a fluid pop-up menu:

A fluid pop-up menu is not a separate, distinct page control found in Application Designer. Instead, you can use several methodologies to create fluid pop-up menus, including a parent group box (described here), a hyperlink or button, and others. The procedure described here relies on a parent group box of type Popup to serve as the button to activate the pop-up menu. This procedure requires no further coding by you to create a control and menu that is generated to standards that work with assistive technology. In addition to the parent Popup group box, you can use one of three methods to create the pop-up menu:

- A group box of type Menu. Each menu item is a hyperlink contained within a group box of type Menu Item.
- A grid with a layout of Menu Grid Layout. Each row in the grid is a menu item.
- A scroll area with a layout of Menu. Each row in the scroll is a menu item.

To create a fluid pop-up menu:

1. Create a parent group box of type Popup to serve as the button to activate the pop-up menu:
   - On the Label tab, specify a text label for this button.
   - On the Use tab, specify an image for this button if applicable.
   - On the Fluid tab: Specify any additional styles for this button—for example, psc_image_only.
   - On the Fluid tab: Oracle recommends that you enable a vertical scroll bar for this menu; whether a vertical scroll bar is displayed depends on how the page is displayed (in a modal window, for example) and form factor usage (smart phone, for example).
   - Using the SetGroupletMOptions PeopleCode built-in function, set modal popup options enabling bPopupMenu on the record field. For example:

```
MY_RECORD.POPUP_MENU_GBX.SetGroupletMOptions("bPopupMenu@1;");
```

**Note:** When bPopupMenu is enabled (set to 1), the system will automatically set bHeader to 0 (disabled), bAutoClose to 1 (enabled), bMask to 1 (enabled), and sMaskStyle to ps_masktrans; these options cannot be overridden. In addition, bVertical will be set to 1 (which is recommended), but it can be overridden.
2. Within the popup group box, create the menu container using one of three options:
   - To create a static menu, use a group box of type Menu.
   - To create a dynamic menu, use a grid with a layout of Menu Grid Layout.
   - Alternatively, use a scroll area with a layout of Menu to create a dynamic menu.

3. Define menu items within the menu container depending on the option selected in step 2:
   - If the menu container is a group box, create a group box of type Menu Item for each static menu item. Within each menu item group box, insert a single control, a hyperlink that executes the PeopleCode for this menu item. If you require a complex grouping of controls, use a grid or scroll as the menu container.
   - If the menu container is a grid or a scroll area, you can create a simple grid or scroll with one column: a hyperlink that executes the PeopleCode for this menu item.
   - Alternatively, if the menu container is a grid or a scroll area, you can also create a grouping of columns to be acted upon as a single menu item: a layout group box as the first column in the grid (in a scroll, this layout group box contains the other columns), one hyperlink that executes the PeopleCode for this menu item, and any additional controls such as images or counters (badges) to adorn the menu item.

Creating Sectional Tabs on a Page

You can create sectional tabs embedded on a fluid page to control which portions of the page data are displayed depending on the tab selected. Using the page controls and techniques described in this section will create sectional tabs that are rendered, styled, and tagged to standards that work with assistive technology.

**Image: Example of sectional tabs**

The following example illustrates sectional tabs:

<table>
<thead>
<tr>
<th>Tab 1</th>
<th>Tab 2</th>
<th>Tab 3</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>DateTime Created</td>
<td></td>
<td></td>
</tr>
<tr>
<td>*Description</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Sectional tabs are not a separate, distinct page control found in Application Designer. Instead, you can use one of three methods to create sectional tabs:

- A group box of type TabSet. Each tab item is a hyperlink contained within a group box of type TabItem.
- A grid with a layout of Tab Set Grid Layout. Each row in the grid is a tab item.
- A scroll area with a layout of Tab Set. Each row in the scroll is a tab item.

To create sectional tabs:
1. Create the tab set container using one of three options:
   - To create a static set of tabs, use a group box of type TabSet.
   - To create a dynamic set of tabs, use a grid with a layout of Tab Set Grid Layout.
   - Alternatively, use a scroll area with a layout of Tab Set to create a dynamic set of tabs.

2. Define tabs within the tab set container depending on the option selected in step 1:
   - If the tab set container is a group box, create a group box of type TabItem for each static tab. Within each tab item group box, insert a single control, a hyperlink that executes the PeopleCode for this tab. If you require a complex grouping of controls, use a grid or scroll as the tab set container.
   - If the tab set container is a grid or a scroll area, you can create a simple grid or scroll with one column: a hyperlink that executes the PeopleCode for this tab.
   - Alternatively, if the tab set container is a grid or a scroll area, you can also create a grouping of columns to be acted upon as a single tab: a layout group box as the first column in the grid (in a scroll, this layout group box contains the other columns), one hyperlink that executes the PeopleCode for this tab, and any additional controls such as images or counters (badges) to adorn the tab.

Page Controls Not Supported in Fluid Applications

The following page controls are not supported in fluid applications:

- Frames – Use a group box of type Layout instead.
- Pop-up menus – The use of the classic pop-up menu page control can produce unpredictable results with other aspects of fluid applications. Pop-up menus on fluid pages are created in a different manner.

  See Creating Fluid Pop-up Menus.
- Scroll bars.
- Trees.

Applying Styles

Understanding Fluid Styling

The layout of all page elements in a fluid application is controlled by free from style sheets using CSS 3.0 standards. This is one of the most critical differences to consider when comparing classic applications to fluid applications. With each control that you add to a page, PeopleTools automatically applies a style class to that control structure, and that style class enables that control to behave and render successfully on a fluid page.
In some cases, a single style class creates a change in behavior, color, or look and feel of a page element. In other cases, depending on the control, a structure of multiple style classes are applied to create the behavior and look and feel of a control. It is critical that before you attempt to override any delivered default styles that you observe the structure of the control in the HTML source of the rendered page so that you can gain insight into the elements involved in the control’s structure and the styles that are currently being applied, not to mention the order in which they are applied.

When the system applies a style, by default or override, the style is applied to the container in which the control resides, and those styles apply to all elements in that container, which includes the structure of the control, the label, the field, and so on. In a fluid application, you do not apply a style to discreet elements, such as just to the label for instance.

### Identifying PeopleTools Style Sheets

PeopleTools provides a main style sheet for fluid pages and controls, while also supplying additional style sheets for various fluid features, such as the NavBar.

<table>
<thead>
<tr>
<th>Style Sheet</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PSSTYLEDEF_FMODE</td>
<td>General style sheet for fluid applications (included on every page), containing the majority of fluid style classes.</td>
</tr>
<tr>
<td>PTNUI_NAVBAR_CSS</td>
<td>Contains the styling used for the Navigation Bar (NavBar).</td>
</tr>
<tr>
<td>PTPN_NOTIFYWIN_CSS</td>
<td>Notification/Alerts styling. Included on every page where notifications are enabled.</td>
</tr>
<tr>
<td>PTNUI_PINTO_CSS</td>
<td>Controls the styling for the “Add to…” functionality. Included on pages with the Add to feature enabled.</td>
</tr>
<tr>
<td>PTS_NUI_FFSTYLE</td>
<td>Used by both global search and component search features.</td>
</tr>
<tr>
<td>PTPG_MENUSTYLE</td>
<td>Used by pivot grid search features.</td>
</tr>
<tr>
<td>PTPG_NUI_GRID_CSS</td>
<td>Used by pivot grid display.</td>
</tr>
</tbody>
</table>

### Overriding Delivered Style Classes

The system default style sheet is PSSTYLEDEF_FMODE, which contains all the default, delivered styles for all page elements and controls.

You can create custom free form style sheets in Application Designer, and you can choose to include them and override or extend the default styles at varying levels for page elements.

The system-wide style sheet can be overridden by way of the PeopleTools options page, by selecting the custom style sheet and assigning it to the Default StyleSheet Name option. This is a global, system-wide setting. If set, the system completely ignores any style contained in the delivered style sheet, PSSTYLEDEF_FMODE. Otherwise, if not set, the system applies PSSTYLEDEF_FMODE by default.

**Note:** Overriding the delivered system-wide style sheet is *not* recommended.
**Note:** Use PeopleTools, Portal, Branding, Branding System Options to set fluid branding options in the Fluid Component group box.

To incorporate additional style sheets at either the component or page level, use the AddStyleSheet built-in PeopleCode function:

```plaintext
AddStyleSheet(StyleSheet.STYLESHEET_NAME);
```

The AddStyleSheet function adds the reference to the style sheet to the header section of the HTML page.

**Image: Style sheets in HTML head section**

This example illustrates style sheets added into the HTML `<head>` section.

```html
<!--<head> --><meta charset="UTF-8">
<meta http-equiv="Content-Type" content="text/html; charset=UTF-8">
<meta name="viewport" content="user-scalable=yes,initial-scale=1.0,minimum-scale=1.0,width=device-width">
</head> --><link rel="stylesheet" type="text/css" href="css/ps/cache/PSTYLEDEF_FHODE_2036.css">
<link rel="stylesheet" type="text/css" href="css/ps/cache/HR ALERTS_FL_2017.css">
<link rel="stylesheet" type="text/css" href="css/ps/cache/PTNU1_PINTO_CSS_2027.css">
<link rel="stylesheet" type="text/css" href="css/ps/cache/PTNU1_NAVBAR_CSS_1479.css">
```

In Application Designer, you can also elect to override or extend the default styles, using the Fluid tab for any page or control use the Free Form Style group box to call out styles to be modified. To completely ignore the default style, select Override PeopleTools Style, otherwise you extend or add to the default style. For situations where you have adjustments to make depending on the form factor of the device, you can set those in the Form Factor Override fields for the various form factors.

When working with the order in which style sheets are applied, consider:

- When you call AddStyleSheet, the system checks if there is a theme with a mapped, skinned style sheet for that style sheet. If so, the system loads that style sheet after the style sheet passed in the argument.
- The order in which you call AddStyleSheet determines the order in which the style sheets appear in the stylesheet list.
- The system determines the order in which the PeopleTools style sheets are applied.
- Regardless of custom changes you may make, standard CSS rules *always* apply. It is very important for the developers to understand how CSS and style sheets work.
Image: Form Factor Override

This example illustrates an approach to adjusting the layout of controls based on the form factor of the device accessing the fluid page.

```
<table>
<thead>
<tr>
<th>Application-Specific Styles</th>
</tr>
</thead>
<tbody>
<tr>
<td>Style Classes</td>
</tr>
<tr>
<td>Form Factor Style Class Override</td>
</tr>
<tr>
<td>Small</td>
</tr>
<tr>
<td>Medium</td>
</tr>
<tr>
<td>Large</td>
</tr>
<tr>
<td>Extra Large</td>
</tr>
</tbody>
</table>
```

For details on the override options, see Setting Properties on the Fluid Tab.

Free form styles set in Application Designer are static and can’t be changed, however, styles set using PeopleCode are dynamic, meaning they can be switched programatically at runtime. Styles set in Application Designer can’t be changed or queried using PeopleCode at runtime. Dynamic styles are applied only with PeopleCode; they can be added, changed, deleted or queried at runtime.

It is not recommended to add style to the system containers. Add your own group boxes, and add style to that.

Example:

```
&fld1.AddFFClass("addffclass");
&fld1.ReplaceFFClass("addffclass", "replaceffclass");
&fld1.FreeFormStyleName = "pc_ffclass";
```

In your implementation, Oracle strongly recommends that you only override style classes with respect to coloring, theme, and branding; a practice often referred to as “skinning.” Oracle strongly discourages overriding delivered style classes with regard to page layout (positioning, padding, filling, and so on).

You only skin complete style sheets, not the sub style sheets contained within a style sheet. To extend (or skin) a delivered style sheet, you want the delivered style sheet to appear first in the style sheet list, followed by the override or “skinned” style sheet. For example, PSSTYLEDEF_FMODE should appear before PSSTYLEDEF_FMODE_skinned, allowing the original to be applied, and the “skin,” containing the supplemental changes, to be applied after.

**Note:** With CSS style sheet application, the last style sheet in the sequence to be applied takes precedence.

It is recommended to skin or extend only one style sheet at a time. As in, if you have multiple style sheets, have the skinned style sheet appear just after (under) the style sheet it extends or overrides. If the extended or override style sheet appears beneath other style sheets in the list (assuming there are multiple style sheets), any override in the skinned style sheet will apply to any style sheet specified before it, which may result with unintended style overrides.
If you intend on extending or overriding the delivered styles, consider these items:

- You need to be aware of all the styles applied in any previously applied style sheet(s).
- If overriding styles, it is recommended to change only color characteristics.
- It is not recommended to override any styles related to structural (layout or positioning) characteristics or behaviors applied to page elements.
- Do not modify a delivered style sheet. Any changes will be overridden in any future upgrade.
- Styles are associated directly to structure (container, label, control, and so on), and any change PeopleSoft makes to structure in future releases can affect any custom styles you’ve implemented.

**Setting Min/Max Width on Content**

Not all content displays as desired when stretched to a maximum size of a device or reduced (shrunk) too much to fit a smaller space, or device. There are functional minimum and maximums, which should be defined on the content so that scrolling occurs or the size of the area no longer grows in terms of min/max values for width. When creating custom fluid pages, or customizing delivered pages, it is your responsibility to manage the styling for these min/max values.

It is recommended that you do not set the min/max values directly on the group box with the style `ps_apps_content`, as this can cause browser issues.

The `ps_apps_content` style implements the flex model. Pages are laid out as a column based on flex model with horizontal stretching. This can cause varying results per browser type when attempting to stretch the width fully while restricting the width based on a max-width value.

It is recommended to include a layout group box within the `ps_apps_content` group box containing your page content, and apply the max/min widths on the interior group box.

<table>
<thead>
<tr>
<th>Layout Element</th>
<th>Example</th>
</tr>
</thead>
</table>
| Structure and Style Class | GROUPBOX - class=ps_apps_content  
GROUPBOX - class=psa_my_content  
&page content goes here |
| Style                  | .psa_my_content {  
min-width:320px;  
max-width: 1440px;  
margin:0 auto;  
/* center content horizontally */  } |

**Hiding Columns in a Flex Grid Using Style**

You can style an entire column in a flex grid by using the page field name of the field (or group box) within a grid. The page field name will be applied directly to the column (both the table header [TH tag] and the cells [TD tag]) as a style. At that point, you can affect styling an entire column (centering, font weight, and so on).

You can hide an entire column stylistically, using the page field name (as opposed to hiding the column using PeopleCode, which can prohibit complete rendering of the column).
If you are hiding a column using style, you must consider the following items.

<table>
<thead>
<tr>
<th>Consideration</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Accessibility</td>
<td>If you stylistically hide the trigger column used for the row action, you must make sure that you un-hide the trigger column in screen reader mode.</td>
</tr>
<tr>
<td></td>
<td>This is because in screen reader mode, the row action is disabled and the column used as the trigger field now becomes actionable and can receive focus. In screen reader mode, the row action trigger should have the following characteristics:</td>
</tr>
<tr>
<td></td>
<td>• It must be visible.</td>
</tr>
<tr>
<td></td>
<td>• It must have text (alt text or image) that explains the action.</td>
</tr>
<tr>
<td></td>
<td>For example, if you have a field on a grid that has a page field name of “ABC_XYZ”, the style applied on all references to that column is “ABC_XYZ” (TD and TH tags in the table). To properly hide the entire column, use the following:</td>
</tr>
<tr>
<td></td>
<td>:root:not(.psc_mode-access) .ABC_XYZ { display:none; }</td>
</tr>
<tr>
<td>Grid Header Alignment</td>
<td>If you stylistically hide a column, do not stylistically hide the last column in a grid. Doing so can adversely affect grid header layout.</td>
</tr>
<tr>
<td></td>
<td>PeopleTools uses the last column of the grid to adjust the grid header if it needs to have an overhang for the scroll bar, enabling the grid scroll bar to appear as part of the grid. If you hide the last column, the overhang is assigned to the last column and if it is hidden, the overhang can be lost, resulting in a misaligned grid header.</td>
</tr>
</tbody>
</table>

**Working with Flex Grid Column Alignment**

A flex grid consists of two table structures that support both the fixed grid header and a scrollable grid body. The column styes are applied to both table constructs that make up this page element. However, these styles can have adverse effects on the grid header, causing alignment issues if you attempt to adjust column dimensions.

If you are attempting to set any dimensions on columns, make sure you are familiar with the limitations of using min/max values on grid columns.

If you attempt to set a dimension of any type (width, min-width, max-width, and so on), make sure you affect only the real table and not the header-only table, which the system uses for header alignment.

For example, assume a column named XYZ_ABC as a page field name in the grid. That class is assigned to all “TD” and “TH” tags both in the real table (ps_grid-flex) as well as the table used internally for fixed header implementation (ps_grid-flex-head). To style a dimension and change the text color, see the following:

```css
.ps_grid-flex .XYZ_ABC { min-width:10em; } /* set dimension only on real table */
.XYZ_ABC {color: #A00;} /* set color both real and header-only table */
```
Working with JavaScript

This topic discusses information related to using JavaScript with fluid applications.

Delivered JavaScript

PeopleTools includes an HTML definition, PT_PAGESCRIPT_FMODE, which serves as the master list referencing other definitions containing the actual JavaScript function definitions. These JavaScript functions control a wide range of page behavior, including (but not limited to):

- Scrolling for group boxes.
- Accordion widget.
- Toggle widget.
- Grouplet.
- Drag and drop group boxes.
- Grid lazy scroll.
- Carousel – (used only for scroll areas).
- Transfer animations.
- File attachments.
- Search page and NavBar.
- Related action menu.
- Side page tabs.
- New action buttons – Back, Home, Logout
- Search side page.

Use the AddOnLoadScript PeopleCode built-in function to invoke delivered JavaScript functions. The following example illustrates two invocations of AddOnLoadScript:

```java
If (IsGroupletRequest()) Then;
  AddOnLoadScript("DoRowAction(" | &nRow | ");");
End-If;

AddOnLoadScript("SetSideTopTitle('" | EscapeHTML("My M/D Component's Title") | ");
```

Related Links

"AddOnLoadScript " (PeopleTools 8.57: PeopleCode Language Reference)
Custom JavaScript Guidelines

Incorporating custom JavaScript programs is supported, but application developers and implementation teams should use custom JavaScript programs judiciously, and they should be well aware of any implications introduced by the custom code.

With the architecture of the PeopleSoft Fluid User Interface, PeopleTools provides increased flexibility and opportunity to customize. However, with that flexibility comes increased responsibility for developers to test and manage any custom code. PeopleTools can only impose logical restrictions and processing constraints on the code it delivers and tests.

When considering adding custom JavaScript programs, consider the following items:

- Include JavaScript files in component PeopleCode, such as PostBuild, for better performance. Otherwise, the system needs to perform extra processing, such as inserting references into the header and checking to make sure all of the styles have been downloaded and applied, and before completing the page load/activate process.
- Avoid using custom JavaScript events on a control.
- If there are any JavaScript errors from application onload, the page will also encounter problems loading.
- Do not use JavaScript to change the structure of the document.
- Don’t use JavaScript to add/change the free form styles on the controls. Use PeopleCode to change/add free form style.
- Only add JavaScript events on the controls that do not have any system generated script.

Considering Accessibility for Fluid Pages

When building any application, developers need to consider accessibility requirements always. This topic describes some key concepts to keep in mind with regard to accessibility while developing fluid pages.

For more information on accessibility for PeopleSoft applications in general, see "Accessibility in PeopleSoft Applications" (PeopleTools 8.57: Accessibility Guide).

<table>
<thead>
<tr>
<th>Accessibility Consideration</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ARIA live regions</td>
<td>Use Accessible Rich Internet Applications (ARIA) live regions sparingly.</td>
</tr>
<tr>
<td>Background and foreground colors</td>
<td>If you specify a foreground color, it is strongly recommended that you also specify a background color and vice versa. Otherwise, users changing their system colors may produce invisible text. Also, be cautious when using any of the following CSS techniques:</td>
</tr>
<tr>
<td></td>
<td>• Background images</td>
</tr>
<tr>
<td></td>
<td>• Gradients</td>
</tr>
<tr>
<td></td>
<td>• RGBA (transparent or semi-transparent) colors</td>
</tr>
<tr>
<td></td>
<td>These all make it difficult to test for color contrast, if not applied appropriately.</td>
</tr>
<tr>
<td><strong>Accessibility Consideration</strong></td>
<td><strong>Description</strong></td>
</tr>
<tr>
<td>---------------------------------------------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Background images</td>
<td>Do not use background images for informational icons. They are not visible in high contrast mode. Only do this for decorative images.</td>
</tr>
<tr>
<td>Button or hyperlink row actions</td>
<td>If you have a button or hyperlink and the control is used for a row action, you must supply a translatable label for the item regardless of whether it's visible or hidden. This label is needed for screen reader users.</td>
</tr>
<tr>
<td>Consistency with images and control labels</td>
<td>Use images and controls consistently throughout your application. For example, do not include a button labeled &quot;Search&quot; on one page and a button labeled &quot;Find&quot; on another page of the same application.</td>
</tr>
<tr>
<td>Creating custom controls</td>
<td>If you create a custom control using HTML Area, which is discouraged, the &quot;Name, Role, Value&quot; rule has to be in place. For example:</td>
</tr>
<tr>
<td></td>
<td>• Custom controls need a meaningful programmatically exposed name.</td>
</tr>
<tr>
<td></td>
<td>• Custom controls have appropriate roles specified using the role attribute.</td>
</tr>
<tr>
<td></td>
<td>• Custom controls have an appropriate value or state and property information conveyed using the relevant WAI-ARIA (Web Accessibility Initiative – Accessible Rich Internet Applications) or HTML 5 attributes.</td>
</tr>
<tr>
<td>Drag-and-drop</td>
<td>If you are leveraging drag-and-drop capabilities on your page, you must provide an accessible mechanism that non-sighted users can use. A similar mechanism must be available. For example, with homepage personalization, users can drag-and-drop tiles into their own specific layout and order. For non-sighted users, who cannot use drag-and-drop, a Personalize Homepage interface is available where users can also use the keyboard to arrange pagelets.</td>
</tr>
<tr>
<td>Dynamic information</td>
<td>User should be able to stop, pause, hide information that is moving, blinking, or auto-updated if:</td>
</tr>
<tr>
<td></td>
<td>• Starts automatically.</td>
</tr>
<tr>
<td></td>
<td>• Lasts more than five seconds.</td>
</tr>
<tr>
<td>Focus indicator</td>
<td>An end user must be able to see when focus is set for a control, for example a box surrounding the widget:</td>
</tr>
<tr>
<td></td>
<td>• If the widget is in HTML area, provide your own focus indicator.</td>
</tr>
<tr>
<td></td>
<td>• If you style a delivered widget in a unique way so it no longer looks like others of its kind, you also need to make sure to style a clear focus indicator.</td>
</tr>
<tr>
<td>Group box pop-up menus</td>
<td>Use only the techniques described in Creating Fluid Pop-up Menus to create pop-up menus on fluid pages.</td>
</tr>
<tr>
<td>Hidden fields</td>
<td>When a fields is not visible (for example, within closed accordion content or within group box that is itself set as invisible), the field should not be tab-able. It also must not be set to have focus.</td>
</tr>
</tbody>
</table>
## Accessibility Consideration | Description
---|---
### HTML areas
The controls in an HTML area must be able to be operated using the keyboard only, with no reliance on the mouse.

Use `tabindex="0"` for controls that are not accessible using TAB, but should be (those that can receive user input).

### Links versus buttons
Use links for transferring users to a different location; use buttons for actions on the current page.

### List items
List items must have one interactive field only, which becomes the target of the row action for the list item. In addition, limit the number of display-only fields (attributes) to three or less per list item. Because each list item is treated as a single cell, all of the fields are read by the screen reader for each list item when it is selected. More than four fields presents too much information for the reader to retain and act on. If you must present more than four fields, create a grid instead of a list. That way, each grid cell can be read individually.

### Lists
If you have a list, use list grid layout to render it, because it is a list, not a table, you are presenting. In addition, when you have only one column, it is not a table, it is a list.

If you want to show how many items are in the list, do not use the word "rows" for the counter. *Row* implies tables, which is confusing for screen reader users.

### Plug-ins
If you use plug-ins, verify that content rendered with those plug-ins is accessible.

### Read-only group box content
For group boxes that contain read-only elements and have a row action, it is recommended to add an aria-label and set the role using PeopleCode:

```人民
&Fld.JavaScriptEvents = "aria-label=""Partial Days⇒None"" role=""button""";
```

### Row headers
Fluid pages should specify a row header for tables, specified in Application Designer. Use the Row Header property on the Grid Properties > Use tab.

### Screen reader mode
- If your fluid component and classic component are exactly the same in functionality, you might want to display the classic component when a user is in fluid screen reader mode for desktop and tablet users; classic pages do not display well on smart phones. This can eliminate the need to design fluid pages for regular and screen reader mode.

- For selected list items, add the following ARIA attribute:

  ```人民
  aria-current="true"
  ```

- If you use styles to hide a column, ensure that you don’t hide the column in screen reader mode. If you always hide it, there will be no action available on the row. For example, the use of none in the following example is incorrect:

  ```人民
  :root:not(.psc_mode-access) .GRID1_EDIT,
  :root:not(.psc_mode-access) .GRID1_EDIT {
    display:none !important
  }
  ```
<table>
<thead>
<tr>
<th><strong>Accessibility Consideration</strong></th>
<th><strong>Description</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Sensory descriptors</td>
<td>Avoid instructions with sensory characteristics or descriptions of page elements, such as:</td>
</tr>
<tr>
<td></td>
<td>• Color (red, blue, and so on).</td>
</tr>
<tr>
<td></td>
<td>• Visual location (above, below, and so on)</td>
</tr>
<tr>
<td></td>
<td>• Orientation (right, left)</td>
</tr>
<tr>
<td></td>
<td>• Size and shape (small, larger, round, arrow, and so on).</td>
</tr>
<tr>
<td></td>
<td>Use field identification instead to point users to page elements.</td>
</tr>
<tr>
<td>Table summaries</td>
<td>Provide table summaries for table. Use Application Designer to populate them. Use the Summary attribute for Accessibility property on the Grid Properties &gt; Use tab.</td>
</tr>
<tr>
<td>Tab order and field focus</td>
<td>With fluid pages, the tab order cannot be set by the application developer, unlike classic pages. The tab order is based strictly on a top-to-bottom, left-to-right sequence. For fluid pages, design in such a way that the logical tab order is maintained as much as possible, leveraging group boxes to gather page elements together as necessary. Pay attention to field focus by tabbing to make sure the tab order is in a logical sequence. Pay close attention to these situations:</td>
</tr>
<tr>
<td></td>
<td>• Default focus location for initial page display. By default, the focus will be set to the first interactive field found on the page. However, if this field is not visible because it is within an invisible element (for example, a group box that is set to invisible) or within collapsed accordion content, then focus will be lost.</td>
</tr>
<tr>
<td></td>
<td>• Focus location after refreshing part of a page.</td>
</tr>
<tr>
<td></td>
<td>• Focus location before and after pop-up windows are displayed.</td>
</tr>
<tr>
<td>Testing</td>
<td>Perform the following additional testing:</td>
</tr>
<tr>
<td></td>
<td>• Test your application in Windows high contrast mode.</td>
</tr>
<tr>
<td></td>
<td>• If you build your fluid application for tablets or phones, test using a native screen reader. For example, use VoiceOver (OSX native screen reader).</td>
</tr>
<tr>
<td>Toggle buttons</td>
<td>If you have a toggle button with different visual styles for on and off, you should do one of the following:</td>
</tr>
<tr>
<td></td>
<td>• Change the label of the button when on versus off.</td>
</tr>
<tr>
<td></td>
<td>• Code WAI-ARIA states aria-pressed=&quot;true/false&quot;.</td>
</tr>
</tbody>
</table>
Chapter 6

Working with PeopleCode for the Fluid User Interface

Working with Fluid Page and Component PeopleCode

This topic discusses PeopleCode constructs and usage specific to working with fluid pages and fluid components.

Execution Order for Page Activate Events

The PeopleCode page Activate events for fluid pages execute in the following:

1. Header page (PT_HEADERPAGE is the PeopleTools-delivered fluid header page).
2. Side pages (Side 1 page and Side 2 page).
3. Footer page.
4. Main page (Standard Page page type).

Note: The Activate event is not supported for subpages, fluid or classic.

Related Links
Selecting Fluid Page Types

Built-In Functions

This table lists the PeopleCode built-in functions provided for use with fluid applications at the component or page level.

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;AddJavaScript&quot; (PeopleTools 8.57: PeopleCode Language Reference)</td>
<td>Add JavaScript to the document or page.</td>
</tr>
<tr>
<td>&quot;AddMetaTag&quot; (PeopleTools 8.57: PeopleCode Language Reference)</td>
<td>Add a meta-tag to the document or page.</td>
</tr>
<tr>
<td>&quot;AddOnLoadScript &quot; (PeopleTools 8.57: PeopleCode Language Reference)</td>
<td>Add the script to execute in the onload event of the document.</td>
</tr>
<tr>
<td>Function</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------</td>
<td>------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>&quot;AddStyleSheet&quot;</td>
<td>Add a free form style sheet to the HTML document for the page or component.</td>
</tr>
<tr>
<td>&quot;CreateSearchRowset&quot;</td>
<td>Create the rowset based of the search record and key list values.</td>
</tr>
<tr>
<td>&quot;DoModalComponentPopup&quot;</td>
<td>Display a secondary fluid component in a modal, secondary window with a child relationship to the parent window. See Transfer and Modal Functions for a complete list of functions available for implementing transfers and creating modal windows.</td>
</tr>
<tr>
<td>&quot;DoModalPopup&quot;</td>
<td>Display a secondary fluid page in a modal, secondary window with a child relationship to the parent window. See Transfer and Modal Functions for a complete list of functions available for implementing transfers and creating modal windows.</td>
</tr>
<tr>
<td>&quot;ExecuteSearchSavePC&quot;</td>
<td>Execute the SearchSave PeopleCode on the search page.</td>
</tr>
<tr>
<td>&quot;GetAddSearchRecName&quot;</td>
<td>Return the add search/prompt record name.</td>
</tr>
<tr>
<td>&quot;GetComponentTitle&quot;</td>
<td>Return the name of the component (from the component definition).</td>
</tr>
<tr>
<td>&quot;GetPagePrefix&quot;</td>
<td>Return the prefix for the page based on the page type as set on the Use tab.</td>
</tr>
<tr>
<td>&quot;GetPageTitle&quot;</td>
<td>Return the title of the page.</td>
</tr>
<tr>
<td>&quot;GetPageType&quot;</td>
<td>Return the page type—for example, header, footer, prompt, and so on.</td>
</tr>
<tr>
<td>&quot;GetPanelControlStyle&quot;</td>
<td>Return the styles set by the system that control the state of the left and right panels.</td>
</tr>
<tr>
<td>&quot;GetSearchRecName&quot;</td>
<td>Return the search/prompt record name.</td>
</tr>
<tr>
<td>&quot;GroupletRequestSource&quot;</td>
<td>Return an Integer value indicating the source page (location) for the grouplet.</td>
</tr>
<tr>
<td>Function</td>
<td>Description</td>
</tr>
<tr>
<td>----------</td>
<td>-------------</td>
</tr>
<tr>
<td>&quot;IsAddEnabled&quot; (PeopleTools 8.57: PeopleCode Language Reference)</td>
<td>Return a boolean value indicating whether Add mode has been enabled on the component's Use tab.</td>
</tr>
<tr>
<td>&quot;IsAddMode&quot; (PeopleTools 8.57: PeopleCode Language Reference)</td>
<td>Return a boolean value indicating whether the component build process is in add mode.</td>
</tr>
<tr>
<td>&quot;IsAGComponent&quot; (PeopleTools 8.57: PeopleCode Language Reference)</td>
<td>Return a boolean value indicating whether the component type is set to Activity Guide on the Fluid tab.</td>
</tr>
<tr>
<td>&quot;IsAGRequest&quot; (PeopleTools 8.57: PeopleCode Language Reference)</td>
<td>Return a boolean value indicating whether the request was initiated by an activity guide wrapper.</td>
</tr>
<tr>
<td>&quot;IsBackEnabled&quot; (PeopleTools 8.57: PeopleCode Language Reference)</td>
<td>Return a boolean value indicating whether back navigation is enabled on the component.</td>
</tr>
<tr>
<td>&quot;IsFluidMode&quot; (PeopleTools 8.57: PeopleCode Language Reference)</td>
<td>Return a boolean value indicating whether Fluid Mode is enabled on the component.</td>
</tr>
<tr>
<td>&quot;IsFluidSearchStart&quot; (PeopleTools 8.57: PeopleCode Language Reference)</td>
<td>Return a boolean value indicating whether the Fluid Search is started on the component.</td>
</tr>
<tr>
<td>&quot;IsGroupletRequest&quot; (PeopleTools 8.57: PeopleCode Language Reference)</td>
<td>Return a boolean value indicating whether the request was initiated by a tile (also referred to as a grouplet).</td>
</tr>
<tr>
<td>&quot;IsHomeEnabled&quot; (PeopleTools 8.57: PeopleCode Language Reference)</td>
<td>Return a boolean value indicating whether the Home button is enabled on the component.</td>
</tr>
<tr>
<td>&quot;IsIScriptAuthorized&quot; (PeopleTools 8.57: PeopleCode Language Reference)</td>
<td>Return a boolean value indicating whether the current user is allowed to access the specified iScript.</td>
</tr>
<tr>
<td>&quot;IsLogoutEnabled&quot; (PeopleTools 8.57: PeopleCode Language Reference)</td>
<td>Return a boolean value indicating whether Logout is enabled on the component.</td>
</tr>
<tr>
<td>&quot;IsMDComponent&quot; (PeopleTools 8.57: PeopleCode Language Reference)</td>
<td>Return a boolean value indicating whether the component type is set to Master/Detail on the Fluid tab.</td>
</tr>
<tr>
<td>&quot;IsMDGuided&quot; (PeopleTools 8.57: PeopleCode Language Reference)</td>
<td>Return a boolean value indicating whether the master/detail or activity guide wrapper is in guided mode (that is, Previous and Next are displayed in the fluid banner).</td>
</tr>
<tr>
<td>&quot;IsMDListPopup&quot; (PeopleTools 8.57: PeopleCode Language Reference)</td>
<td>Return a boolean value whether the master/detail or activity guide wrapper is in non-optimized mode (that is, navigation to pages is presented in a drop-down list in the fluid banner, not in the left panel).</td>
</tr>
<tr>
<td>Function</td>
<td>Description</td>
</tr>
<tr>
<td>----------</td>
<td>-------------</td>
</tr>
<tr>
<td>&quot;IsMDNonOptimized&quot; (PeopleTools 8.57: PeopleCode Language Reference)</td>
<td>This function is equivalent to the IsMDListPopup function.</td>
</tr>
<tr>
<td>&quot;IsMDRequest&quot; (PeopleTools 8.57: PeopleCode Language Reference)</td>
<td>Return a boolean value indicating whether the request was initiated by a component from within the master/detail wrapper.</td>
</tr>
<tr>
<td>&quot;IsMDSearchEnabled&quot; (PeopleTools 8.57: PeopleCode Language Reference)</td>
<td>Return a boolean value indicating whether the search type is set to Master/Detail for the current component.</td>
</tr>
<tr>
<td>&quot;IsModeless&quot; (PeopleTools 8.57: PeopleCode Language Reference)</td>
<td>Return a boolean value indicating whether the target content for the tile is currently being displayed in a modal window—that is, the Display In setting for the tile is set to Modal.</td>
</tr>
<tr>
<td>&quot;IsNavBarEnabled&quot; (PeopleTools 8.57: PeopleCode Language Reference)</td>
<td>Return a boolean value indicating whether the NavBar is enabled on the component.</td>
</tr>
<tr>
<td>&quot;IsNextInListEnabled&quot; (PeopleTools 8.57: PeopleCode Language Reference)</td>
<td>Return a boolean value indicating whether NextInList is enabled on the component.</td>
</tr>
<tr>
<td>&quot;IsNotificationEnabled&quot; (PeopleTools 8.57: PeopleCode Language Reference)</td>
<td>Return a boolean value indicating whether the Notifications button is enabled on the fluid component. This corresponds to the Notifications toolbar option on the component’s Fluid tab.</td>
</tr>
<tr>
<td>&quot;IsPinEnabled&quot; (PeopleTools 8.57: PeopleCode Language Reference)</td>
<td>Return a boolean value indicating whether Add To functions are enabled on the component.</td>
</tr>
<tr>
<td>&quot;IsPrevInListEnabled&quot; (PeopleTools 8.57: PeopleCode Language Reference)</td>
<td>Return a boolean value indicating whether PreviousInList is enabled on the component.</td>
</tr>
<tr>
<td>&quot;IsSaveEnabled&quot; (PeopleTools 8.57: PeopleCode Language Reference)</td>
<td>Return a boolean value indicating whether Save is enabled on the component.</td>
</tr>
<tr>
<td>&quot;IsSearchEnabled&quot; (PeopleTools 8.57: PeopleCode Language Reference)</td>
<td>Return a boolean value indicating whether search is enabled on the component. <strong>Important!</strong> In PeopleTools 8.55 or later, use either the IsMDSearchEnabled function or the IsStandardSearchEnabled function instead to determine which type of search is enabled.</td>
</tr>
<tr>
<td>&quot;IsSingleComponentAG&quot; (PeopleTools 8.57: PeopleCode Language Reference)</td>
<td>Return a boolean value indicating whether this is a single component activity guide.</td>
</tr>
<tr>
<td>&quot;IsSingleUnitOfWork&quot; (PeopleTools 8.57: PeopleCode Language Reference)</td>
<td>Return a boolean value indicating whether this is a single unit of work activity guide.</td>
</tr>
<tr>
<td>&quot;IsSmallFFOptimized&quot; (PeopleTools 8.57: PeopleCode Language Reference)</td>
<td>Return a boolean value indicating whether the Display on Small Form Factor Homepage option has been selected on the Fluid tab of the component properties.</td>
</tr>
</tbody>
</table>
Chapter 6 Working with PeopleCode for the Fluid User Interface

### Function Description

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;IsStandardSearchEnabled&quot; (PeopleTools 8.57: PeopleCode Language Reference)</td>
<td>Return a boolean value indicating whether the search type is set to Standard for the current component.</td>
</tr>
<tr>
<td>&quot;SetAddMode&quot; (PeopleTools 8.57: PeopleCode Language Reference)</td>
<td>Set the AddMode attribute in the panel processor.</td>
</tr>
<tr>
<td>&quot;SetMDGuided&quot; (PeopleTools 8.57: PeopleCode Language Reference)</td>
<td>Set whether the master/detail or activity guide wrapper is in guided mode (that is, Previous and Next buttons are displayed in the fluid banner).</td>
</tr>
<tr>
<td>&quot;SetMDListPopup&quot; (PeopleTools 8.57: PeopleCode Language Reference)</td>
<td>Set whether the master/detail or activity guide wrapper is in non-optimized mode (that is, navigation to pages is presented in a drop-down list in the fluid banner, not in the left panel).</td>
</tr>
<tr>
<td>&quot;SetPanelControlStyle&quot; (PeopleTools 8.57: PeopleCode Language Reference)</td>
<td>Specify a String value that updates the system with styles that control the state of the left and right panels.</td>
</tr>
<tr>
<td>&quot;SetThemeId&quot; (PeopleTools 8.57: PeopleCode Language Reference)</td>
<td>Set the theme ID for the page so that proper theme style sheets get loaded.</td>
</tr>
<tr>
<td>&quot;SetTransferAttributes&quot; (PeopleTools 8.57: PeopleCode Language Reference)</td>
<td>Set certain fluid-related properties prior to executing a transfer to a different page or component.</td>
</tr>
</tbody>
</table>

### Related Links

"Understanding Activity Guide Templates and Template Types" (PeopleTools 8.57: Portal Technology)

**PT_PAGE_UTILS Application Package**

The fluid page utilities classes of the PT_PAGE_UTILS application package provide tools to manage certain aspects of your fluid applications:

- **PT_PAGE_UTILS:Banner** —

  Use the PT_PAGE_UTILS:Banner class to control items in the fluid banner including the title as well as visibility of some of the items that appear in the Actions list.

  Many methods of this class are ignored and have no effect if the component is rendered in a context that does not allow access to the fluid banner and Actions list such as in an activity guide, in a master/detail component, or in a modal window.

- **PT_PAGE_UTILS:PanelController** —

  Use the PT_PAGE_UTILS:PanelController class to inquire on and update the modes and visibility of the Side Page 1 (left panel) and Side Page 2 (right panel). Because this class spawns Panel objects for each side panel, you do not need to instantiate Panel objects directly.

  The system determines the initial characteristics of each panel based on the configuration of the component, activity guide instance, or master/detail instance. The system also maintains the panels’ runtime characteristics. The panel state is not maintained within the PanelController object (or...
any Panel objects it spawns). Therefore, you must ensure that any changes are updated back to the server to effect an actual change either by directly invoking the UpdatePanel method or indirectly by invoking the Initialize method with auto-update set to true.

• **PT_PAGE_UTILS:Utils** —

  The PT_PAGE_UTILS:Utils class provides general utility methods for working with viewport settings, displaying confirmation messages in the banner, and working with toggle buttons.

---

**Important!** To be rendered correctly across all device types, each fluid application should set the viewport. The "SetDefaultViewport" (PeopleTools 8.57: PeopleCode API Reference) method is the recommended way to do this.

---

**Related Links**

"Banner Class" (PeopleTools 8.57: PeopleCode API Reference)
"PanelController Class" (PeopleTools 8.57: PeopleCode API Reference)
"Utils Class" (PeopleTools 8.57: PeopleCode API Reference)

**Additional Field Class Methods and Properties**

This section lists other methods and properties of the Field class used in fluid development.

See "AddFFClass" (PeopleTools 8.57: PeopleCode API Reference).
See "AriaAttributes" (PeopleTools 8.57: PeopleCode API Reference).
See "AriaWrapperAttributes" (PeopleTools 8.57: PeopleCode API Reference).
See "FreeFormStyleName" (PeopleTools 8.57: PeopleCode API Reference).
See "GetBaseName" (PeopleTools 8.57: PeopleCode API Reference).
See "HtmlAttributes" (PeopleTools 8.57: PeopleCode API Reference).
See "HtmlInputType" (PeopleTools 8.57: PeopleCode API Reference).
See "IsHyperlink" (PeopleTools 8.57: PeopleCode API Reference).
See "JavaScriptEvents" (PeopleTools 8.57: PeopleCode API Reference).
See "PlaceholderText" (PeopleTools 8.57: PeopleCode API Reference).
See "ReplaceFFClass" (PeopleTools 8.57: PeopleCode API Reference).
See "SetImageUrl" (PeopleTools 8.57: PeopleCode API Reference).

**Additional Grid Class Properties**

This section lists other properties of the Grid class used in fluid development.

See "Layout" (PeopleTools 8.57: PeopleCode API Reference).
See "FreeFormStyleName" (PeopleTools 8.57: PeopleCode API Reference).
See "Selector" (PeopleTools 8.57: PeopleCode API Reference).

### Additional Meta-HTML

Additional meta-HTML you can use with fluid development include these constructs.


See "%@FORMFACTOREXTRALARGE" (PeopleTools 8.57: PeopleCode Language Reference).

See "%@FORMFACTORLARGE" (PeopleTools 8.57: PeopleCode Language Reference).

See "%@FORMFACTORMEDIUM" (PeopleTools 8.57: PeopleCode Language Reference).

See "%@FORMFACTORSMALL" (PeopleTools 8.57: PeopleCode Language Reference).

See "%@BB" (PeopleTools 8.57: PeopleCode Language Reference).

See "%@BP" (PeopleTools 8.57: PeopleCode Language Reference).

See "%@BV" (PeopleTools 8.57: PeopleCode Language Reference).

---

### Determining Browser and Device Type

Depending on the device or browser accessing the application, you may want to set various options or styles catered to that device type, browser type, or browser platform (operating system).

See "FormFactor" (PeopleTools 8.57: PeopleCode API Reference).

See "GetDeviceInfo" (PeopleTools 8.57: PeopleCode API Reference).

See "BrowserDeviceType" (PeopleTools 8.57: PeopleCode API Reference).

See "BrowserDeviceFormFactor" (PeopleTools 8.57: PeopleCode API Reference).

See "BrowserFluidCapable" (PeopleTools 8.57: PeopleCode API Reference).

See "BrowserTypeClass" (PeopleTools 8.57: PeopleCode API Reference).

See "BrowserPlatformClass" (PeopleTools 8.57: PeopleCode API Reference).

See "ExtraLarge" (PeopleTools 8.57: PeopleCode API Reference).

See "Large" (PeopleTools 8.57: PeopleCode API Reference).

See "Medium" (PeopleTools 8.57: PeopleCode API Reference).

See "Small" (PeopleTools 8.57: PeopleCode API Reference).
Using Drag and Drop PeopleCode

The PeopleCode used to handle drag and drop functionality needs to be component-level PeopleCode and to be added to the PT_WORK.PT_BUTTON_DND field. With drag and drop, you drag data from a field, row, or rowset in a source group box and drop it onto a field, row, or rowset in a target group box.

See "GetDNDField" (PeopleTools 8.57: PeopleCode API Reference).
See "GetDNDRow" (PeopleTools 8.57: PeopleCode API Reference).
See "GetDNDRowset" (PeopleTools 8.57: PeopleCode API Reference).
See "GetDNDTargetField" (PeopleTools 8.57: PeopleCode API Reference).
See "GetDNDTargetRow" (PeopleTools 8.57: PeopleCode API Reference).
See "GetDNDTargetRowset" (PeopleTools 8.57: PeopleCode API Reference).
See "Draggable" (PeopleTools 8.57: PeopleCode API Reference).
See "Droppable" (PeopleTools 8.57: PeopleCode API Reference).

Creating Grouplets with PeopleCode

A grouplet is the encapsulation of content from one source (for example, a component, an iScript, or external content) that is presented within the context of another fluid application page. Tiles, embedded related content, and related information are all examples of grouplets. In each of these scenarios, the grouplets are created by the system at runtime based solely on configuration details.

However, you can use methods and properties of the Field class to generate grouplets from group box fields programmatically. The following example with comments illustrates how to create a grouplet based on component content. The behavior of the grouplet can be enhanced by optional method invocations to set a target URL, where the target content is displayed, and so on.

Example

Declare Function PSURLtoNewWin PeopleCode FUNCLIB_PTPP.PTPP_HYPERLINK FieldFormula;

Local string &src_URL = PSURLtoNewWin(GenerateComponentContentURL(%Portal, %Node, MenuName.MY_MENU, %Market, Component.COMPONENT_A, Page.MAIN_A, %Action_UpdateDisplay));

Local string &tgt_URL = PSURLtoNewWin(GenerateComponentContentURL(%Portal, %Node, MenuName.MY_MENU, %Market, Component.COMPONENT_B, Page.MAIN_A, %Action_UpdateDisplay));

Local Field &fld = GetField();

/* Use the following three methods to create a display-only grouplet. */
 fld.SetGroupletType(%GroupletNoStyle);
/* Specifies the grouplet's source content */
 fld.SetGroupletUrl(&src_URL);
/* Specifies the group box's page field name. Not used with interactive */
/* grouplets, which render the entire component. */
 fld.SetGroupletID("GRPLTC_NOINTER");
/* Optional. Specifies the target URL, which makes the entire grouplet tappable. */
&fld.SetGroupletActionUrl(&tgt_URL);

/* Optional. Specifies how the action URL is opened. Default is current window. */
&fld.SetGroupletDisplayIn(%GroupletActionInNewWindow); /* */

/* Enable the icon for zooming to open the modal – similar to related */
/* information in the right panel. */
<*& &fld.IsGroupletZoomIconEnabled = True;
/* Modal options if %GroupletActionInModal is used for SetGroupletDisplayIn. */
&fld.SetGroupletMOptions("bAutoClose@0;"); *

Related Links
"SetGroupletActionUrl" (PeopleTools 8.57: PeopleCode API Reference)
"SetGroupletDisplayIn" (PeopleTools 8.57: PeopleCode API Reference)
"SetGroupletEventMsg" (PeopleTools 8.57: PeopleCode API Reference)
"SetGroupletID" (PeopleTools 8.57: PeopleCode API Reference)
"SetGroupletImage" (PeopleTools 8.57: PeopleCode API Reference)
"SetGroupletImageUrl" (PeopleTools 8.57: PeopleCode API Reference)
"SetGroupletMOptions" (PeopleTools 8.57: PeopleCode API Reference)
"SetGroupletTargetID" (PeopleTools 8.57: PeopleCode API Reference)
"SetGroupletTimer" (PeopleTools 8.57: PeopleCode API Reference)
"SetGroupletType" (PeopleTools 8.57: PeopleCode API Reference)
"SetGroupletUrl" (PeopleTools 8.57: PeopleCode API Reference)
"IsGroupletRequest" (PeopleTools 8.57: PeopleCode Language Reference)

Limitations on Accessing a Component as a Grouplet and Then in a Standalone Manner

To prevent data integrity errors in the component buffer during a user’s session, you must not provide access to the same fluid component as a grouplet or in a “modeless” manner and then again in a “standalone” manner.

Specifically, standalone access refers to navigation to the fluid component from the Navigator menu, a homepage, a dashboard, a component transfer, execution of DoModalComponentPopup, and so on. The same fluid component cannot be specified as a grouplet (that is, as dynamic tile content, embedded related content, related information, or programmatically via grouplet PeopleCode) and it cannot be displayed in a “modeless” manner (such as the zoom on related information, the modal target for a tile, through ViewContentURL, and so on).

Implementing Transfers and Modal Windows with PeopleCode

Transfer and Modal Functions

Eighteen PeopleCode functions are available to use for implementing transfers and creating modal windows. Some functions are available for use in fluid applications only, in classic applications only, or in other specific contexts. The information on these functions is presented in a table that has been split into four parts. See the legend that follows the table for an explanation of terms and abbreviations.
<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
<th>Source Location</th>
<th>Action</th>
<th>Target</th>
<th>Rel</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;DoModal&quot; (PeopleTools 8.57: PeopleCode Language Reference)</td>
<td>Use the DoModal function to display a secondary page in a modal, secondary window with a child relationship to the parent window.</td>
<td>Y</td>
<td>Y</td>
<td>*</td>
<td>*</td>
</tr>
<tr>
<td>&quot;DoModalComponent&quot; (PeopleTools 8.57: PeopleCode Language Reference)</td>
<td>Use the DoModalComponent function to display a secondary component in a modal, secondary window with a child relationship to the parent window.</td>
<td>Y</td>
<td>Y</td>
<td>*</td>
<td>*</td>
</tr>
<tr>
<td>&quot;DoModalComponentPopup&quot; (PeopleTools 8.57: PeopleCode Language Reference)</td>
<td>Use DoModalComponentPopup as the recommended function to display a secondary fluid component in a modal, secondary window with a child relationship to the parent window. This function includes a modal_options parameter, which allows you to specify characteristics of the modal window such as height and width.</td>
<td>Y</td>
<td>N</td>
<td>*</td>
<td>*</td>
</tr>
<tr>
<td>&quot;DoModalPopup&quot; (PeopleTools 8.57: PeopleCode Language Reference)</td>
<td>Use DoModalPopup as the recommended function to display a secondary fluid page in a modal, secondary window with a child relationship to the parent window. This function includes a modal_options parameter, which allows you to specify characteristics of the modal window such as height and width.</td>
<td>Y</td>
<td>N</td>
<td>*</td>
<td>*</td>
</tr>
<tr>
<td>Function</td>
<td>Description</td>
<td>FS</td>
<td>CS</td>
<td>AG/ MD</td>
<td>IG</td>
</tr>
<tr>
<td>----------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>----</td>
<td>----</td>
<td>--------</td>
<td>----</td>
</tr>
<tr>
<td>&quot;DoModalX&quot; (PeopleTools 8.57: PeopleCode Language Reference)</td>
<td>Use the DoModalX function to display a secondary page modally when you do not want it to display in a modal, secondary window.</td>
<td>N</td>
<td>Y</td>
<td>*</td>
<td>N</td>
</tr>
<tr>
<td>&quot;DoModalXComponent&quot; (PeopleTools 8.57: PeopleCode Language Reference)</td>
<td>Use the DoModalXComponent function to display a secondary component modally when you do not want it to display in a modal, secondary window.</td>
<td>N</td>
<td>Y</td>
<td>*</td>
<td>N</td>
</tr>
<tr>
<td>&quot;RedirectURL&quot; (PeopleTools 8.57: PeopleCode API Reference)</td>
<td>Use the RedirectURL function in to navigate to the location specified by the URL parameter.</td>
<td>N</td>
<td>Y</td>
<td>N</td>
<td>N</td>
</tr>
<tr>
<td>&quot;Transfer&quot; (PeopleTools 8.57: PeopleCode Language Reference)</td>
<td>Use the Transfer function to exit the current context and transfer the user to another page.</td>
<td>Y</td>
<td>Y</td>
<td>Y¹</td>
<td>Y²</td>
</tr>
<tr>
<td>&quot;TransferExact&quot; (PeopleTools 8.57: PeopleCode Language Reference)</td>
<td>Use the TransferExact function to exit the current context and transfer the end user to another page using an exact match of all keys in the optional key list.</td>
<td>Y</td>
<td>Y</td>
<td>Y¹</td>
<td>Y²</td>
</tr>
<tr>
<td>&quot;TransferModeless&quot; (PeopleTools 8.57: PeopleCode Language Reference)</td>
<td>Use the TransferModeless function to open a new page in a modeless window on top of the parent window.</td>
<td>N</td>
<td>Y</td>
<td>*</td>
<td>*</td>
</tr>
<tr>
<td>&quot;TransferTop&quot; (PeopleTools 8.57: PeopleCode Language Reference)</td>
<td>Use the TransferTop function to exit the current context and transfer the user to another page by always replacing the current window.</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td>Function</td>
<td>Description</td>
<td>Source Location</td>
<td>Action</td>
<td>Target</td>
<td>Rel</td>
</tr>
<tr>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
</tr>
<tr>
<td>&quot;ViewContentURL&quot; (PeopleTools 8.57: PeopleCode Language Reference)</td>
<td>Use the ViewContentURL function to open a new browser window and navigate to the location specified by the URL parameter.</td>
<td>FS</td>
<td>CS</td>
<td>AG/MD</td>
<td>IG</td>
</tr>
<tr>
<td></td>
<td></td>
<td>N</td>
<td>Y</td>
<td>N</td>
<td>N</td>
</tr>
<tr>
<td>&quot;ViewContentURLClassic&quot; (PeopleTools 8.57: PeopleCode Language Reference)</td>
<td>Use the ViewContentURLClassic function to navigate to the classic content specified by the URL parameter.</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>&quot;ViewContentURLFluid&quot; (PeopleTools 8.57: PeopleCode Language Reference)</td>
<td>Use the ViewContentURLFluid function to navigate to the fluid content specified by the URL parameter.</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>&quot;ViewContentURLModeless&quot; (PeopleTools 8.57: PeopleCode Language Reference)</td>
<td>Use the ViewContentURLModeless function to open a modeless modal window displaying the PeopleSoft component content (either classic or fluid) specified by the URL parameter.</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>&quot;ViewURL&quot; (PeopleTools 8.57: PeopleCode Language Reference)</td>
<td>Use the ViewURL function to navigate to the location specified by the URL parameter.</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>&quot;ViewURLModeless&quot; (PeopleTools 8.57: PeopleCode Language Reference)</td>
<td>Use the ViewURLModeless function to open a modeless modal window displaying the non-component content (for example, an iScript or external content) specified by the URL parameter.</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Source Location</td>
<td>Description</td>
<td>Function</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>-----------------</td>
<td>-------------</td>
<td>----------</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>FS</td>
<td>Y</td>
<td>“ViewURLTop” (PeopleTools 8.5.7, PeopleCode Language Reference)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>IG</td>
<td>Y</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>MD</td>
<td>Y</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CS</td>
<td>Y</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>NW</td>
<td>Y</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>MW</td>
<td>Y</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CW</td>
<td>Y</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>C2F</td>
<td>Y</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>C2C</td>
<td>Y</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>F2F</td>
<td>Y</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>F2C</td>
<td>Y</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Target</th>
<th>Action</th>
<th>Source Location</th>
<th>Relation</th>
<th>Available</th>
<th>Release</th>
</tr>
</thead>
<tbody>
<tr>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>N</td>
</tr>
<tr>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>N</td>
</tr>
<tr>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>N</td>
</tr>
<tr>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>N</td>
</tr>
<tr>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>N</td>
</tr>
<tr>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
</tr>
</tbody>
</table>

Use the `ViewURLTop` function to exit the current context and navigate to the location specified by the `URL` parameter by always replacing the current window.
Legend

<table>
<thead>
<tr>
<th>Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>FS</td>
<td>Fluid standalone</td>
</tr>
<tr>
<td>CS</td>
<td>Classic standalone</td>
</tr>
<tr>
<td>AG/MD</td>
<td>Activity guide (incl. fluid navigation collections) or master/detail</td>
</tr>
<tr>
<td>IG</td>
<td>Interactive grouplet</td>
</tr>
<tr>
<td>MW</td>
<td>Modeless window</td>
</tr>
<tr>
<td>F2F</td>
<td>Fluid-to-fluid</td>
</tr>
<tr>
<td>F2C</td>
<td>Fluid-to-classic</td>
</tr>
<tr>
<td>C2C</td>
<td>Classic-to-classic</td>
</tr>
<tr>
<td>C2F</td>
<td>Classic-to-fluid</td>
</tr>
<tr>
<td>CW</td>
<td>Current window</td>
</tr>
<tr>
<td>NW</td>
<td>New window</td>
</tr>
<tr>
<td>2W</td>
<td>Secondary window (modal or modeless)</td>
</tr>
<tr>
<td>*</td>
<td>Refer to the values for the source type as a standalone component</td>
</tr>
<tr>
<td>1</td>
<td>When AJAX transfers are not enabled (default), the action exits the fluid wrapper and the content replaces the current window. When AJAX transfers are enabled, the new content is displayed in the target content area of the fluid wrapper.</td>
</tr>
<tr>
<td>2</td>
<td>When the target setting is current window, the content replaces the current content.</td>
</tr>
<tr>
<td>3</td>
<td>On iOS only, when the Safari browser is in full screen mode and when content has been set to open in a new window, the content replaces the current window instead.</td>
</tr>
</tbody>
</table>

Modal Options

Modal windows can be launched from fluid components in four different ways. Each of these four scenarios allows you to specify modal options:

- Programmatically, use one of the following PeopleCode built-in functions: DoModalComponentPopup, DoModalPopup, ViewContentURLModeless, or ViewModeless. Modal options are specified by the modal_options parameter.
- For a group box defined as a grouplet, use the SetGroupletMOptions method to set modal options. (See Creating Grouplets with PeopleCode for more information on creating grouplets.)
- On the Fluid Attributes page of a content reference definition, if you specify Modal for the Display In option, then the Modal Parameters field is displayed.
- For a Tile Wizard definition, at Step 4, if you specify Modal for the Display In option, then the Modal Parameters field is displayed.
Important! Always use a semicolon to terminate each modal option. For example:

```
&sPopupOptions = "bAutoClose@1;bPopup@1;";
```

The following table lists modal options in alphabetical order. For Boolean options, specifying 1 enables the option; specifying 0 disables it:

<table>
<thead>
<tr>
<th>Option</th>
<th>Values</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>bAutoClose</td>
<td>0</td>
<td>1</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Enable automatically closing the modal window when the user clicks anywhere outside the modal window.</td>
</tr>
<tr>
<td>bAutoCloseWarn</td>
<td>0</td>
<td>1</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Enable display of a save warning if content in the modal window has been changed when bAutoClose has been enabled.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td><strong>Note:</strong> This option is applicable only when bAutoClose has been enabled by DoModalComponentPopup or DoModalPopup.</td>
</tr>
<tr>
<td>bCenter</td>
<td>0</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Display the modal window near the center of the main window.</td>
</tr>
<tr>
<td>bClose</td>
<td>0</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Enable the close icon in the header of the modal window.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td><strong>Note:</strong> This option is valid only for popup group boxes, only with the SetGroupletMOptions method, and only when the header is displayed; otherwise, it is ignored in all other contexts.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td><strong>Important!</strong> Do not disable both of auto-close and the close icon.</td>
</tr>
<tr>
<td>bFullScreen</td>
<td>0</td>
<td>1</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Display the modal window so that it covers the entire screen.</td>
</tr>
<tr>
<td>bHeader</td>
<td>0</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Display the header for the modal window.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td><strong>Note:</strong> This option is ignored by DoModalComponentPopup and DoModalPopup because the header content is displayed within the same iframe as the target content within the modal window. You must use styling on the page definition to hide the header with these PeopleCode functions.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td><strong>Important!</strong> Disabling the mask is not recommended. Moreover, a mask is required when bAutoClose is enabled.</td>
</tr>
<tr>
<td>bMask</td>
<td>0</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Display a transparent mask over the parent window.</td>
</tr>
<tr>
<td>bPopup</td>
<td>0</td>
<td>1</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Display the modal window adjacent to the trigger field with a chat dialog-style arrow pointing to the trigger field.</td>
</tr>
</tbody>
</table>
### Option Values Default Description

<table>
<thead>
<tr>
<th>Option</th>
<th>Values</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>bPopupMenu</td>
<td>0</td>
<td>1</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td><code>MY_RECORD.POPUP_MENU_GBX.SetGroupletMOptions(&quot;⇒bPopupMenu@1;&quot;);</code></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td><strong>Note:</strong> When bPopupMenu is enabled (set to 1), the system will automatically set bHeader to 0 (disabled), bAutoClose to 1 (enabled), bMask to 1 (enabled), and sMaskStyle to ps_masktrans; these options cannot be overridden. In addition, bVertical will be set to 1 (which is recommended), but it can be overridden. See Creating Fluid Pop-up Menus.</td>
</tr>
<tr>
<td>bVertical</td>
<td>0</td>
<td>1</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td><code>MY_RECORD.POPUP_MENU_GBX.SetGroupletMOptions(&quot;⇒bPopupMenu@1;bVertical@0;&quot;);</code></td>
</tr>
<tr>
<td>sTitle</td>
<td>String</td>
<td>&quot;&quot;</td>
<td>Set the title in the header of the modal window. <strong>Note:</strong> This option is ignored by DoModalComponentPopup and DoModalPoup because the header content is displayed within the same iframe as the target content within the modal window. <strong>Note:</strong> To allow spaces in the title and to properly escape special characters, store the title as a message catalog entry. Then, use the EscapeHTML built-in function on the retrieved message. For example:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td><code>$sMenuTitle = EscapeHTML(MsgGetText(11124, 525⇒,&quot;Message Not Found: My Title&quot;));</code></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>`$sOptions = &quot;sTitle@&quot;</td>
</tr>
<tr>
<td>sWidth</td>
<td>String</td>
<td>none</td>
<td>Set the height and width of the modal window as a string value. You can specify any CSS supported unit of measure such as em, in, cm, px, %, and so on. For example:</td>
</tr>
<tr>
<td>sHeight</td>
<td></td>
<td></td>
<td><code>sWidth@50em; sHeight@100em;</code></td>
</tr>
<tr>
<td>width</td>
<td>Number</td>
<td>none</td>
<td>Set the height and width of the modal window in pixels. For example:</td>
</tr>
<tr>
<td>height</td>
<td></td>
<td></td>
<td><code>width@400; height@400;</code></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td><strong>Note:</strong> The recommended approach for sizing a modal window is to apply styles at the page level.</td>
</tr>
</tbody>
</table>
Working with PeopleCode for the Fluid User Interface

Chapter 6 Working with PeopleCode for the Fluid User Interface

Related Links

"DoModalComponentPopup" (PeopleTools 8.57: PeopleCode Language Reference)
"DoModalPopup" (PeopleTools 8.57: PeopleCode Language Reference)
"SetGroupletMOptions" (PeopleTools 8.57: PeopleCode API Reference)
"ViewContentURLModeless" (PeopleTools 8.57: PeopleCode Language Reference)
"ViewURLModeless" (PeopleTools 8.57: PeopleCode Language Reference)

---

Working with the Back Button

The Back button is displayed on the left side of the fluid banner (or the left side of the fluid-like portal header on classic pages). The Back button is used to navigate back to the previously visited item (for example, component, homepage, activity guide, navigation collection, WorkCenter, or MAP application). The label on the Back button varies to indicate the item to which the user will return.

The navigation history stack tracks navigation from component to component, including navigation from standard components, homepages, dashboards, activity guides, navigation collections, WorkCenters, and MAP applications. When a user navigates from one of these items, the Back button will be labeled appropriately and will point back to that item. However, page transfers within a component are not tracked in the navigation history stack. To support navigation tracking to remote content in a clustered PeopleSoft environment, an additional HTTP request, PTGETREMOTEDATA, is issued from the local site to the remote site. For more information on the Back button’s behavior in specific circumstances, see "Using the Back Button" (PeopleTools 8.57: Applications User's Guide).

Application developers can override the default Back button behavior (for example, specifying a custom Back button label or indicating that a specific transfer is to be ignored) using the SetTransferAttributes PeopleCode function, which alters the entries written to the navigation history stack. In addition, component property settings or the SetTransferAttributes function can be used to enable tracking of page-to-page transfers within a component.

Related Links

"Setting Internet Properties" (PeopleTools 8.57: Application Designer Developer's Guide)
"SetTransferAttributes" (PeopleTools 8.57: PeopleCode Language Reference)
Chapter 7

Managing Fluid User Interface Deployments

Configuring Web Profile Settings for Fluid Applications

Web Profile Configuration - General Page

Navigation

Access the Web Profile Configuration page. (Select PeopleTools > Web Profile > Web Profile Configuration.)

If you intend to enable online help for your fluid components, you must specify a Help URL value in the web profile on the General page.

For information on all of the fields on the Web Profile Configuration - General page, see "Configuring General Portal Properties" (PeopleTools 8.57: Portal Technology).

For more information on enabling help for a fluid page, see Setting Fluid Properties.

Web Profile Configuration - Look and Feel Page

Navigation

Access the Web Profile Configuration - Look and Feel page. (Select PeopleTools > Web Profile > Web Profile Configuration. Select the Look and Feel page.)

Image: Web Profile Configuration - Look and Feel page, fluid properties

The following example illustrates the Fluid Homepage property that you can set for fluid applications.

<table>
<thead>
<tr>
<th>Start Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Page: WEBLIB_PTB1LSCRIPT1.FieldFormula.Script_StartPage</td>
</tr>
<tr>
<td>Fluid Homepage: NUI_FRAMEWORK.PT_LANDINGPAGE.GBL</td>
</tr>
</tbody>
</table>

Fluid Homepage
Displays the name of the component used to render fluid homepage tabs.

The default value is NUI_FRAMEWORK.PT_LANDINGPAGE.GBL.

Override
Click to change the default fluid homepage. The Override Fluid Homepage Component page is displayed with these fields:

- Menu Name: The default value is NUI_FRAMEWORK.
- Component: The default value is PT_LANDINGPAGE.
• Market: The default value is *GBL*.

• Fluid Homepage: This field is blank by default.

**Important!** When this value is set, it appears as \LP=LB\_PAGE\_ID and it overrides any values set on the Assign Branding Themes page. See "Assigning Branding Themes" (PeopleTools 8.57: Portal Technology) for more information on defining the default fluid homepage for a portal and by user attribute.

The values of these four fields are concatenated to produce the value of the Fluid Homepage field on the Look and Feel page.

For information on all of the fields on the Web Profile Configuration - Look and Feel page, see "Configuring Appearance and Character" (PeopleTools 8.57: Portal Technology).

---

**Configuring PeopleTools Options for Fluid Applications**

The system-wide options for fluid applications appear on the PeopleTools Options page in the Fluid Mode Properties group box.

**Image: Fluid Mode Properties**

This example illustrates the properties for fluid applications on the PeopleTools Options page. Descriptions of the properties appear after the example.

### Fluid Mode Properties

#### Default Style Sheet Name

Displays the default, system-wide style sheet for fluid components, which is defined on the Branding System Options page.

**Note:** If no style sheet is specified, then PSSTYLEDEF\_FMODE is used as the default style sheet for all fluid components.

See "Configuring Branding System Options" (PeopleTools 8.57: Portal Technology)

#### Embedded Stub Subpage

The default subpage stub is PT\_ERCSUBPAGE\_STUB.
Managing Fluid Homepages

Creating, configuring, and managing fluid homepages is similar to managing classic homepages, which is performed in the PeopleTools Portal administration interface. When working with fluid homepages, make sure you are familiar with the concepts and procedures of the portal registry.

Related Links
"Managing Homepages" (PeopleTools 8.57: Portal Technology)

Working with Fluid Homepages

PeopleTools provides a default homepage, named DEFAULT_LP. The underlying fluid page and component are both named PT_LANDINGPAGE. (The term landing refers to where the user “lands” after signing on to the system).

All fluid homepages are content references under the Fluid Homepage - Hidden folder. Set the content reference permission to control the access.

Default PeopleSoft User (PTPT1000) permissions are granted to the component. Managing and administering the system delivered fluid homepages requires the Portal Administrator permission list (PTPT1300).

Renaming a homepage is controlled by the All Rename option on the Homepage tab attributes for a homepage content reference.

See Setting Component Properties for Fluid Components for more information on fluid component properties.
Setting Device Homepage Defaults

By default, all devices are set to display the fluid homepage after an end user signs on to the PeopleSoft system. If the classic homepage is preferred for any or all device types, you can override the fluid homepage default using the Define Personalization page.

Navigation

Select PeopleTools > Personalization > Personalization Options > select PPTL.

Image: Define Personalizations page

This example shows using the HPPC and HPTABLET options to set system defaults for homepage display.

Important! The HPPC and HPTABLET user options are system-wide settings. They cannot be exposed to end users to adjust as needed.

HPPC applies to laptop and desktop computers and HPTABLET applies to mobile devices. If you want to change the default homepage displayed for a device, click the Set Option Default Value link, and select the desired homepage.
Image: Set Option Default Value page

This example illustrates overriding the default homepage of fluid and setting it to classic for PC’s (laptops and desktop computers).

<table>
<thead>
<tr>
<th>Option Category Level</th>
<th>PeopleTools</th>
</tr>
</thead>
<tbody>
<tr>
<td>User Option</td>
<td>HPPC</td>
</tr>
<tr>
<td>Description</td>
<td>PC Homepage</td>
</tr>
<tr>
<td>Current Default Value</td>
<td>Fluid</td>
</tr>
<tr>
<td>Option Default Value</td>
<td>Classic</td>
</tr>
</tbody>
</table>

Providing Guest User Access to Fluid Homepages

PeopleTools provides a feature where you can provide guest access to the system. This applies to both fluid and classic users where a user may not be tied to a user profile in the system, but can access specific pages in the system as needed. Configuring this option is discussed in detail in the product documentation for PeopleTools Portal Technology.

For more information, see "Implementing Guest User Access" (PeopleTools 8.57: Portal Technology).

Related Links
"Managing Homepages" (PeopleTools 8.57: Portal Technology)

Managing Mobile Device Access

PeopleTools delivers a default icon (LOGO_FAVICON) that will be used when a user adds (pins) a link to any PeopleSoft URL on the home screen of their mobile device. If you replace the PeopleTools default icon with a custom image, that customization will be overwritten after applying a PeopleTools update or upgrade.
Working with the Push Notification Framework

Understanding the Push Notification Framework

The Push Notification Framework updates the user interface with real time changes that have occurred on the server tier. The framework enables the PeopleSoft Internet Architecture to push data directly to the end user’s display. To bring this feature to your PeopleSoft application, PeopleTools takes advantage of these elements in our server architecture:

- WebSocket push technology on the web server.
- Tuxedo event broker on the application server.
The following example illustrates how the Push Notification Framework architecture operates within these layers of the PeopleSoft infrastructure:

- Browser layer
- Web server layer.
- Server runtime layer.

In the architecture shown the example, the Tuxedo Event Broker running on the application server interacts with websockets in web server to dispatch events from the server to the end user’s browser.

The key elements in this framework are:
• Event: A state change in the system, causing the notification publication.
• Publisher: Publisher raises the event during the state change on the application server.
• Subscriber: Interested in events occurring on the server or browser.
• Websockets: Provides full duplex communication channels (simultaneous in both directions) between browsers and web servers.

Note: For the Push Notification feature to work, your browser should support the websocket technology. Newer browser versions support this technology.

• Tuxedo Event Broker: The Oracle Tuxedo Event Broker is provides asynchronous routing of application events among the processes running in a Oracle Tuxedo application. It also distributes system events to the application processes configured to receive them.

Development tasks for implementing the Push Notification feature can be categorized as follows:

<table>
<thead>
<tr>
<th>Function</th>
<th>Tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Event Definition</td>
<td>• Define events.</td>
</tr>
<tr>
<td></td>
<td>• Define event collections.</td>
</tr>
<tr>
<td></td>
<td>• Associate events to collections.</td>
</tr>
<tr>
<td>Subscription</td>
<td>• Subscribe to an event.</td>
</tr>
<tr>
<td></td>
<td>• Subscribe to an event collection.</td>
</tr>
<tr>
<td>Publishing</td>
<td>Use PeopleCode API.</td>
</tr>
</tbody>
</table>

System administration tasks for implementing the Push Notification feature include:

• Enabling Push Notifications in the active web profile for the PIA domain on the web server.
• Enabling Push Notifications for the application server domain(s).
• If events will be generated by processes run through Process Scheduler, you need to enable Push Notifications for the Process Scheduler domain(s), and the domain gateway feature between the Process Scheduler domain(s) and an application server domain enabled for Push Notification.

**System Requirements for Push Notifications**

Before making use of the Push Notification feature, verify that your infrastructure support WebSockets.

<table>
<thead>
<tr>
<th>System Component</th>
<th>Requirement</th>
</tr>
</thead>
<tbody>
<tr>
<td>Web Server</td>
<td>Weblogic 12.1.2 onwards.</td>
</tr>
<tr>
<td>Reverse Proxy Support</td>
<td>OTD from 11.1.1.7, WLS Plug-In 12.1.2+ for Apache 2.2, 2.4, OHS 12.1.3</td>
</tr>
</tbody>
</table>
Setting up Push Notifications

This topic contains an overview and discusses:

- Enabling push notifications for the PIA domain.
- Configuring an application server domain for push notifications.
- Configuring notifications from the Process Scheduler.
- Testing push notifications published from the application server domain.
- Configuring the Notification window.
- Troubleshooting the notifications configuration.

Understanding Push Notification Configuration

To receive push notifications on a PeopleSoft system, you have to enable push notifications for the server domains where the events are being published. Events are published from application server domain and Process Scheduler domains. By enabling Push Notifications within a domain, the TMUSREVT server process will start in the domain (tmusrevt.exe), which is the Tuxedo Event Broker.

Note: Events raised in a Process Scheduler domain are ultimately routed through application server domain. For these inter-domain events, you have to set configurations for both the application server and the Process Scheduler.

This topic assumes you have a working knowledge of PeopleSoft server administration. For more information on managing PeopleSoft servers, see "Using PSADMIN" (PeopleTools 8.57: System and Server Administration).

Enabling Push Notifications for the PIA Domain

By default, Push Notifications are turned off for the PIA domain (web server layer). If Push Notifications are set at the server layer (application server and Process Scheduler), in order for the notifications to be distributed to the end user interface, you must enable Push Notifications for the PIA domain.

To enable Push Notifications for the PIA domain:

1. Select PeopleTools > Web Profiles > Web Profile Configuration.
2. Select the Custom Properties tab of the deployed web profile, add the custom property, `EnablePNSubscriptions`, and set it to `true`.
3. Save the web profile changes.
4. Restart the PIA domain for this change to take effect.

Configuring an Application Server Domain for Push Notifications

To enable Push Notifications in the application server domain:
1. Launch PSADMIN.

2. Select the appropriate domain(s) and select Configure this domain.

3. Enter 13 to enable Push Notifications from the Quick-Configure menu.
   The Push Notifications option is set to No (disabled) by default.

4. Enter 14 to load the modified configurations settings.

5. Boot (or reboot) the domain and verify that the TMUSREVT server process starts along with the other domain server processes.

**Configuring Notifications from the Process Scheduler**

The inter-domain configuration allows events raised from Process Scheduler servers routed to application servers and finally routed to browsers. You can configure the following to allow push notifications from the Process Scheduler domain.

**Image: Inter-Domain Event Configuration**

This example illustrates the configuration settings for setting up inter-domain events between an application server domain and a Process Scheduler domain. The Process Scheduler port values set on both domains and the application server port values set on both domains must match to ensure successful transactions.

As a first step, you should configure the application server and Process Scheduler domains to generate inter-domain events configuration.
Generating Inter-Domain Events Configuration for an Application Server Domain

To configure inter-domain events for the application server domain:

1. Launch PSADMIN.
2. Select the appropriate application server domain and elect to configure the domain.
3. On the Quick-Configure menu, enable the Domains Gateway and Push Notifications options.
4. Select 14) Load Configuration.

Generating Inter-Domain Events Configuration for a Process Scheduler Domain

To configure inter-domain events for the Process Scheduler domain:

1. Launch PSADMIN.
2. Select the appropriate Process Scheduler domain and elect to configure the domain.
3. On the Quick-Configure menu, enable the Domains Gateway and Push Notifications options.
4. Select 6) Load Configuration.

When you complete these tasks, the system generates the tuxedo inter-domain events configuration for application server and Process Scheduler domains. Next, you need to configure values for the application server and Process Scheduler domains for inter-domain events.

Configuring the Process Scheduler Domain for Inter-Domain Events

To enable Inter-Domain Events for a Process Scheduler domain:

1. Launch PSADMIN.
2. Select the Process Scheduler domain and select to Configure this domain.
3. Enter the Custom configuration option.
4. Press the Enter key for Do you want to change any values (y/n/q)? [n], and continue to press the Enter key until the Values for config section – Inter-Domain Events appear.
5. Review and modify as needed the values in Inter-Domain Events.

<table>
<thead>
<tr>
<th>Values for config section – Inter-Domain Events</th>
</tr>
</thead>
<tbody>
<tr>
<td>Process Scheduler Port=8988</td>
</tr>
<tr>
<td>Application Server Credentials=APPDOM1</td>
</tr>
</tbody>
</table>

**Process Scheduler Port**

Specify the port through which this Process Scheduler domain sends event notifications.

**Note:** You can leave the port as it is if you are configuring a single Process Scheduler domain on a machine. If you are configuring multiple Process Scheduler domains on a machine for inter-domain events, then provide unique port number for each domain.
**Application Server Credentials**

Specify the application server domain to which this Process Scheduler domain will send event notifications in the format:

```
<domain name>|<hostname>:<application server port>
```

- **domain name**: Open the `interdom.gbb` file for the application server domain. The file is available in `PS_CFG_HOME/appserv/<Domain>/folder`. Locate the section in the file that is similar to the following:

  ```
  *DM_LOCAL
  "AS_TESTSERV_41162" GWGRP=GWTGROUP ACCESSPOINTID=D="TESTSERV_41162"
  ```

  **Note:** The ACCESSPOINTID must be 30 bytes or fewer in length. If the value is a string, it must be 30 characters or fewer (including the trailing Null character).

  Copy the ACCESSPOINTID value and provide the configuration value as follows:

  ```
  Application Server Credentials=TESTSERV_41162|<hostname>:<application server port>
  ```

- **hostname**: the host name of the machine, which is running application server domain.

- **application server port**: the port number provided in inter-domain events configuration for application server domain. You can leave the default value of the port as it is.

  The completed configuration values for the application server will look similar to the following example:

  ```
  Application Server Credentials=TESTSERV_41162|slc00fep:7988
  ```

6. Enter `q` to exit the custom configuration interface, load any configuration changes, and return to the Domain Administration menu.

  **Note:** If you have multiple process scheduler domains, then this configuration needs to be applied to each of the Process Scheduler domains.

**Configuring the Application Server Domain for Inter-Domain Events**

If the events occur by way of the Process Scheduler, then the system routes the events to an application server domain where they can be processed and distributed to the browser interface. For this to occur, you must enable and configure the settings for the Inter-Domain Events between the application server domain and the Process Scheduler domain.

When your environment consists of multiple application server domains, you can configure any one of the application server domains for inter-domain events. This ensures that any notification published from any
of the Process Scheduler domains will be routed to the application server domain. Then, the events are routed to the connected PIA domain and finally to the browser clients.

To configure inter-domain events for the application server domain:

1. Launch PSADMIN.
2. Select to configure the appropriate application server domain and elect to Configure the domain.
3. Select the Custom Configuration, option.
4. Press ENTER until you arrive at the Inter-Domain Events section.
5. Press y to change the values in Inter-Domain Events.
6. Review and modify as needed the Process Scheduler Credentials and Application Server Port settings.

   Process Scheduler Credentials=PRCS1=localhost:8988
   Application Server Port=7988

**Process Scheduler Credentials**

Specify the credentials for the Process Scheduler domain from which notifications will be received in the format:

```
<domain_name>|<hostname>:<process scheduler port>
```

- **domain_name**: Open the interdom.gbb file for the Process Scheduler domain. The file is available at PS_CFG_HOME/appserv/prcs/<Domain>/ folder. Locate the section in the file that is similar to the following:

```
*DM_LOCAL
"PRCS" GWGRP=GWTGROUP1 ACCESSPOINTID="PRCS_SLC0_FEP_PSNT"
```

**Note:** The ACCESSPOINTID must be 30 bytes or fewer in length. If the value is a string, it must be 30 characters or fewer (including the trailing Null character).

Copy the ACCESSPOINTID value and provide the configuration value as follows:

```
Process Scheduler Credentials=PRCS_SLC0_FEP_PSNT|<hostname>:<process scheduler port>
```

- **hostname**: The host name of the machine where the Process Scheduler domain is running.
- **process scheduler port**: Process scheduler port is the port number provided in inter-domain events configuration for Process Scheduler domain.

The completed configuration values for the Process Scheduler domain will look similar to the following example:

```
Process Scheduler Credentials=PRCS_SLC0_FEP_PSNT|slc⇒00fep:8988
```
Note: If there are multiple Process Scheduler domains from which you want to receive push notifications, then provide the configuration for each domain separated by a comma. For example:

```
Process Scheduler Credentials=PRCS_SLC00FEP_PSNT|slc00fep:8988,PRCS_SLCFTJTH_PSNT|slcftjth:8988
```

Note: If you have multiple Process Scheduler domains running on the same machine, then each Process Scheduler domain should have a unique port for inter-domain events configuration. For example:

```
Process Scheduler Credentials=PRCS_SLC00FEP_PSNT|slc00fep:8988,PRCS_SLC00FEP_PSNT1|slc00fep:8989
```

<table>
<thead>
<tr>
<th>Application Server Port</th>
<th>You can retain the port number as it is.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>

7. Enter q to return to the PeopleSoft Domain Administration menu, and load any configuration changes.

You have completed the configuration for push notifications on the application server domain and Process Scheduler domains. You need to boot the domains for the configurations to take effect.

Testing Push Notifications Published from the Application Server Domain

To test the push notifications published from an application server domain:

1. Select PeopleTools > Portal > Inter Window Communication.
2. Search and select Portal Object Name: PTSVRTESTEVENTS_GBL.
3. In the Content Reference Message Events grid, click the Map icon for SERVEREVENTTESTA.
4. On the Map Event Data to Page Elements Modal window, click OK, and click Save.
   
   Note: You need to complete this only once on a new installation.

5. Using two different browser sessions navigate to PeopleTools > Utilities > Debug > Server Side Events Test Page.
6. Enter test values in the Event Data field and click Publish on one browser session.
7. On the other browser session, confirm that the values you entered previously, appear in the Event Targets fields.
Configuring the Notification Window

This topic discusses:

- Setting system configuration options.
- Managing business event notifications.
- Enabling the two-panel action view.

Setting System Configuration Options

Use the System Configuration page to configure the Notification window for all users system wide.

Navigation

PeopleTools > Push Notifications > Notification Window > Configuration > System Configuration

Image: System Configuration page

This example illustrates the fields and controls on the System Configuration page. You can find definitions for the fields and controls later on this page.

<table>
<thead>
<tr>
<th>System Configuration</th>
<th>Manage Notification</th>
<th>Action View</th>
</tr>
</thead>
<tbody>
<tr>
<td>Max Notification Items</td>
<td>10</td>
<td></td>
</tr>
<tr>
<td>Notification Items to Load</td>
<td>100</td>
<td></td>
</tr>
<tr>
<td>Archive and Purge</td>
<td></td>
<td></td>
</tr>
<tr>
<td>From Date</td>
<td></td>
<td></td>
</tr>
<tr>
<td>To Date</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Category Name</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Archive</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Purge Data</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Save</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

The table describes the names and definitions of fields in the System Configuration page.

Max Notification Items
Enter the default number of maximum notification to be displayed to the user.
Chapter 8 Working with the Push Notification Framework

Note: Users can personalize the Notification window by specifying a different maximum number. See "Personalizing the Configuration of the Notification Window" (PeopleTools 8.57: Applications User's Guide).

**Notification Items to Load**

Enter the number of records that get loaded to the system when the notification window is loaded. The default value for this option is 100. This configuration can be used to tune the performance of the Notification window.

**From Date, To date**

Set the period to archive or purge data.

**Category Name**

Select a category to archive or purge data.

**Archive**

Click to archive the data based on the date range and selected categories. When notification items are archived, the data is copied into the archive table. Archiving the data at regular intervals improves the system performance because the number of notification items in the table gets reduced on archival.

**Purge Data**

Click to purge the data based on the date range and selected categories. You cannot retrieve purged data. Purging the data at regular intervals improves the system performance because the number of notification items in the table gets reduced on purging.

**Managing Business Event Notifications**

Use the Manage Notification page to enable or disable business event notifications selectively based on the business process, activity name, event name, and worklist name.

**Navigation**

Select the Manage Notification page tab.

**Image: Manage Notification page**

This example illustrates the fields and controls on the Manage Notification page. You can find definitions for the fields and controls later on this page.
TriggerBusinessEvent
Select Yes to enable business event notifications.

Object Owner ID
Select an object owner ID to filter the results in the grid.

Enable
Select Enable to enable or disable the notification feature for that business process combination.

Notification Message Set/Message Number
For each combination of business process, activity, event, and worklist, you can set the message set ID and number, based on which message catalog entry used to form the notification message and notification category.

Enabling the Two-Panel Action View
Use the Action View page to enable the two-panel action view for all users system wide.

Important! Review the following important considerations before enabling the two-panel action view on your system.

Navigation
Select the Action View page tab.

Image: Action View page
This example illustrates the fields and controls on the Action View page.

The two-panel action view uses the master/detail architecture. A user’s list of notifications (the master) is displayed in the left panel, while the actionable transaction (the detail) is displayed on the right. The action view master/detail component has both AJAX transfers and the slide-out left panel enabled.
Image: Action view master/detail component

The following diagram illustrates the relationship of the items in the action view master/detail architecture:

- The action view master/detail component is the container.
- The master list of notifications is displayed in the left panel.
- If the notification target content includes an inner left panel, then the left panel collision handling that is set on the action view master/detail component enables the slide-out left panel.
- The component for the notification target is displayed on the right.

Any component and page that could be displayed as a detail transaction in the action view must conform to the general restrictions on being displayed within a master/detail component as described in Guidelines and Limitations for Master/Detail Components.

In addition to these general guidelines, evaluate each target component and page that could be displayed in the action view as the result of a notification:

- If the target is a fluid activity guide, another master/detail component, or a fluid navigation collection, it cannot be displayed within the action view; however, it can be set to display in a new browser.
window. You must add the &ICDisplayNotify=N query string parameter to the notification when it’s published.

- Pages in the target fluid component cannot include an “application header”—that is, any of the Custom Header group box types (Left, Right, Middle, or Bottom) must be hidden when displayed in the action view.

- Since the action view master/detail component controls the title in the fluid banner, for each page defined within the target component, you should add a group box of type Page Title that is defined to be visible when the page is rendered within a master/detail component. This Page Title group box provides context that is lost when the page title is not displayed in the fluid banner. To hide this page title if the page is rendered outside of a master/detail component, use the psc_hideinmode-notmd style.

- If the target content is a fluid component that employs the 8.54 two-panel construct (that is, it was built from the PeopleTools 8.54 PSL_TWOPANEL layout page or it was designed with an internal left panel similar to PSL_TWOPANEL), your implementation must ensure that the internal two-panel is initialized (using initializeTwoPanel) so that left panel collision handling can occur.

Related Links

Working with Two-Panel Implementations
"Using the Two-Panel Action View" (PeopleTools 8.57: Applications User's Guide)

Troubleshooting the Notifications Configuration

If events are not appearing in the Notification window, check the following items:

- Verify that the web profile passwords are consistent between the PIA domain and the application server domain.

- Verify that your browser, web server, and any reverse proxy servers used all support websocket technology.

To troubleshoot the notification configuration for push notifications published from Process Scheduler domain, you also need to consider the following:

- After booting up the domains, you can verify the configuration by ensuring that the domains have connected to each other. To verify the connection, you need to open the TUXLOG file for application server and Process Scheduler domains from their respective domain LOGS folders. You will see an entry in the file that the connection is established between the domains.

- If you do not see connections being established, then reboot the domains after clearing IPC resources for the domains. Use the Clean IPC resources of this domain option in PSADMIN and then reboot the domains.

- If you reboot application server domain or Process Scheduler domains after a successful configuration, the domains may not connect to each other anymore. This happens because the ACCESSPOINTID, which you had entered for the inter-domain configuration changes during a reboot. In this case, review the configuration for the domains and provide the correct ACCESSPOINTID.
Defining Events

Before subscribing or publishing an event, you must define an event. Events are state changes that occur on the server during system runtime. Examples of a state change include:

- Process Scheduler process or job status change.
- Approval notification for a workflow.

You can define events on the Define Server Side Events page.

Access the Define Server Side Events page by selecting PeopleTools > Push Notifications > Define Server Events.

**Image: Define Server Side Events Page**

The following example shows the Server Side Events grid where you add server side events.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
<th>Data Type</th>
<th>Data Structure</th>
</tr>
</thead>
<tbody>
<tr>
<td>PARTITION EVENTS</td>
<td>PARTITION EVENTS</td>
<td>KeyValue Pair</td>
<td>PRINCSCHNAME, SCHINSNANCE, PRINCREATEDBY</td>
</tr>
<tr>
<td>PROCESS EVENTS</td>
<td>PROCESS SCHEDULER</td>
<td>KeyValue Pair</td>
<td>PROCSNAME, PROCSDESC, PROCSSTATUS, PROCSUSER</td>
</tr>
<tr>
<td>REFRESH CHART</td>
<td>REFRESH PUM CHARTING</td>
<td>KeyValue Pair</td>
<td>DTA1, DTA2</td>
</tr>
<tr>
<td>PTPNPBCGEVENT</td>
<td>PTPNPBCGEVENT</td>
<td>KeyValue Pair</td>
<td>TARGET, CATEGORYNAME, CATEGORYTYPE, KEYMSGINFO, Q</td>
</tr>
<tr>
<td>SENDNOTE</td>
<td>SENDNOTE</td>
<td>KeyValue Pair</td>
<td>TARGET, CATEGORYNAME, CATEGORYTYPE, KEYMSGINFO, Q</td>
</tr>
</tbody>
</table>

**Name**
Enter a unique name for the event.

**Description**
Enter a description of the event.

**Data Type**
Select between KeyValue Pair or PeopleCode Rowset. The Data Type value defines how the system structures the event data while publishing the event. The value you assign determines what you enter for a Data Structure.

**Data Structure**
Enter the Data Structure value, depending on the Data Type selected.

- **KeyValue**: Enter key names separated with comma.
- **PeopleCode Rowset**: Click the Prompt button to select the record name.

APIs are provided by the framework to set event data (in the form of KeyValue pairs or PeopleCode Rowset) while publishing the event.

**Adapters**
Adapters are used for sending push notifications to mobile applications running in the Oracle Mobile Application Framework (MAF). An adapter is associated with a server side event.
For more information on adapters and working with MAF, see Creating an Adapter.

**Recipients**

(Optional) Click the Recipients link associated with a server side event to open the Add Recipients page, where you can add either users or roles (but not both) to receive notifications for that event. If no recipients are provided, the system sends the event notification only to users who have subscribed to the event.

---

### Publishing an Event

You can publish an event from server runtime using the PeopleCode APIs provided by the framework. The procedure depends on the data type: KeyValue or PeopleCode rowset.

#### Publishing an Event for KeyValue Pairs

If you are publishing an event where the data type is a KeyValue pair you follow these general steps:

1. Set values for the keys defined for the event.
2. Add a recipient user who has subscribed to the event.

**Note:** Adding recipients to the event is optional. If you add users or roles using the APIs as recipients then the recipients added through web interface while defining the event are ignored.

3. Publish the event.

#### Example

This example demonstrates the publishing of the event PROCESSSTATUSCHANGE with the keys PROCESSID and RUNSTATUS and recipient user, VP1.

1. Create the event object.
   ```
   Local object &EventObject;
   &EventObject = CreateObject("PSEvent");
   ```

2. Set values for the keys defined in the event
   ```
   &EventObject.SetKeyValuePair("PROCESSID", PSPRCSSTATUS.PROCESSID);
   &EventObject.SetKeyValuePair("STATUS", PSPRCSSTATUS.RUNSTATUS);
   ```

3. (Optional) Add a recipient user for the event.
   ```
   &EventObject.AddRecipient("VP1", 1)
   ```
   The the parameters for AddRecipient are:
recipient Specify the recipient using either a user name or a role name.

recipient type Use a value of 1 to indicate a user.

Use a value of 2 to indicate a role.

4. Publish the event.

&EventObject.Publish("PROCESSSTATUSCHANGE");

Publishing an Event for a PeopleCode Rowset

If the data type is PeopleCode rowset, you set the values for the fields in the record and add a recipient.

Example

This example illustrates publishing an event for a PeopleCode rowset. In this example, WORKFLOWAPPROVAL is the server event for which name and status fields are defined. All users assigned the role of Workflow Administrator are added as recipients.

1. Create the event object.

Local object &EventObject;
&EventObject = CreateObject("PSEvent");

2. Set the PeopleCode Rowset for the event.

Local object &EventObject;
&rs = CreateRowset(Record.PSPFWTAPPVL);
&rs.InsertRow(&i);
&rs(&i).PSPTWKLAPPVL.NAME.Value = "Test Workflow";
&rs(&i).PSPTWKLAPPVL.STATUS.Value = 1;
&EventObject.SetRowsetData(&rs);

3. (Optional) Add a recipient role for the event.

In this case, the event will be sent only to users who have subscribed to the event and belong to the role: Workflow Administrator.

&EventObject.AddRecipient("Workflow Administrator", 2);

4. Publish the event.

&ret = &EventObject.publish("WORKFLOWAPPROVAL");

Subscribing to an Event

This topic provides an overview of how you can create subscriptions to an event.
Subscribing to an Event through Interwindow Communication (IWC)

Use IWC to subscribe an event occurring on a PeopleSoft page, where the event model is mapped to page elements, such as fields and grids. Creating a subscription does not require any changes to the page. When the event is published from the server, the page is updated automatically with the event data.

See event data structure in, Defining Events.

To subscribe to an even through IWC:

1. Identify the component which needs to subscribe to the event.

2. Navigate to the content reference for the component using the portal Structure and Content interface (PeopleTools >Portal >Structure and Content).

3. Click the IWC Message Events link on the Content Ref Administration page of the component.

4. Select Add a New Value, and add a new row on the IWC Message Events page, specifying these values:
   - Event Name: Enter a name to identify the event.
   - Message Event Type: Select Server Sub.

5. Click the Map to display the Map Events Data to Page Elements page.

Image: Map Events Data To Page Elements Page

In this page you can map the data model of a published Event to a page element defined as &lt;Record Name&gt;._&lt;FieldName&gt;.
Chapter 8 Working with the Push Notification Framework

Event Name Displays the Event Name that is defined in Content Reference Message Events page.

Page Name Select the page where you want the event subscription added.

Page widget Type Select from field or grid widget type inside the page which is auto-updated with the published event data.

Event Data Select the meta-data of the event. The drop down will display key values if the event data type is KeyValue Pair and record fields if the event data type is PeopleCode Rowset.

Page Record Field Name Select the record field name for the page element, which will update.

Related Links
"Publishing and Subscribing to IWC Messages" (PeopleTools 8.57: Portal Technology)

Subscribing to an Event Using JavaScript

When using programmatic subscription, you are able to render the published event data on the page in any form using the JavaScript Object Notation (JSON) data-interchange format. Use the following JavaScript API on an HTML embedded section on a page on the web interface to receive Push Notifications.

Subscribe(event name, callback function name)

event name The event to be subscribed to.

callback function name JavaScript function invoked when the event is published on the server.

Example

```javascript
<script>
function OnEvent(EventName,EventData)
    { //EventName is the name of the published event
        //EventData is the payload (or data) of the published event in //JSON(JSON Object Notation) form.}
Subscribe("PROCESSSTATUSCHANGE",OnEvent)
</script>
```

Subscribing through Application Server Runtime

You can also subscribe to events from server runtime itself. This is beneficial for cases when you want to write the published event data to a database table or write to a log file.

Write a PeopleCode handler for subscription of an event, which also acts as the callback method for the event.

Subscription Code

```peoplecode
Local object &EventObject;
&EventObject = CreateObject("PSEvent");
SubscriptionHandle = &EventObject.Subscribe("PROCESSSTATUSCHANGE", "PT_PRCS:Process⇒
```
Monitor: OnEvent()

The second parameter for the Subscribe method is the fully qualified name of a callback function in the form:

Application Package: Application Class: Function Name

This function is invoked when the event is published.

**Syntax of a callback function**

```plaintext
method OnEvent(&EventObject As object);
end-class;
```

The &EventObject parameter represents the published event data.

---

**Working with Event Collections**

This topic provides an overview of the executables for working with event collections.

**Understanding Event Collections**

You can group a set of events that exhibit a common behavior as a collection. When you subscribe to a collection, you receive notifications for all the events included in the collection whenever they are published from the server runtime.

**Defining an Event Collection**

Use the Define Server Event Collections page to define an event collection.

Access PeopleTools > Push Notifications > Define Event Collections.

**Image: Define Server Event Collections Page**

This example illustrates how you can define an event collection.

<table>
<thead>
<tr>
<th>Collection Name</th>
<th>Description</th>
<th>Handler - Application Package</th>
<th>Handler - Application Class</th>
<th>Events</th>
</tr>
</thead>
<tbody>
<tr>
<td>PUSHNOTIFICATIONWINDOW</td>
<td>Push Notification Window</td>
<td>PTPN_WINDOW_HANDLER</td>
<td>NotificationWindowHandler</td>
<td>Events</td>
</tr>
<tr>
<td>SERVIERTESTEVENTS</td>
<td>Server events test collection</td>
<td>PT_PNCOLL_HANDLER</td>
<td>ServerEventsTestHandler</td>
<td>Events</td>
</tr>
</tbody>
</table>

- **Collection Name**: Enter the unique name for the event collection.
- **Description**: Enter the description of the event collection.
- **Handler - Application Package**: (Optional) Select the PeopleCode application package that contains the Handler - Application Class.
- **Handler - Application Class**: (Optional) Select the PeopleCode application class that can receive the events which are part of the event collection when they are published. A valid handler class implements the interface PT_PNCOLL_HANDLER:Handler.
- **Events**: Click the link to add events to the event collection.
When you click Events for a collection, the Add Events page appears where you add events to the collection. If you subscribe to the collection, then you will receive the push notifications for all the events added in this page.

**Subscribing to an Event Collection**

You can subscribe to an Event Collection using the following JavaScript API.

```
SubscribeCollection(collection_name, callback_function_name)
```

- **collection_name**: The name of the event collection to which you are subscribing.
- **callback_function_name**: The function invoked if any of the events included in the collection are published on the server.

Collection-name is the name of the event collection to be subscribed. Callback function name is t

See [Subscribing to an Event Using JavaScript](#) for an example of how to add the callback function.

**Using Application Data Set Definitions for Events**

These Application Data Set (ADS) definitions are for events and collections. You can use them to copy event and collection definitions between databases.

- **PTSVR_EVENTS**: ADS definition for events for copying event definitions and their corresponding IWC subscription configurations.
- **PTPN_EVENT_COLLECTION**: ADS definition for event collections for copying both collection definitions as well as all the associated event definitions for that collection.

[Related Links](#)

"Understanding the PeopleSoft API Repository" (PeopleTools 8.57: PeopleCode API Reference)

---

**Configuring Push Notification to Run within Oracle Mobile Application Framework**

This topic provides an overview and describes the tasks to complete to enable push notifications to run within the Oracle Mobile Application Framework (MAF) on mobile devices, such as smartphones and tablets.

**Understanding Push Notification and MAF**

PeopleTools enables the Push Notification Framework to allow the PeopleSoft server runtime to push real-time notifications to MAF applications running on Android and iOS devices. The following example depicts the sequence of interaction for mobile devices configured for MAF and the PeopleSoft system.
This example illustrates the sequence of events for establishing push notifications on a mobile device. The high level steps are described below.

1. **MAF application registers with the push notification provider:** Google Cloud Messaging (GCM) for Android or Apple Push Notification service (APNs) for iOS.

2. **MAF application receives the registration ID (or device token) from the provider.**

3. **Mobile device passes registration ID to the PeopleSoft server.**

4. **When a defined server event occurs, PeopleSoft server runtime sends notification to the push notification providers.**

5. **Push notification provider pushes the notification to the MAF application.**

Before you get started configuring push notifications for PeopleSoft on mobile devices, you need to:

- Enable Integration Broker.
  
  See "PeopleSoft Integration Broker Administration Overview" (PeopleTools 8.57: Integration Broker Administration).

**Note:** If the application server is running inside a secure private network (such as VPN), the proxy server host and port needs to be configured in the Integration Broker Gateway configuration properties file. This is essential for the PeopleSoft server runtime to connect to the APNs server, which listens on particular port numbers that may be blocked by the internal firewall.

- Install the MAF elements provided with your PeopleTools license.
Gathering Push Notification Provider Information

Depending on your mobile device operating system, you will need a set of attributes related to your MAF application to configure push notification for your PeopleSoft application.

Required Attributes for Android

For the Android device, you need to provide these MAF application attributes:

- Application Name
- GCM Project Number
- GCM API Key

The GCM Project Number for a MAF application is embedded into the application when it is packaged. The GCM API Key is used to establish connection to the provider. These attribute values are generated through Google API Console.

Required Attributes for iOS

For the iOS device, you need to provide these MAF application attributes:

- Application Name
- APNs Bundle ID
- APNs Certificate (.p12 file)
- APNs Certificate password

The APNs Bundle ID is a unique identifier provided by Apple for the MAF application, which is embedded into the application when it is packaged. PeopleSoft server runtime requires the APNs SSL Certificate (.p12 file) and the Certificate password to establish connection to the APNs server to send the notification. The APNs SSL Certificate is generated through iOS provisioning portal.

Configuring a MAF Application in PeopleSoft

Access the Configure MAF Applications page to register your MAF applications within PeopleSoft.

PeopleTools > Push Notifications > Mobile Notifications > Configure MAF Applications

Image: Configure MAF Application page

This example illustrates the fields and controls of the Configure MAF Application page.
Add the MAF Application Name for your application, and also add the required attributes for the provider through which you will receive push notifications on your MAF application running on a device.

If your MAF application is running on an android device, then you need to configure the GCM (Google Cloud Messaging) attributes for the MAF application, such as, GCM Project Number and GCM API Key.

If your MAF application is running on an iOS device, then you need to configure the APN (Apple Push Notifications) attributes for the MAF application, such as, APN Bundle ID, APN Private Key File Name, and APN Private Key Password.

**Note:** The GCM settings, discussed earlier, are also applicable if you are using Firebase Cloud Messaging (FCM), which is the new version of GCM.

See [Gathering Push Notification Provider Information](#).

Use the Push Notification administrator credentials to configure MAF applications: user ID *PTPNADMIN* with password *PTPNADMIN*. The PTPNADMIN user ID has as one of its roles, *PN Administrator* (Push Notification Administrator).

The Push Notification administrator can enable or disable push notifications to the configured MAF application by selecting or deselecting the Enabled check box.

For APNs registration, you need to update the Integration Broker gateway properties file also. The exact path where the APNs Private key file is stored should be assigned to the *ig.apnKeyStorePath* property. For example:

```
ig.apnKeyStorePath=/usr/opt/APN
```

### Configuring Push Notifications to Google Cloud Messaging (GCM) Through An HTTPS Connection

PeopleSoft provides an Integration Broker service operation — *PTPN_GCM_OPERATION_POST* — to post push notifications to the Google Cloud Messaging (GCM) server.

To configure an HTTPS connection, complete the following steps:

1. Select PeopleTools > Integration Broker > Integration Setup > Service Operations, and select the *PTPN_GCM_OPERATION_POST* service operation.
3. Add a certificate in the Integration Gateway keystore that validates the GCM SSL certificate because Integration Gateway needs to validate the SSL certificate of the GCM server.
   - Navigate to the location where the Integration Gateway keystore is located — *(PS_CFG_HOME/webserv/peoplesoft/piaconfig/keystore)*.
   - Use the keytool utility to import the certificate into the keystore. For example, if the certificate name is `geotrustca.cer`, your command will be similar to the following.

```
keytool -import -alias geotrust -file geotrustca.cer -keystore pskey
```
Creating an Adapter

The PeopleSoft server runtime sends push notifications to MAF applications using adapters. An adapter is a PeopleCode application class that uses Push Notification Framework APIs to send push notifications to MAF applications.

For more information on Push Notification Framework PeopleCode, see "Understanding the PSEvent Class" (PeopleTools 8.57: PeopleCode API Reference).

The following example illustrates an adapter class implemented for a PeopleSoft push notification event named SENDNOTE. Extensive comments are given in this example so that it can be used as a reference for writing adapter classes.

<*> This is an example adapter class for pushing event: SENDNOTE to MAF application.
Developers can use this class as a reference to implement custom adapter classes for their events.
A custom adapter class extending from "MAFApplicationAdapter" should have a constructor and implement the method "onNotification". *

import PTPN_ADAPTERS:MAFApplicationAdapter;
class SendNoteAdapter extends PTPN_ADAPTERS:MAFApplicationAdapter
  method SendNoteAdapter();
  method onNotification(&eventObject As PSEvent);
end-class;

<*> Invoke MAFApplicationAdapter constructor by passing the MAF application name, to which push notifications for SENDNOTE event is to be sent and the fully qualified name of the adapter class. *

method SendNoteAdapter
  %Super = create PTPN_ADAPTERS:MAFApplicationAdapter("PeopleSoft", "PTPN_ADAPTERS:SendNoteAdapter");
end-method;

<*> onNotification method will receive the published event instance: eventObject.
Developers can use methods in PSEvent class to retrieve data from the published event instance.
Use MAFApplicationAdapter methods and properties to set notification data and send the push notification to the MAF application.
SendNotification method will return an error text incase of failures. Refer PeopleBooks for methods and properties of PSEvent class. *

method onNotification      /+ &eventObject as PSEvent +/;
  Local string &alert;      Local string &eventDataKey = "DETAIL";
  Local string &response;
  &alert = &eventObject.GetValueOfKey(&eventDataKey);
  %Super.SetAlert(&alert);      &response = %Super.SendNotification();
end-method;

The MAFApplicationAdapter class provides the following APIs to construct a push notification to a MAF application.
## API

<table>
<thead>
<tr>
<th><strong>API</strong></th>
<th><strong>Description</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><code>SetAlert(alert-text)</code></td>
<td>Alert text will be displayed as an alert message on the device receiving the notification.</td>
</tr>
<tr>
<td><code>SetSound(sound-file)</code></td>
<td>Plays an alert sound on the device receiving the notification.</td>
</tr>
<tr>
<td></td>
<td>For example:</td>
</tr>
<tr>
<td></td>
<td><code>SetSound(&quot;default&quot;)</code></td>
</tr>
<tr>
<td><code>SetIOSBadge(badge-number)</code></td>
<td>Displays the badge-number on the device, which receives the notification (works only on iOS devices).</td>
</tr>
<tr>
<td></td>
<td>For example:</td>
</tr>
<tr>
<td></td>
<td><code>SetIOSBadge(1)</code></td>
</tr>
<tr>
<td><code>SetUrl(url)</code></td>
<td>Sends a URL as part of the notification payload in the case where the user may have to navigate to a page to perform a task based on the notification.</td>
</tr>
</tbody>
</table>

## Associating an Adapter to a Push Notification Event

PeopleTools > Push Notifications > Define Server Events > Click the Adapter icon

**Image: Associating an Adapter to an Event**

This example illustrates the fields and controls on the page used to associate adapters to events.

After clicking the Adapter icon for the desired event, use the Adapter drop-down to select the appropriate adapter. Add rows as needed.

The adapter will be executed when a selected event occurs in the PeopleSoft application server run-time.

## Enabling Notifications

To enable notifications to a device use the Enable Notifications page.

PeopleTools > Push Notifications > Enable Notifications
Image: Enable Notifications Page

This example illustrates the fields and controls on the Enable Notifications page.

End users can configure which push notification events can send notifications to the MAP application on their phone.

Registering Devices

After an end user downloads the MAF application and registers for push notifications, the provider sends a device token and device information, which is passed to the PeopleSoft when the user signs in to the system. When the device token and device information is stored in the PeopleSoft database, appears in the Register Device page, which displays a row for each new device token received.

Access PeopleTools > Push Notifications > Mobile Notifications > MAF Register Device

Image: Register Device Page

This example illustrates the fields and controls of the Register Device page.
Chapter 9

Deploying Applications Using the Oracle Mobile Application Framework

Understanding Mobile Application Framework Support for PeopleSoft

PeopleTools provides support for customers who want to incorporate Oracle Mobile Application Framework (MAF) for their PeopleSoft Fluid or MAP deployments.

This documentation describes how to locate the elements and information required for using this option.

You can use Oracle MAF as described in the Mobile Application Framework and PeopleSoft license agreements. Using MAF is an option for deploying PeopleSoft Fluid User Interface applications or applications built with PeopleSoft Mobile Application Framework to mobile devices (smartphones and tablets).

Note: MAF is not required for deploying PeopleSoft applications to mobile devices. It is an option some customers may choose to pursue.

PeopleTools provides a restricted use of the Mobile Application Framework, which enables you to use only the Remote URL option for running PeopleSoft applications in the MAF container on the mobile device. An additional MAF license is required if you intend to use other MAF features or create new data controls.

This list outlines the main steps you need to complete to implement the MAF deployment option for PeopleSoft applications:

• Download the version of MAF provided in the PeopleTools Media Pack.

• Download the mobile application archive (.maa) provided with PeopleTools.

• Import the delivered mobile application archive into your IDE and modify as needed. JDeveloper is the recommended IDE. Eclipse may also be used, but see the note below.

• Deploy the application for end user download. For internal usage, deploy the application to your site’s application repository. For external usage, deploy the application to Apple App Store or Google Play Store.

Note: Currently Oracle delivers the PeopleSoft mobile application archive (.maa) for JDeveloper. Eclipse may also be used, but you need to install Oracle Enterprise Pack for Eclipse (OEPE) and build the .maa manually.
Preparing to Use MAF for PeopleSoft Applications

After installing the current version of PeopleTools, before you begin working with MAF for PeopleSoft applications, you will need to have completed the tasks described in this topic.

**Note:** The version of MAF and JDeveloper used with your version of PeopleTools is important. Make sure to review the release notes, feature overview, licensing documentation, and Certifications on My Oracle Support to make sure you use the appropriate version combinations.

Using an Integrated Development Environment (IDE)

To configure and deploy a mobile application using the delivered .maa file, you will need to import the .maa file into an IDE. When working with Oracle MAF, currently, the primary IDE to use is JDeveloper.

Oracle delivers the PeopleSoft mobile application archive (.maa) for JDeveloper. Eclipse may also be used, but you need to install Oracle Enterprise Pack for Eclipse (OEPE) and build the .maa manually.

**Note:** This document does not seek to replace any documentation already existing for JDeveloper or Eclipse. It is assumed that if you are implementing the mobile application archive delivered by PeopleTools that you have a working knowledge of at least one of the IDE products listed in this document. This document outlines and describes the tasks required to configure and deploy the delivered .maa file in general terms. Always refer to the product documentation for your IDE for specific information.

**Note:** This document is written from the perspective of using JDeveloper. If you elect to use Eclipse, you are expected to be familiar with that product and use its documentation to achieve the same objectives described here for JDeveloper.

Installing MAF

**Important!** Only install the version of MAF supported with your version of PeopleTools. While there are more current versions of MAF available, install only the supported version of MAF for working with the delivered .maa file in your PeopleTools installation.

**Note:** MAF comes bundled with Oracle Enterprise Pack for Eclipse. You need to install the specific version of OEPE that includes the version of MAF supported by your PeopleTools version.

Downloading MAF

In many cases, MAF is already bundled with the PeopleTools files that you downloaded from the Oracle Software Delivery Cloud (OSDC). Therefore, you will not need to download MAF separately. This ensures that you receive the correct version of MAF supported with your version of PeopleTools. Store the MAF download within a local file system accessible from your JDeveloper installation.

However, in some circumstances, the version of MAF you require is not yet available on OSDC and has not yet been bundled with PeopleTools. In those circumstances only, use the Certifications database on My Oracle Support to determine the correct version of MAF to download:

2. Download the supported version of MAF from OTN:
   
   http://www.oracle.com/webfolder/technetwork/jdeveloper/downloads/1213center.xml#oracle.maf

3. Store the MAF download within a local file system accessible from your JDeveloper installation.

**Installing MAF from JDeveloper**

To install MAF using JDeveloper:

1. In JDeveloper, select Help > Check for Updates.

2. On the Select update source screen, select Install From Local File, provide the path to the zip file containing the MAF download, and click Next.

**Image: JDeveloper — Installing MAF**

This example illustrates the interface used to install or update MAF using JDeveloper.

**Note:** When using the Check for Updates option from within JDeveloper to install MAF, you need to specify Install From Local File. Using the Search Update Centers option applies the latest MAF version, which most likely is not the version certified for PeopleSoft use.
3. On the License Agreements screen, click *I Agree* (if the terms are suitable for your site), and click Next.

4. On the Summary screen, review your selections, and click Finish.

5. To complete the MAF installation, you will need to restart JDeveloper.

### Installing Target Operating System Development Requirements

Depending on the target operating system of the devices to which you will deploy the MAF application, you need to install any required development artifacts, such as SDK’s and so on.

#### Required Elements for iOS

For iOS, you will need these items in place in your development environment:

- Xcode 6
- iOS SDK
- Provisioning profile
- Any required client-side certificates

For more information see:

- [Setting Up Development Tools for iOS Platform](#)
- [Provisioning and Development](#)

#### Required Elements for Android

For Android, you will need to install the Android SDK. See:

- [Installing the Android SDK](#)
- [Setting Up Development Tools for Android Platform](#)

### Importing the Delivered Mobile Application Archive

After installing PeopleTools, there is an additional folder in the `PS_HOME\setup` directory, named `MAF`. This is where the PeopleSoft mobile application archive file (.maa) resides.

To import the PeopleSoft archive file:

1. In JDeveloper, select `File > Import`.

2. From the Import dialog box, select *MAF Application from Archive File*, and click OK.
Image: Importing a MAF Application From Archive

This example illustrates using the Import dialog box to import the .maa file.

3. On the Select MAA File to Import dialog box, navigate to PS_HOME\setup\MAF and select PS_MAF_MOBILE_PROJECT.maa, and click Open.

Image: Selecting the PeopleSoft MAF Project

This example illustrates the PeopleSoft .maa file.
4. On the Location screen, enter a custom project name in the Application File field, and click Next.

Your project name will be reflected automatically in the Directory field, where the project files will be stored. The default project name is the same as the archive file (PS_MAF_MOBILE_PROJECT).

**Image: MAF Application from Archive Dialog Box**

This example illustrates specifying the .maa file location as well as the location of the new application.

5. On the Finish screen, click Finish.

After importing the archive you have the basis of a MAF application open in your IDE.
Chapter 9 Deploying Applications Using the Oracle Mobile Application Framework

Image: MAF Feature Directory Structure

This example illustrates the maf-feature.xml file in the feature directory structure.

Also, the system creates the appropriate project directory structure, containing the required files for further configuration and deployment.

Image: JDeveloper Project Directory Structure

This example illustrates the project directory structure under JDeveloper\mywork.

---

Configuring the Mobile Application Project for Your Site

This topic describes how you can configure the delivered mobile application project.

Setting the Application Name

To set the application name:
1. Expand the Application Resources pane.

2. Expand the Descriptors folder.

3. Expand the ADF META-INF folder.


   **Image: IOpening maf-application.xml**

   This example illustrates navigating to and opening maf-application.xml.

5. On the maf-application.xml tab, select the Application tab:
   
   - Enter your custom application name value in the Name field.
   
   - Consider the Navigation Bar behavior. If Show Navigation Bar on Application Launch is selected, the system displays the Navigation Bar at the bottom of the application, where end users can configure the URL using the Settings tab.
Image: maf-application.xml tab

This example illustrates selecting the maf-application.xml tab and naming the application.

See Setting the Default Remote URL.

Selecting Application Icons

The application icon can be changed in the Application Images screen in the Deployment Profile Properties dialog box. Make sure to have the same images placed inside the resources folder of the deployment profile.
The following example illustrates modifying the application icon.

**Note:** While the example above depicts Android, this applies to iOS deployments as well.

**Selecting Feature Icons**

The feature icon can be changed using the Navigation Bar field on the General tab of a feature in the maf-feature.xml.

Feature icons apply to both Android and iOS deployments. For iOS, you need to follow the standards provided by Apple as described in their developer’s guide.
Image: Selecting Feature Icons

This example illustrates selecting feature icons with the navigation bar field.

Setting the Default Remote URL

You can set the default URL for end users so that the specified URL value appears for the first launch of the application.

Set the default URL in the adf-config.xml file using as value of the URL property.
Deploying Applications Using the Oracle Mobile Application Framework

Chapter 9

Image: adf-config.xml file

This example illustrates setting the default URL for end users.

When the user first launches the application, if you have configured the URL in the adf-config.xml, the application navigates to the default URL specified.

To change the URL, users can tap the Settings tab in the navigation bar, enter the new URL and tap Submit.

Users can also see the list of URLs they have used previously by tapping the Saved URLs list. Select a URL in the list and tap submit to navigate to that URL instead of the default URL.

If you have not provided a default URL value in the adf-config.xml file, when the user first clicks the application, the system displays an alert message indicating that the user needs to provide a URL to the PeopleSoft system.

After the user clicks OK, the system displays the Settings tab for the user to set the URL.

Setting the Remote URL Whitelists

Make sure to set the Remote URL Whitelist in the Security section in the maf-application.xml, as shown in the following example. Connections to domains on the white list open in the WebView within the MAF application container. Connections to domains that are not on the white list open in the device browser, outside of the MAF container.
Image: Remote URL Whitelist

This example illustrates the Remote URL Whitelist in maf-application.xml.

For more information, see Implementing Application Features as Remote URLs.

Enabling Push Notification for MAF

After creating a MAF application container for PeopleSoft, you can enable push notification for the MAF application. This allows the PeopleSoft system to send real-time notifications from the PeopleSoft Push Notification Framework to the mobile device. To implement this option, there are some tasks that need to be completed within the PeopleSoft Push Notification Framework and within MAF. This topic focuses on the tasks that need to be completed in MAF.

For information on the tasks that need to be completed in the Push Notification Framework, see Configuring Push Notification to Run within Oracle Mobile Application Framework.

Enabling Push Notification for iOS MAF Applications

For iOS, generate a provisioning profile that is Push Notification enabled. The push-enabled profile must be selected in JDeveloper > Preferences > Mobile Application Platform > iOS Platform to receive the device token, which is a unique alpha-numeric string used by the server to send the notification.

Enabling Push Notification for Android MAF Applications

To enable Push Notification for Android MAF applications:
1. Create a new project in the Google API console.
2. Enable Google Cloud Messaging for Android under Services.
3. Insert the Project ID into the value field of adf-property `googleProjectID` under `adf-config.xml` in your JDeveloper project.

**Image: Setting adf-property**

This example illustrates setting the adf-property to reflect the Google Project ID.

---

### Deploying Your Mobile Application

When distributing a MAF application you have the option to distribute the application internally using your own app repository, or you may elect to distribute the application externally to the Apple App Store or Google Play repositories.

**Note:** These steps are documented in detail in the MAF documentation. The sections in this document outline specific items to complete from a PeopleSoft perspective.

### Related Links

- Deploying Mobile Applications

### Deploying Applications for Android

This section describes:

- Distributing an Android Application Externally.
- Distributing an Android Application Internally.

### Distributing an Android Application Externally

To deploy an application for Android:
1. In JDeveloper, create a deployment profile, by selecting Application > Deploy > New Deployment Profile.

2. For the Profile Type, select \textit{MAF for Android} from the drop-down list, and enter your Deployment Profile Name.

3. For the deployment of the Android application to package, it is recommended to set the deployment profile to Release mode instead of Debug mode.

   For this you need to sign the application, and map the same keystore in the Tools > Preferences > Mobile Application Framework > Android Platform and browsing through the keystore created in the Release tab under Signing Credentials.

\textbf{Image: Mobile Application Framework: Android Platform}

This example illustrates settings required for deploying applications for the Android platform.

4. Deploy the Android application to distribution package.

   The result is the .apk file in the $\langle\text{path to app location}\rangle/\langle\text{deploy}\rangle/\langle\text{deployment profile}\rangle/\langle\text{app name}\rangle$.apk.

   You distribute the .apk file.

\textbf{Deploying an Android Application Internally}

The same .apk file generated using the steps in the previous section can be used to distribute internally. However, you would upload the file to an internal repository.
For example, you can store the .apk on your web server and have a link pointing to this .apk file from an HTML page for users to access.

Deploying Applications for iOS

This section describes:

- Distributing an iOS Application Externally.
- Distributing an iOS Application Internally.

Deploying an iOS Application Externally

To deploy an application for iOS:

1. Create a deployment profile in JDeveloper, by selecting Application > Deploy > New Deployment Profile.
2. For the Profile Type, select MAF for iOS from the drop-down list, and enter your Deployment Profile Name.

For the deployment of the iOS application to a package, you need to complete the steps in the following sections:

- Registering the Certificate.
- Registering the Provisioning Profile.
- Setting JDeveloper Preferences.
- Defining Your Application Bundle ID.

Registering the Certificate

To register the certificate:

1. From your Applications > Utilities folder open the KeyChain Access utility.
2. Ensure that the login keychain is the default (shown in bold).
3. Select the login keychain and choose File > Import Items from the Menu.
4. In the Import dialog select your certificate. Ensure that "login" is shown as the Destination Keychain in the drop down at the bottom of the dialog.
5. When prompted, enter the password.

Registering the Provisioning Profile

To register the provisioning profile:

1. Start XCode.
2. In XCode, choose XCode > Preferences.
3. On the Accounts tab, click the “+” button at the bottom, left corner.
4. Select Apple ID from the drop-down list options.
5. Sign in with your Apple ID.

---

**Note:** The certificate must be issued with this ID.

---

### Setting JDeveloper Preferences

To set JDeveloper preferences:

1. Start JDeveloper and navigate to the preferences screen (Tools > Preferences).
2. In the Preferences screen navigator navigate to Mobile Application Framework > iOS Platform.
3. In the Device Signing section, for the Provisioning Profile field, click the Browse button and navigate to your provisioning profile.
4. In the Certificate field, copy and paste the certificate value from your keychain, making sure to include the entire certificate. You can right-click on the certificate and copy the text against Get Info.
5. Click OK to save the preferences.

---

### Defining Your Application Bundle ID

To define the application bundle ID:

1. For every application that you want to deploy to a package with this profile, edit the deployment profile you are using through the Application Properties dialog box.
2. Select iOS Options in the Deployment Profile dialog box.
3. Ensure that the prefix of the value in the Application Bundle ID of the deployment profile property is taken from the link. Refer to your member center in the Apple developer site for more information.
4. Associated with the profile name, locate the ID, and append the Application Name to this ID.

---

### Deploying the iOS Application Internally

To deploy the iOS application to the distribution package:

1. Open Xcode, and select File > Open, and navigate to <path to app location>/deploy/<deployment folder>/temporary_xcode_project/Oracle_ADFmc_Container_Template.xcodeproj.
2. When the project opens, change all the attributes under Signings in Build Settings to your provisioning profile. Also, ensure the app is reaching targeted customers by selecting the device support on the top after the app name.
3. Select Product > Archive, select Distribute, then click Next.
4. Select Save for Enterprise or Ad Hoc Deployment, and click Export.
5. Select your Mobile Provisioning Profile, and click Export.
6. Save the ipa into the desired location, and enter the file name.